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Limited warranty and disclaimers

A. Limited Warranty on Media
Lundström Design warrants the disks on which the Software is recorded to be free of defects in materials and faulty

workmanship under normal use for a period of ninety (90) days from the date of delivery as evidenced by a copy of the sales

receipt. Lundström Design will, as its option, replace or refund the purchase price of the diskette at no charge to you, provided you

return the faulty diskette with the sales receipt to Lundström Design, or an authorized Lundström Design Dealer. Lundström

Design shall have no responsibility to replace or refund the purchase price of a diskette damaged by accident, abuse, or

misapplication. ANY IMPLIED WARRANTIES ON THE DISK, INCLUDING WARRANTIES OF MERCHANT ABILITY AND

FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO 90 DAYS FROM THE DATE OF DELIVERY.

B. Disclaimer of Warranty on Software
THE SOFTWARE IS PROVIDED ”AS IS” WITHOUT WARRANTY OF ANY KIND, AND LUNDSTRÖM DESIGN

EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO THE IMPLIED

WARRANTIES OF MERCHANT ABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LUNDSTRÖM DESIGN DOES

NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF

THE USE OF SOFTWARE OR ANY ACCOMPANYING WRITTEN MATERIALS IN TERMS OF THEIR CORRECTNESS,

ACCURACY, RELIABILITY, CURRENTS, OR OTHERWISE. YOU ASSUME THE ENTIRE RISK AS TO RESULTS AND

PERFORMANCE OF THE SOFTWARE AND WRITTEN MATERIALS. LUNDSTRÖM DESIGN DOES NOT WARRANT

THAT THE SOFTWARE WILL WORK CORRECTLY IN YOUR MULTI-USER OR NETWORK ENVIRONMENT. IF THE

SOFTWARE IS DEFECTIVE, YOU, AND NOT LUNDSTRÖM DESIGN OR ITS DEALER, DISTRIBUTORS, AGENTS, OR

EMPLOYEES, ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME

STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT

APPLY TO YOU.

C. Complete Statement of Warranty
THE LIMITED WARRANTIES PROVIDED IN PARAGRAPHS ”A” AND ”B” ABOVE ARE THE ONLY WARRANTIES OF ANY

KIND THAT ARE MADE BY LUNDSTRÖM DESIGN ON THIS LUNDSTRÖM DESIGN PRODUCT. NO ORAL OR WRITTEN

INFORMATION OR ADVICE GIVEN BY LUNDSTRÖM DESIGN, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES

SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY

ON ANY SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE

OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

D. Limitation of Liability.
IN NO EVENT WILL LUNDSTRÖM DESIGN, OR ITS DEVELOPERS, DIRECTORS, OFFICERS, EMPLOYEES, OR AFFILIATES BE

LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS

OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF

THE USE OF OR INABILITY TO USE THE SOFTWARE OR ACCOMPANYING WRITTEN MATERIALS, EVEN IF LUNDSTRÖM

DESIGN OR AN AUTHORIZED LUNDSTRÖM DESIGN REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF

SUCH DAMAGES.

BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR

INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Lundström Design liability to you for actual damages for any cause whatsoever, and regardless of the form of action, will be limited to the

greater $200 or the money paid for the Software that caused the damages.
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Introduction

TouchCAD 3.5 is a combined 3D-modeling and unfolding program. It can be used
for creating and building complex free-form 3D-shapes such as sheet metal objects,

tents, sail roofs, blimps, boat hulls, architectural and industrial design models, reversed
engineering to recreate copies of already existing objects, etc. The ability to unfold just
about anything in a controlled way enables you to design and build shapes that you
would normally hesitate to design because of the difficulties of extracting real usable
drawings and assembly instructions.

This documentation was written by Claes Lundström © 2002 - 2005, with
assistance from Leif Bäckström and John Hall. All rights are owned by:

Lundström Design
Ekhagsvägen 7
SE-104 05 Stockholm
Sweden
Tel: int+46-8-15 46 63

info       @touchcad.com    
www.touchcad.com
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Installing TouchCAD
Notes and Acknowledgements

Claes Lundström wrote TouchCAD. TouchCAD is a copyright of Lundström Design,
2002-2004. All rights reserved. Documentation and illustrations are Copyrighted

2002-2004 by Lundström Design.
TouchCAD is a trademark licensed to Lundström Design. Macintosh™ is a

trademark licensed to Apple Computer, Inc. VectorWorks™ is a trademark of
Nemetschek Inc. AutoCAD® and DXF® are trademarks licensed to Autodesk, Inc.
Postscript™, Adobe Illustrator™ are trademarks licensed to Adobe Systems, Inc.
Windows is a trademark of Microsoft Corp.

Installing TouchCAD
Move the document called TouchCAD and the sample files to a suitable location on
the hard disk. Double-click on the symbol to decompress the files (using StuffIt
Expander on Mac and WinZip on Windows). On MacOS Classic you need to have
QuickDraw3D installed. It is included in QuickTime, which you can find on the
System CD.

If you run on MacOS X or Windows 32, install Quesa. The latest version of Quesa

can be found at    www.quesa.org  .
TouchCAD requires QuickTime to run. Most Mac users already have it in the

System and do not need to install it, unless you want to upgrade to the latest version.
Windows users can download the latest version of QuickTime for Windows from
Apple at www.apple.com.

Read and install the copy protection instruction found on the program CD.

Hardware configuration
TouchCAD will work on any PowerMac equipped with System 8.6 or later (MacOS X
included). A G3 processor or better is recommended. TouchCAD is also available for
Windows 32 based systems where a 300 MHz Pentium or better is recommended.
Windows 32 also requires OpenGL and Quesa to work. On all versions we recommend

an accelerated video card to get access to all rendering effects.

Video cards.
It may be a good idea to test the speed of the video card to find the best possible
performance. Computers with no video acceleration typically work best using 256
colors. Older video cards often work best using thousands of colors, whereas newer

video cards work best using millions of colors. Note that you need to restart the
program after having changed color depth to get correct results.
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 Starting the program

This is roughly what you see when you start the program though it varies slightly
due to the operating system used. The Tool Palette contains tools for drawing, selecting

and modifying objects, and basic navigation tools such as zoom, pan, etc. The palette is
sub-divided into three parts, from the top, tools for editing (the red section), 2D-shapes
(the blue section), and 3D-shapes (the yellow section). Some tools in the Tool palette
contain options showing up in the Mode bar when a tool is selected. The Layer / Color
palette is used for adding, deleting, activating and editing of layer colors. The Object
Info palette is used for changing various properties of the drawing objects. The

Trackball palette is used for rotating/paning and  the display view. The View bar
contains editing views (Front, Top, Side/Right, Unfold and Perspective). The Selection
Mode bar is used for choosing a selection mode when the Selection Arrow tool is
activated. The options from left are: Select everything in the current layer, select objects
as elements, select all vertexes connected to the control point knot you click on, and
select one control point at a time. When something is selected, a red marker called the

Intersection Point is displayed in the drawing area. The x, y, z coordinates of this point
are displayed above the drawing area. Dragging, entering new coordinates in the edit
fields or using the arrow keys (+/- for moving away/towards you) can be used for
moving the location of the Intersection Point. The cursor coordinates, help text, and
layer/color info are also shown above the drawing window.
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Some basic concepts
The main drawing window consists of some basic elements:

The drawing area
The drawing area is where you draw and edit the model. It displays a gray rectangle
and a horizontal line and vertical line when starting the program. The rectangle
indicates where the printable area is. It is perfectly OK to place objects outside this
rectangle, but they will not be printed, so in most cases it is practical to stay inside it.
The rectangle does not reflect the actual sheet size, such as A4 or Letter. Instead it
shows the actual printing area you have access to, as most printers can’t print to the

edge of the sheet. The advantage with this method is that TouchCAD allows you to
print over just about any number of sheets of sheet. You can for example print out an
A3 drawing on an A4 printer by doing it on two sheets of sheet. Just cut one of the
sheets along the edge where the lines stop, and place it over the adjacent sheet.

The horizontal and vertical lines displayed in the Front, Top and Side (right) views
represent the location of the zero point coordinates in the respective directions. The

zero point is normally located in the middle of the drawing, but you can move it using
the Move Print Area command in the Page menu.

The View Bar
The View Bar contains the standard view buttons, Front (1), Top (2), Side (3) (right),
Unfold (4) (the unfolding feature is regarded as a view in TouchCAD) and Perspective
(5). You can also change view by using the standard view settings in the View menu, by
pressing the 0-9 keys on the numerical keyboard (see the picture below), by using the

Rotate View tool in the Tool palette, or by using the Trackball palette.
To take a look at a model in full 3D, hold the cursor over the Trackball palette push

the mouse button and drag. The model now rotates. Note that you rotate the view, not
the model.

You can reset the rotation by clicking on either of the view buttons in the View bar.
Other ways to reset views is to select Standard Views in the View menu, or by using

the numerical keyboard indicated below with views.
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Auto centering when changing view
TouchCAD provides an auto-centering feature automatically centering the view on the
midpoint of the selected object(s). If nothing is selected, it centers on the mid-point of
the entire visible model. When used in the intended way it typically allows you to
continue working directly after having changed view. It is therefore good practice to
consider what you have selected before changing the view.

The Mode Bar
The Mode Bar located to the left and immediately above the drawing area

sometimes displays various sub options. The options vary from tool to tool and some

tools in the Tool palette do not have any options at all. If you for example select the
Rectangle tool in the Tool palette (1) in the Blue 2D section of the tool palette) you will
find four sub-options in the Mode bar (2-6). The first three control the shape type,
from the left; a rectangle defined as a curve (a series of ruler points) (2), a rectangle
defined as a ruler (3), and the last a rectangle defined as a surface (4). The last button
defines the depth of the object (in a direction away/towards you) (5). If the depth is

zero you get a flat object, if not a 3D cube is obtained. The current depth setting is
displayed to the far right (6) in the Mode bar.

The Selection Mode bar
The Selection mode bar is used for controlling how objects are being selected using the
Selection Arrow tool. The Global mode (1) selects all objects in the active layer. The
Object mode (2) selects and edits individual objects. The Mesh mode (3) selects and
edits individual control points and control point knots. Mesh mode selects all points in
a control point knot if you click on it. The Vertex mode  (4) selects individual control
points, one at a time. If you click on a control point knot, it only selects one control of
the points in that knot.

The Intersection coordinate fields.
The Intersection Coordinate fields represent the Intersection Point X, Y and Z
coordinates. The Intersection Point symbol, as seen to the left, is similar to the
intersection point in a word processor and essentially tells you where you are in the

model. The color dots at the end of the symbol axes are used for dragging the selection
in various ways and directions. The bottom left dot is for freeform dragging. The blue,
yellow and green dots are used for constrained dragging in a fixed direction. The
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intermediate red dot is used for moving the selection away/towards you to the closest

non-selected point.
The Intersection Point coordinates also act as working planes when drawing new

objects. If you, for example, draw a circle in the Top view, it will be placed at the Y
location of the Y field.

These fields have three modes. In the first mode you simply enter a new coordinate,
and the location of the selection is updated accordingly. Other selected objects will

move the same distance as the Intersection point.
In the second mode you place an “=” character before the number and that provides

all selected objects with the same absolute coordinate value (e.g. =100 means that all
objects will get the coordinate value 100).

In the third mode you insert an “M” before the coordinate and that means that you
want to move the object relative to the previous coordinate (e. g. if the previous

coordinate was 500 and you type in M100 you will get 500 + 100 = 600).

The Layer and Color pop-ups
The Layer and Color pop-ups located above the drawing area are used for setting the
active/default layer/color. Choose for example Blue in the color pop-up, and all new
objects that you draw will become blue by default. The Layer / Color palette also
allows you to change the active/default layer/color.

Note that the active / default setting is not the same as the setting of an object. You
change the object layer and color properties by selecting the object(s) and then modify

it in the Object Info palette.

The cursor coordinates
The cursor coordinates are displayed above the drawing window (1). In some cases the
Info line is used for displaying additional data (2). This primarily happens when you
draw new objects. In the example above it shows the angle between the previous point
and the current cursor location, the diagonal (polar) length, and the offsets in the
horizontal and vertical directions.

The Info Line.
The Info line above the drawing window displays various instructional messages.
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The Scroll Bars
The Scroll bars allow you to scroll the drawing area horizontally and vertically in a
fairly standard way used by most other programs.

In the bottom left corner of the drawing window you will find seven buttons. The
first four are used for saving (2), deleting (3) and toggling between views (1, 4). You
can save up to ten views in the wireframe mode and up to ten views in the render
mode. The wireframe view saving settings include the view, degree of zoom and pan.
The render mode settings include all settings found in the Mode bar while you are in
the render mode. Saved views are stored as a part of the drawing and can be re-used
when you open a drawing. The left (1) and right (4) arrows are used for stepping
between saved views. Clicking on the Save (2) button saves the current view. Clicking
on the Delete (3) button deletes the current view from the list.

The following two buttons with the zoom in (5) / out (6) symbols double and halves
the degree of zoom, essentially as if you double-click on the Zoom tools in the Tool
palette.

The blue button (7) adjusts the degree of zoom and pans so that the sheet area fits
into the drawing window.

The last button (8) is used for centering the view on the currently selected object.
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Drawing Elements

Open a document called Manual1.T3D. It contains a model used for explaining some

basic elements of TouchCAD. The picture below shows how it looks.

Control Points
When you first open the model it will look like the upper picture (1). The black dots
are called Control points (2). They are shown black because they are not selected.

Choose the Selection Arrow (3) tool in the Tool palette. Click on the Object
selection (4) mode in the Selection mode bar (4). Click on one of the black Control
point (2 or 10) dots to select the object. All black dots become red (5) and slightly
bigger than before, indicating that the entire object has been selected. The Object
selection mode selects objects as a unit explaining why all points are selected. The
green dot represents the starting point (6) and is an important element when editing
objects. The green dot is a control point as well. It is black if nothing is selected and

green if something is selected to indicate where the starting point is located. The green
dot increases in size when the point is selected. One of the control points holds the
Intersection Point (10) symbol used as a handle for moving the selection in space.

The Mesh (12) selection mode selects individual control points. Several points can
be selected by drawing a selection rectangle (13) using the Selection arrow (3) tool.

A gray selection box (7) also occurs when something is selected. The box handles
(8-9) allow you to re-scale the selection from the corners, from the line midpoints in
one direction or from the middle (9). The corner selection handles scales
proportionally when the Shift key is pressed. The center-point (0) scales in one
direction only if the Shift key is pressed and when dragging horizontally or vertically,
and proportionally when dragging diagonally. Other selection box options include
skewing press Opt/Alt while selecting the box midpoints, deforming by pressing the

Opt/Alt while selecting a corner point, and rotation by clicking on the lines in between
the control points (11) and then rotate. When pressing the Alt/Opt key it rotates
around the diagonal corner of the box, if not it rotates around the midpoint.
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Control Rulers
Some mesh lines become red when you select at least one control point in an object.
These red lines are called Control Rulers (2,6 below) and are used for showing the
object direction and the ruler identity of individual control points. All control points
along a given control ruler belong to the same control ruler. Both the control rulers
and the control points are indexed from the green starting point dot.

Visual difference between curves, rulers and surfaces
Curves (a series of ruler points) and control rulers are not surface objects and are

therefore not visible when rendered and can not be used for unfolding.
In the first example we have a control ruler (1). You can see that it is a ruler because

all lines are red between the control points even though this particular object is blue.
You can see the color when the object isn’t selected. The basic shape can be converted
into a surface (3) by using the Curve to Surface (2) command found in the Tool menu.
Note that you can see that it is a surface because it has two control rulers and blue
intermediate lines (the color of the object).

In the second example we have a curve (4) (a series of ruler starting points). You

can see that it is a curve because the lines are not red between the control points even
though it is selected. It can be converted into a surface (6) using the Curve to Surface
(5) command in the Tool menu. Note that you can see that it is a surface because it has
two red control rulers and blue intermediate lines (the color of the object).

The Object Info palette also specifies the data type of the object holding the
Intersection Point.

The Intersection point
One of the control points has a red symbol (left) that looks a bit like a coordinate
system symbol. This point is called the Intersection Point and works a bit like the
intersection point found in most word processing programs, where it usually is a

vertical blinking line.
The purpose of the intersection point in a word processor is to indicate where letters

will occur when you press a key on the keyboard. In TouchCAD the Intersection Point
indicates where you are in the model, and you can read and change the coordinates of
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that particular location in the X, Y and Z coordinate (right) edit fields above the

drawing area. The Intersection point moves to a new location when you click on
another control point, and that is exactly what you would expect in a word processor.

The Intersection Point symbol contains several dots in different colors, and a
corresponding set of dots can be found in front of the Coordinate fields above the
drawing area. The red dot, found in the bottom left corner, is used for unconstrained
dragging. The blue, green and yellow dots are hotspots for constrained dragging, and

the direction is indicated by a dot in front of the respective coordinate fields above the
drawing area. Note that you can actually drag in any direction with these three points,
even away, towards you, and from any 3D-view. When dragging away/towards you
really can’t see what you are doing, but it can however be seen numerically as a
floating text while dragging, specifying the actual coordinate as well as the offset from
the starting point.

A very useful feature with the Constrained dragging mode (1) is that it is possible to

refer to another control point (2) or mesh point and pick up its coordinate by simply
holding the cursor over the given point. A snap cursor occurs and the selection jumps
to the given position. The Intersection Point moves to the coordinate of the referred
point (3) and in the direction used when clicking on it.

In the fixed Front, Top and Side views, an additional red dot occurs in the middle
of the diagonal line of the Intersection Point symbol. This point is used for moving the

Intersection Point to the closest control or mesh point found within the snapping area,
in the direction away/towards you.. If there are several possible candidates, it will
choose the closest point measured from the original location of the Intersection Point.
If no points are found, if will not move at all.
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The Resize box
A gray rectangle, called the Resize box (1), occurs around the selection. The rectangle
is used for resizing the selected objects in various directions. Nine resize box handles
appears around the edge of the resize box and one in the middle (5). You can start
resizing when the diagonal Resize arrow cursor occurs, and by clicking on one of resize
box handles. Drag and then click again to finish the sequence.

The four corner-handles (3) allows both horizontal and vertical scaling and
proportional scaling if you press the Shift key.

The four midpoint handles allow constrained scaling horizontally and vertically.

The center-point is used for scaling from the center (5). Drag to the right to make it
wider (5), left to make it narrower, up to make it higher (7), down to makes it lower.
You can choose to just scale in one direction by pressing the Shift key and drag either
horizontally (5) or vertically (7). You can scale it proportionally from the center by
dragging diagonally (9) while pressing the Shift key.
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Holding the cursor over one of the corner points of the Selection box (1) can deform

the selection. Press the Alt/Opt key click and drag (2). The result (3) .can be seen to
the right.

A similar effect can be achieved by using the midpoints of the Selection Box (1).
Press the Alt/Opt key click and drag (2). The result (3) .can be seen to the right.

The lines (1) in between the control points of the selection box are used for rotation
of the selected objects around the midpoint of the selection. Click and drag when the
Rotation cursor is shown (1).

Holding over for example the top right segment (2), Alt/Opt-clicking and dragging
provide an alternative rotation point. It then rotates around the diagonal point in this
case the bottom left corner. Consequently, the top left segment (3) rotates around the
bottom right corner, the bottom left segment (4) around the upper right corner and the
bottom right segment (5) around the upper left corner.

The resize box is a rectangle that encloses the selection, regardless of whether all
control points are selected or not. The picture shows an example where some control
points in many objects have been selected, using the Selection Arrow tool, the Mesh
selection mode and by drawing a selection box. All control points within the box are
selected and the Resize box encloses only parts of the surface.
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Note that control points normally override the resize box if it is located over resize
box control handle. You can however get access to all resize points by turning off the
snapping features in the Constraints palette.

The resize box feature can be turned on and off at any time using the Resize Box
command found in the View menu, or by using the Command (M) / Control (W) + “<”
quick-key feature.

Moving objects
Objects can be moved by dragging, by using the arrow  keys, by entering new
coordinates in the edit fields above the drawing window, or by using the available
editing tools such as the rotate and resize tools etc.

Choose the Selection Arrow from the Tool palette, and activate the Object selection
mode in the Mode bar. Select an object by clicking on it. Click again on one of the red

dots to start the dragging procedure.  The surface now follows the cursor. Note that
you don’t have to press the mouse button while dragging. Click again to stop moving.

To move one control point, firstly click beside the object in the white drawing area
to deselect the object. Then click on one of the points using the Selection Arrow tool in
the Tool palette and the Mesh selection mode in the Selection mode bar. The red
Intersection Point indicator appears again indicating that the point is selected. Click
again to start the moving sequence. Click again to stop at the new location. Note that
the surface changes shape when you drag. Try moving some other control points.

You can Shift-Click to activate further points.
You can also draw a selection rectangle, where every control point inside will be

selected. Note that if you use the Object selection mode make sure that all control
points in the object are really enclosed by the selection rectangle to select an object. If
not, the object will not be selected.

Using the Arrow keys
The Arrow keys move all selected objects one grid step in the respective direction

and away/towards you when you use the plus and minus keys. Note that the movement
affects different coordinates in the Front-, Top-, Side-, Perspective- and Unfold- views.

The Up/Down keys, for example, increase and decrease the Y coordinate in the Front
and Side views and the Z coordinate in the Top view. The Perspective view behaves as
in the Front view when using the arrow keys. The same applies to the Unfold view
when the Edit 3D mode is activated. More on that in the chapter about the Unfold
view.

Nudge pan, zoom, and rotate view.
The arrow keys are also used for quick nudge panning when the Shift key is pressed,
nudge rotating the view by pressing the Opt/Alt key, and for nudge zooming by
pressing the Command (on Mac) / Windows (on Windows) keys.
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The Selection mode bar
The Selection mode bar is used for controlling the selection and editing of objects when
using the Selection Arrow tool in the Tool palette. The options are from the left: The
Global mode (1) selects all objects in the current layer. The Object mode (2) selects
objects as a unit, and all control points in an object are being selected. The Mesh mode
(3) selects all control points connected to the control point knot you click on. The

Vertex mode (4) selects individual control points, one at a time. The Vertex mode is
primarily used for decomposing control point knots when you need access to individual
controls.

The Object mode (2) has two optional methods in the Mode bar. The left button (1)
selects all objects associated with the control point knot clicked on. The right button
(2) only selects one of the possible objects. Two additional arrow buttons (3-4) occur
when you select this option. They toggle between all possible candidates, one by one.
Once the right one is found, click on the Intersection point to start dragging.

The Selection mode also affects the way new items are being added using the Option
or Option/Shift keys.

Object Mode duplicates the selected objects when you Alt–click on an object and
then start dragging.

Mesh / Vertex mode adds new control points when you Alt–click on a control point.
Mesh / Vertex mode adds a new control ruler when you Shift + Alt–click on a

control point and start dragging.
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Selection Mode examples
The Selection mode options are illustrated in the picture below:

Four surfaces were drawn, each having different line colors (1). Global mode (2)
selects everything in the currently active layer. Object mode (3) selects objects as units.
Clicking on a control point along the edge (3) between two or more surfaces selects all
surfaces connected to that control point knot, in this case the blue and green surfaces.

Clicking at the center-point of these four surfaces would select all four surfaces.
A selection rectangle (4) select all surfaces enclosed by the rectangle, in this case the

red and yellow (bottom two) surfaces are being selected.

Group/Object mode generates a copy of the selected surface if you press the Alt /
Opt key before you start to drag.

Mesh mode (5) selects all points located at the same physical location. All connected
control points move (6) when dragged in this mode. Mesh mode can be used for adding
new control points and control rulers.

Vertex mode (7-8) activates and moves one control point at a time.
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Adding new control points on a ruler
New control points can easily be added using the following steps:

Make sure that the Selection Arrow is selected. Choose the Mesh or Vertex mode in
the Selection mode bar (the two buttons to the right). The Object and Global mode
will generate new objects and that is not what we want to do now. Also, you can’t use
grouped objects because that would not work either. Select at least one control point.

Press the Alt / Opt key and then click again on one of the selected (red) control

points. New points occur when you drag them a bit. Note that the new points are
added upwards and away from the green starting point.

An alternative method is to use the Add Control Point command found in the Tool
menu. It essentially does the same thing as with the keyboard.

Is it possible to add points downward in the index list as well? Yes. Just use the Flip
Direction -> Along Ruler command in the Edit menu to reverse the index order of the

ruler and consequently move the green starting point to the other end of the first ruler.

Adding new rulers
The procedure for adding a new control ruler is similar to adding a point. Select a
point in a ruler by clicking on it, press the Shift + Alt / Opt keys, and then click on the
control point again. Drag the ruler to its new location.  As expected, the new ruler is

being added upwards and away from the green starting point dot.
An alternative method is to use the Add Control Ruler command found in the Tool

menu. It essentially does the same thing as with the keyboard.

Deleting control points and rulers
Deleting control points and rulers is done in a similar way. Select the point(s) you want

to delete, and then press the Delete or Backspace keys to delete the points. A ruler is
automatically deleted if all control points in the ruler are deleted.

Making a copy of an object
A copy of an object can be made is several ways.

One way is to use the Duplicate or Duplicate Array commands in the Edit menu

but we will revert to that later in the manual (in the Menus section).
A quick and easy way of creating a copy of an object is to select the Arrow tool in

the Tool palette, Object Selection mode, and then pressing the Alt/Opt key while
clicking on the selected object and before you start dragging.
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Cursors and snapping
The cursors play an important role when editing objects in TouchCAD.

The cursor shown when placing it over the drawing area symbolizes the three axes

X, Y and Z. The horizontal and vertical lines represent the screen plane and the
diagonal line the direction away/towards you. Small black dots occur at the end of the
respective axis whenever a snap in that direction occurs. The options are:

1/ No snap
2/ 2D snap

3/ 3D snap
4/ Horizontal alignment snap
5/ Vertical alignment snap
6/ Horizontal and vertical alignment snap
7/ Move the Intersection Point to the closest control point in the direction
away/towards you (note that other selected control points also move the same

distance). The intermediate red dot in the diagonal line indicates where the hotspot is
located.
8/ Snap to mesh grid. The cursor indicates if the snap is in 2D or 3D.

If you hold the cursor over a control point of an object, it changes and gets black
dots at the end of at least two of the lines (2-3). This implies that a snap event has

occurred. Dots at the end of the horizontal and vertical lines mean that the snapping is
on the control point in the horizontal and vertical directions.

In some cases you may see a dot on just one cursor direction (4-5). This indicates
that an alignment event has occurred with an alignment point (indicated by a small
blue circle). This only happens if the Alignment Indicator option is activated in the
Constraint palette (the bottom left button). In some cases you can get a double

alignment indication. This indicates that an alignment has two directions. You move
alignment points by holding the cursor over a control point for a short period of time.

If a dot occurs on the third diagonal line (3) you have a snap in the direction away /
towards you, that is, the control point is located at the current working plane defined
by the Intersection Point location, disclosed by the Intersection Point edit fields above
the drawing window. The dot here means that the cursor has a 3D-awareness and

indicates a snapping in the direction away / towards you, which you really can’t see on
the screen.

If you click on a control point, the Intersection Point / working plane moves the
depth location in the direction away / towards you.

If you drag a point to the location over another, a snap event occurs. The moved
point gets the same horizontal and vertical coordinate location as the point it snapped

to, provided that the 2D-snap option is selected in the Constraint palette (the top Left
button).
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The snapping may be three-dimensional too if the 3D-snap option is selected in the

Constraints palette (top right button). This moves the dragged control point to the
location of the object it snaps to in the direction away / towards you. What happens if
there is more than one location along the axis away /towards you? TouchCAD simply
chooses the closest point measured from the dragged point’s original location in the
direction away / towards you. This applies to the standard Front, Top, and Side views.
In the Perspective view you always get a 3D snap because it is assumed that you then

rotate the view to get a clearer view before you start dragging.
There is also an optional method that can be used for moving a selected point to the

closest control point in the direction away / towards you, and without the 3D snap
feature activated. Drag the cursor along the diagonal line of the Intersection point to
the red intermediate dot. A new arrow cursor occurs (7). Click and the Intersection
point moves to the closest available point. Nothing happens if it can’t find such a

point.
The Resize cursor that looks like a double-sided diagonal arrow occurs when you

hold the cursor over a Resize box control handle. A curved version occur of the Resize
cursor when holding over the gray selection box lines in between the controls to
indicate that a rotation will take place if you click. The curved version comes in four
shapes, used for indicating the rotation direction when pressing the Alt / Opt key for

rotation around the diagonal corner (as opposed to the center-point normally used).
The Snap to Mesh option in the Constraints palette (the bottom right button)

allows you to drag and snap to individual mesh points in an object that are not control
points. The cursor is however the same as for an ordinary snap.

TouchCAD also use a few other cursors such as the Zoom magnifying glass, the Pan
hand and the Selection Finger hand used when drawing selection boxes.

These features are controlled by the Constraints palette normally located below the
Tool palette to the left of the drawing window. It can be made visible if invisible by
selecting Constraints in the Palettes menu.

Rulers, points, curves, and surfaces and definitions thereof
TouchCAD objects can be subdivided into five different sub-data types named Points,
Rulers, Curves, Surfaces and Groups.

A point is an object consisting of a single set coordinates, and can described as a
ruler point.

A ruler is a number of connected points all located in the same ruler index.
A curve is a number of connected points, in which each point is located in its own

control ruler.
A surface is an object consisting of at least two control rulers, where at least one of

the rulers have at least two control points (in short a triangle).
A Group is a one or several objects grouped into a unit. All control points in a

group are activated when you click on a single point.
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Identifying object types
It is important to understand the difference between these data types for a number of
reasons. You can see the difference between rulers, curves and surfaces by selecting
them.

A ruler changes color to red if you select it because it consists of a single control
ruler.

A curve keeps its original color because it essentially consists of ruler starting points.

Rulers in curves do not become red when you select them because each ruler consist of
a single point, and a point does not have a length that can become red.

A surface changes the ruler elements to red when they are selected, whereas the
mesh parts keep their original colors.

A practical use is if you, for example, draw a circle defined as a ruler, you have to
press the Alt / Opt + Shift keys to extend it into a tube because you then need to add a
new ruler.

If you, on the other hand, start with a circle defined as a curve you already have all
the rulers you need. In this case you need an extra set of control points along each of
the rulers, and to do that you only need to press the Alt / Opt key before clicking to
add the new points along each ruler.

Points are essentially ruler/curve starting points and can therefore easily be

extended into rulers and curves as described above.
A group is simply one or several objects compiled into a unit. When selected, all

control points in the group are selected. In order to edit a group you must ungroup it
first using the Ungroup command in the Edit menu or activating the Ignore Groups
command, also in the Edit menu.

An easy way of identifying the data type of an object is to select it, and then look at

the top of the Object Info palette, where the Object ID, Ruler ID, Vertex ID and data
type of the object having the Intersection point is being specified.

Changing direction of an object
In some cases you may realize that it would have been better to use a ruler instead of a
curve or visa versa. It can be easily be fixed by using the Flip Direction -> 90 Degrees
command in the Edit menu. It converts rulers to curves and curves to rulers.

The Flip Direction -> Along Rulers and -> Perpendicular to Rulers commands in
the Edit menu reverses the object direction along the rulers and perpendicular to the
rulers. A common use for such commands is when adding new points or rulers and
when the object direction is wrong, that is when you want to add points downwards
towards the green starting point and not upwards as you normally do. The solution is

simply to change the direction of the object.
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It is also possible to change a single ruler or curve within a given object, for
example to fix a lofted surface where one of the rulers had an incorrect direction. The
Flip Direction -> Selected Ruler / Curve commands fixes such problems.

In the upper example (1), the upper control ruler is flipped in direction compared to
the other two rulers causing the deformed shape. Place the Intersection Point on the

upper ruler and select Flip Direction -> Selected Ruler (2 ).to fix it
In the lower example (3), the right curve, perpendicular to the control rulers, is

flipped in direction compared to the other two curves. Place the Intersection Point on
one of the control points to the right, belonging to the right curve, and select Flip
Direction -> Selected Curve (4) to fix it.
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Constraints palette

Constraints palette
The Constraints palette controls the how objects snap when you drag them.  The
options are Snap-2D (1), Snap-3D (2), Alignment indicator (3), Snap to Mesh (4),
Slide Along Ruler (5) and Slide Along Surface (6).

Snap 2D
The Snap 2D mode is used for 2D snapping to control points and mesh points. In the

fixed Front, Top and Side views it snaps to objects along the current working plane
but not in the direction away / towards you. If you are in a Perspective view you will
get a full 3D snap to control points because you are expected to rotate the view to a
location where you can easily identify the point to snap to.

Snap 3D
The Snap 3D allows you to snap to objects in all three directions, including the
direction away / towards you. If there are several possible candidates located at
different levels in the direction away / towards you, it will snap to the point closest to
the current working plane. The fixed coordinate fields above the drawing area define
the location of this working plane. In the Front view, the working plane location is
being defined by the Z coordinate, the Top view by the Y coordinate, and the Side

(Right) by the X coordinate.
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Alignment indicator
The Alignment indicator is an aid allowing you to place temporary help points and get
aligning lines from them. Above is an example showing how to draw a diagonal line

(2-3 & 11) based on the outer edges of two rectangles (1).
Make sure that the Alignment indicator and the 2D snap options are selected in the

Constraints palette. Choose the Line tool in the Tool palette. Hold the cursor over the
first point (4) used as an alignment point. Don’t click. A small circle occurs around
that point. Hold the cursor over the second (5) alignment point. Don’t click. Move the
cursor to a point that roughly aligns horizontally and vertically (5) with the previous

points. The cursor now indicates a snap in both the horizontal and vertical directions.
Note that you can get a dot on either the horizontal or vertical cursor line ends and
that suggest that you have an alignment in one direction only. Click and drag (7) the
cursor towards the intended end of the line. Hold the cursor over the first (8) and then
second (9) alignment point without clicking, and then move the cursor to a point close
to the final point (10) and then click. The line should look like in the final (11) picture.

Note that the alignment Indicator can be used for aligning in a single direction and
that can also be quite useful. The quick key is (L).

Snap to Mesh
The Snap to Mesh feature allows you to snap not only on control points but also on
individual mesh points. This applies to surfaces, rulers and curves (ruler starting

points).
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Slide Along Ruler
The Slide Along Ruler (1) command enables you to slide a control point (2) along the
control ruler it belongs to. The sliding follows the original shape in three dimensions as
you drag along the original ruler and while getting a snap indication.

The purpose of this feature is to re-distribute the control points along the ruler. As
always with mathematically generated curves, it is best to distribute the controls as
evenly as possible along the Ruler to avoid tension problems and the Slide Along Ruler

feature is very useful in this respect as it generates a minimum of distortion.

Slide Along Surface
The Slide Along Surface (1) feature enables you to slide a control point along the
surface instead of along the fixed working planes normally used in the Front, Top and
Side views. In the diagram above a control point is selected in the Front view (2). When
seen from the side (3) the surface forms a leaning plane. When the control point is
dragged downward (4) the control point not only moves downwards but also in the
direction away-towards you as seen to the right (5).

The purpose of this feature is to move the control points with a minimum damage
to the shape of the object. A practical use is to re-distribute the unfolded panels over
the surface as these are to some extent controlled by the shape of the rulers. The
practical result is a re-distribution of the unfolded patterns whereas the shape stays
more or less unchanged, at least when the feature is used with moderation.



___________________________________________________________________________
Page 37

Trackball palette

Trackball palette
The Trackball palette is used for rotating the view. You simply place the cursor over
the palette, click and drag. A red dot occurs when you release the mouse button. The

red dot indicates where on the map you are. Note that you have a faint blue world map
in the background. If you are above the horizontal centerline you are on the Northern
Hemisphere, that is, you look on the model from above (1). If the dot is close to the
horizontal centerline you are close to the Front view (2). If it moves one quadrant to
the right your are close to the Right view (3), and so on. The Trackball can be used at
any time, regardless of which tool you currently use. This also applies when the model

is displayed as a rendered picture.
A similar feature, called Rotate View, is found in the Tool palette. The difference is

that you need to select the tool first and then rotate by dragging over the drawing
surface.

The Trackball palette also provides alternative features. Press the Shift key while
dragging and the palette goes into the Dynamic Pan mode. Press the Opt /Alt key and

the palette goes into the Dynamic Zoom mode.
The Trackball palette is by default set to using the automatic Roll-Up feature that

rolls up the palette into strip when not used. Hold over the palette and it rolls down
again automatically. The advantage is that it leaves valuable drawing area uncovered.
In some cases you may want to leave it rolled down, and it can be done using the
Trackball Roll-down command found in the Palette menu.

The sensitivity of the Trackball palette can be adjusted by Control-clicking on it. A
pop-up slider occurs below the map where you adjust the settings. Click on the
Trackball again or move the cursor out of the Trackball area to go back to the normal
mode.

It is also possible to nudge rotate the view by means of the arrow keys in
combination with the Opt/Alt key.
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Layer / Color palette

The Layer/Color palette
The Layer/Color palette is used for adding and deleting layers and colors and for

controlling the accessibility of layers.
The Layer/Color palette is by default set to using the automatic Roll-Up feature that

rolls up the palette into strip when not used. Hold over the palette and it rolls down
again automatically. The advantage is that it leaves valuable drawing area uncovered.
In some cases you may want to leave it rolled down, and it can be done using the
Layer/Color Roll-down command found in the Palette menu.

Layers
Layers can be visible or invisible. Selecting a layer and then clicking on the Visibility
button (8) changes the visibility. Alt / Opt – clicking on the Visibility button makes all
layers visible or invisible. Note that the active layer is always visible regardless of the
state of visibility.

The four layer-modes (3) are:
Active Only where you only see the active layer, regardless of the layers are visible

or not.
Show All displays all visible layers but allows no snapping to objects in other layers.
Show / Snap Others displays all visible layers and allows snapping to objects in

other layers but no editing.
Showing / Snap / Modify displays all visible layers and allows both snapping and

editing of visible layers. Changing mode can be done with a Visibility popup (3) in the

Layer palette or in the View menu -> Layer Options ->…..
Layers can be added and deleted using the plus and minus (5) buttons in the Layer

palette. The Up and Down (7) buttons are used for changing the display order of the
layers in the list box (2).

Layers names can be changed it the name-editing field (4). Click on the layer to be
changed, write a new name and press Enter.

Layers are activated by clicking on the name of the layer in the name list field of the
Layer palette (2), or by selecting it in the Layer pop-up in the main drawing window.

The Info field (6) displays instruction messages concerning the Layer palette.
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Colors
The colors used in a particular document are defined in the Layer/Color (1) palette.
Click on the Color tab (2) of this palette. The picture above shows the options.

All colors have a name (2) to make it easier to identify them. A number of standard
colors are provided when you open the program. The colors may be deleted or edited
in any way you like because the color list is individual for each document. TouchCAD

automatically adds any additional colors to the list if you import objects into a drawing
using the Open Info command in the File menu. The currently selected color is
indicated by the brush (2) symbol in front of one of the color. Below the color list there
is a field used for editing the color name (3). The line and fill colors (4, 5) of a color
definition can be edited by clicking on their respective color fields. A standard color
selection dialog then occurs where you can choose any color. The line and fill colors

may have different colors, which may make the model easier to understand and edit.
The Transparency (6) field controls the transparency / opacity of the color when
rendered. Note that you need an accelerated video card to be able to see the opacity
when you render. Some older video cards require a color depth set to thousands (of
colors) to work full-screen on a big monitor. The Plus and Minus (7) buttons are used
for adding and deleting colors. The order of the list may be edited using the Top, Up,
Down and Bottom (8) buttons. The Help (9) field displays short instructional messages
when you hold the mouse over a field.

Below is an example showing a rendered picture containing transparent objects.

Colors can be exported as layers when exporting to DXF and VectorWorks text.
This allows you to divide the model into color identities and that can be useful when
exporting to a rendering program.
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Object Info Palette

The Object Info Palette
The Object Info palette is used for editing various object properties such as
dimensions, weight, weight per area unit, surface display and behavior mode, and the
way it should be unfolded (or not). The Object Info palette has three tabs, Dimension
(1), Properties (2) and Unfold (3).

The Dimension tab (1) controls the width, height and depth of the selected object(s).

Resizing objects can be done from the lowest coordinate value, mid-point, or highest
coordinate, and individually in the X, Y and Z directions. A more detailed resizing
dialog can be displayed using the Reshape command in the Edit Menu. This dialog also
allows scaling by a scale factor, proportional scaling, and scaling from the Intersection
point.

The Properties tab (2) contains various object specific settings such as horizontal

and vertical mesh resolution, skin type, display mode, layer and color identity, shape
closing and if the object is to be used for marine calculations.

The Unfold tab (3) specifies the unfolding properties of the selected object(s), such
as unfolding direction, if the object sub-strips should be treated as individual objects or
not, if the object is to treated as a combined stretch unfold object or being joined in
combined groups of objects. Overlaps can also be added individually along the outer

edges of the panel, and along the internal joints. The internal joints can either be on
one side, facing upwards or downwards from the green point, or be double-sided. The
joining point between joined sub-panels can be set parametrically to any vertex along a
joining side, and this feature can be useful when optimizing the use of material. The
Flip checkbox is used for turning the selected pattern upside down when required
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Object Info, Dimension Tab

The Dimension Tab (1) in the Object Info palette is used for defining the physical
size and weight properties of the selected objects. The ID index, ruler index, point
index and data type of the object holding the Intersection Point is displayed to the
right of the Dimension text (2). If nothing is selected it reads –1.

The Dimensions section.
The Dimension section (2) allows numerical resizing of the selected objects in the X, Y,
and Z directions (4). The Min, Center and Max buttons controls the location of the

scaling center point (3). Resizing can also be done visually using the Resize box on the
drawing area, and the with the Reshape command dialog in the Edit menu, which
provides additional features such as resizing from the Intersection point, proportional
resizing, and resizing by means of a scale factor.

The Weight section.
The Weight section (5) controls the weight properties of the selected objects. There are
two methods for defining object weights.

The first method (6) ignores the surface area altogether. This method is primarily
used when the true object weight is known, for example an engine, a battery, and other
fittings. In such cases you typically know the weight of the object and in such cases you
simply enter the weight of the object in the Weight (6) field. If a point object is used, it

is assumed that the point coordinates are located at the center of gravity of the object
in question. If a surface object is used, the center of gravity of the surface area is used
as a weight point. It is a reasonable assumption provided that the object has an
uniform weight distribution. If not, it may be a good idea to sub-divide the object.

The second method (7) defines a weight per surface unit property, for example
0.320 Kg / square meters or 15 Lbs. / square feet. The Surface Properties commands,

found in the Tool menu, allows you to multiply this weight property with the true 3D
surface area and center of gravity, to calculate the object weight as well as its center of
gravity.



___________________________________________________________________________
Page 42

Object Info, Properties Tab
In most cases you start with a crude object sketch based on the standard tool

objects, and then refine it in various ways. The Object Info palette plays a key role in
this process with its many parametric settings. Let’s take a closer look at what you can

do with it. Start by opening the Manual1.T3D drawing. Select an Isometric view by
choosing the Right Isometric view in the View menu or pressing the (3-key) on the
numerical keyboard. The result should look similar to the picture below (2).

The Properties tab
The Properties tab (1) is used for modifying various 3D properties in objects such as
skin type, display mode, mesh resolution and so on.

Changing the surface skin type
We are now ready to experiment a bit with the object settings. Make sure that the

object is selected. It is selected if it has at least one red dot along the rulers. Click on
the Properties tab. Locate the Skin Type (1) popup.

The Skin type popup has four options. Straight (2) / Straight (3) draws straight lines
between the control points in all directions. Smooth (4) / Straight (5) smoothes the
object along the ruler (4) but draws straight lines perpendicular (5) to the control
rulers. Straight (6) / Smooth (7) draws straight lines along the control rulers (6) and
smoothes perpendicular to the rulers (7). Smooth (8) / Smooth (9) draws smooth
curves in all directions.
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Changing the skin mesh resolution
Two Resolution (1) edit fields in the Properties tab of Object Info palette control the
skin resolution setting. The default skin resolution setting is five by five steps (1-2).
This may be a bit crude so try changing the horizontal resolution (along the rulers) (3)
to 16 steps and then press Enter. Note that the object now looks smoother.

The Vertical (4) resolution setting (perpendicular to the rulers) is edited in the same
way. Note though that changes in the perpendicular resolution are only visible in the
skin types having smooth curves perpendicular to the rulers. If this happens, try
changing it to Smooth along the rulers and Smooth Perpendicular to the rulers in the
Skin Type pop-up. Experiment with the resolutions and skin types!

Layer and colors
The layer and color identity of an object can be changed using the respective popup
menus in the Properties tab.  Note that there is a difference between selecting the active
layer and color, which is done in the drawing window or in the Layer / Color palette
and changing the color and identity of an object, which is done in the Object info
palette.

Display modes
TouchCAD has five display modes for surfaces. The setting can be changed using the
Display popup found in Properties tab of the Object Info palette.
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Contours.
The Contour mode (1) only displays the surface outlines. The mode is primarily used
for reducing the number of lines of objects that you currently are not working with but
still need to see. The mode makes it easier to understand the model especially if many
surfaces are used and/or if each surface has a high resolution. Each surface may consist
of up to 32.000 quads or 64.000 triangles, which generates a substantial number of
lines.

Mesh.
The Mesh mode (2) displays the mesh lines as well. This mode gives a good overview of
how the shape looks. Mesh mod is the default mode. It displays the mesh using the
specified values in the SurfRes H and V fields in the Object Info palette.

Cross-sections
The Cross Sections mode (3) displays the cross sections as shown in the picture above.
The Cross sections option displays the model using fixed section steps, similar to the
way contour lines appear on maps. The cross sections are only visible in the fixed
Front, Top and Side views. Other views are displayed as contours.

TouchCAD allows you to switch between the Front, Top and Side views and

dynamically update the cross sections as you modify the shape. This provides a detailed
control of the shape of the surface. It is primarily used for modeling shapes in a very
accurate way, for example, to define a boat hull. It is usually recommended to limit the
use of this mode, especially at high surface and sectioning resolutions because it
requires quite a lot of processing power. It can therefore be a recommended procedure
to use it while defining the shape of a give object and then turn if off when you’re done

with it.
Choosing Sectioning Settings in the Page menu sets the sectioning options, including

the X, Y and Z direction steps, help lines and corresponding lead texts, etc. The
sectioning starts where the light blue lines are located on the screen and away there
from in any direction until the model ends. The relationship between grid and model
can either be changed by simply moving the model, or by moving the zero point using

the Move Print Area command in the Page menu. Note that the Move Print Area
setting is unique for each view.

Curves along or perpendicular to the rulers.
These two display modes are similar to the Mesh mode but the grid lines are only seen
in one direction. The Curves Along (4) and Perpendicular to the ruler (5) modes can be

useful for displaying the panel layout in the 3D-model while comparing it to the



___________________________________________________________________________
Page 45

unfolded patterns, especially if you turn on the Show 3D Object ID feature in the View
menu. It can be described as an assembly map for the unfolded parts.

Panel joints.
The Panel Joints mode displays where the unfolded panels joints are being located. If
an object lacks unfolding properties or is set to one of the Stretch Unfold modes the
panel is displayed as an outline.

Overlapping mesh.
The display modes from item 7 and below appears to don nothing in the drawing
window but it affects the way objects are being displayed when rendered. All items
below item 7 except Mesh mode renders surfaces as wireframe objects. Mesh mode
renders surfaces as a solid skin without edge highlights as seen above in the upper
section of the image. All items from 7 and above combine a skin rendering with

highlighted outlines, meshes, cross sections, lines along or perpendicular to the surface
direction and panel joints. The later often adds clarity to the illustrations and gives a
slightly more drawing style feel to the image.

The options from item 7 also exports DXF, VectorScript and 3DMF
(QuickDraw3D) files as seen when rendered, that is as a skin surface with interlaced
contours.



___________________________________________________________________________
Page 46

 Closing shapes
Objects can be closed in a number of ways using the Close popup in the Properties tab.
Control rulers, curves and surfaces can all be closed in one way or another. A simple
example is if you draw a control ruler where the end point is not connected to the

starting point. It is possible to connect these points by selecting the Close along Ruler
item in the Close popup. This feature connects the start and end point(s) internally.
The same applies to objects consisting of curves (ruler starting points) and surfaces.
Surfaces can be connected along the control rulers as well as perpendicular to the
control rulers or both, which can be useful in some cases.

The example above shows a surface (1).
The second (2) example shows the same surface being closed perpendicular to the

control rulers.  This option adds a ruler above the ruler with the highest index and
physically place it at the location of the first control ruler. Note that the shape is not
closed along the control ruler.

The third (3) picture shows the same object being closed along the control rulers.
This option connects the first and last control points along a control ruler so that a

closed shape is created. Note that it is still open perpendicular to the control rulers.
The forth (4) example closes the surface along as well as perpendicular to the

control rulers. The result is closed in all directions.

Marine Calculations
The last item in the Properties tab defines an object as being used for marine

calculations such as overall length, length in the waterline, overall beam, beam in the
waterline, draft, displacement, prismatic coefficient, block coefficient, center of
buoyancy, lateral center point, wetted surface, and section area curve. The calculation
can be performed on any number of surfaces, but it may be practical to limit the
number of surfaces to the relevant objects only. You will find more details on this
subject in Marine Properties menu command section of this manual.
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Object Info, Unfold Tab
A key feature in TouchCAD is the ability to unfold virtually any surface defined by

two control rulers and at least two control points.

Unfold View
Start by selecting the object. Click on the hull surface using the Selection Arrow. Click
on the Properties tab (Prop.) and change display mode to Mesh (2). Set the horizontal
resolution to sixteen and the vertical resolution to eight. Click on the Unfold tab of the
Object Info palette (3). The first step is to define the surface as an unfoldable surface.
It is done by selecting an unfold type in the Unfold popup (4). Choose Joined
horizontal (4). Click on the Unfold (5) button in the View bar or press the Zero key on

the numerical keyboard. The surface is now unfolded using joined horizontal strips,
and at the resolution of the mesh. The red dots indicate that the surfaces are selected.
Now try the other options in the Unfold popup. They allow you to parametrically
unfold the surface in several different ways. The Vertical unfolding option may
produce too many strips to be practical for production, but it is easy to fix. Just click
on the Prop. tab and then change the horizontal resolution to, for example, eight, and

the problem is reduced.
Stretch Horizontal and Stretch Vertical enables you to join all strips into a single

unit by adding a certain degree of deformation or stretching. This can be useful when
unfolding stretchable materials such as metals and some types of fabrics, where you
start with a basic sheet that you deform into its final shape. When using stretching you
add tensions to the material and it should therefore be used with caution and based on

experience with the materials used. TouchCAD does however provide tools to analyze
and help reducing the tensions when shaping an object. More on this in the General
Unfolding Settings section.

TouchCAD also provides methods being a cross between the ordinary unfolding and
the stretch Unfold methods by joining sub panels in sub-groups.
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Unfold direction
Below is a picture showing what the Unfold options look like. The Join at Vertex
option allows you to move the joining point between sub-surfaces by entering a factor.
Zero means the first point, one the second point and so on. It is useful for making
joined unfolded surfaces as compact as possible.

Stretch Unfold calculation
The Stretch Unfold features combine main panel sub-strips into a single unit, where
you let the material carry the tensions generated by stretching the material. The result

can be defined as an approximation of the final shape such as it looks before the
stretching takes place. A sweater, for example, is essentially a flat piece of fabric that
stretches into the final 3D shape when you take it on. The image below shows the same
surface as ordinary horizontally unfolded panels (left) and as a stretch Unfold panel
(right).
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The stretch unfold options enable you to numerically place a balance point from

where the calculation starts. In most cases it is best to start in the middle but when the
surface has lots of tensions on one side it may be better to move the starting point to
balance the tensions. The starting point is represented by a purple colored rectangle
and the JoinPt H and JoinPt V edit fields in the Unfold tab of the Object Info palette is
used to control the location.

Since the stretch unfold options is a form of approximation of the unfolded shape, it
of course generates tensions. The image above shows the difference between the normal
unfolds mode shown as dotted lines, and the Stretch Unfold mode shown as a gray
surface.

TouchCAD can however specify where the tensions occur and the degree of tensions
generated. In the View menu, select Show in Unfold -> Stretch Tensions. The
illustration above shows the tensions defined as absolute offsets relative to their
respective original location with the Stretch Unfold options turned off. The dots
indicate that the vertex has an offset above the stated limit as defined in the Stretch
Settings dialog found in the View menu -> Show in Unfold -> Stretch Settings.

What an acceptable level of tension is depends on the material used. A very flexible
material such as the fabric used in for example a sweater of a T-shirt can be stretched
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quite a lot whereas for example carbon fiber or kevlar is extremely rigid. It is therefore

important to use these features with caution and based on experience.

Stretch Unfold Settings
The stretch unfold settings can be found in the View menu -> Show in Unfold –>
Stretch Settings. The Round To (1) pop-up defines how many decimals to be used in
the texts. The Display Type (2) popup sets the display style for the tension markers.

The options are Dots where all points having a value above the limits are marked with
a dot, Values where the same points are marked with a text label, or Dots and Values
where both are being displayed. The Text Size Unfold (3) edit field defines the text
sizes used within the Unfold view. The Ignore Tensions Less Than (4) edit field defines
the lower limit of the tensions where they are ignored. This setting should be set
according to the material used, the size of the object and so on. The Define Limits (5)
buttons define if absolute values should be displayed or if it should be displayed as a
percentage of the width of the local panel.

Balancing point
The balancing point is adjustable using the JoinPt H and PoinPtV edit fields in the
Object Info palette as seen above, here illustrated with a filled rectangle, normally not
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used in the program. Note that the purple colored tension markers move as the

balancing point moves. In most cases and by default it is set to the center of the surface
but in some cases there is a distinct advantage to move it, for example when there are
lots of tensions on one side or corner and less in other areas. It is therefore advisable to
experiment a bit to generate an even distribution.

Note that the tension values change as the 3D shape changes so it may be a good
idea to experiment a bit with the shape to reduce tensions as much as possible.

Joining unfolded strips into groups
It is also possible to join unfolded strips into groups, which can be said to be a cross
between the ordinary unfolding modes and the Stretch Unfold modes. This
intermediate method can generate tensions just as the Stretch Unfold modes so it also
supports the tension analyzing methods mentioned above.

In the example above, the panel mesh resolution is set to 16 x 16 (2) in the
Properties tab (1) of the Object Info palette. The unfolding mode is set to Joined
Horizontal (3) in the Unfold Tab. The edit field at the bottom of the Unfold tab
controls the number of joining steps (4). When set to one (4), it splits the sub panel
according to the mesh resolution (2). When set to something evenly dividable to the
mesh resolution such as four (5), sixteen is evenly dividable by four, the sub-strips are
joined evenly in groups of four. Note that the tension markers are now visible. When
set to five (6), which is not evenly dividable by sixteen, the first three are joined in

groups of five (7) and the last spare (8) forms a single strip, all counted from the green
starting point (9).
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Overlaps / Seam allowances
The picture below shows the overlap options. Each of the four main panel sides can
have its own overlap setting called External Overlap 1-4 and the joints between the
main panels has a setting called Internal Overlap. This inner overlap can be place on
either the upper or lower side seen from the green starting dot, or it can have an
overlap on both sides.
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General unfolding settings
TouchCAD provides a range of general unfolding settings. These options can be found
in the View menu -> Show in Unfold -> etc.

These options allow you to organize and keep track of very large and complex
models consisting of hundreds of sub-panels. All these unfold options are supported
when exporting as DXF (supported by most CAD programs), VectorWorks
(VectorScript) and PlotMaker (PlotMaker is a program for controlling sail panel
cutting machines used by many sail makers).

1/ The Cut lines option shows the outer edge of the surface including overlaps.

2/ The Joining Lines, show where the final assembled surface edges meet.

3/ The Starting Point is used for specifying where each panel starts. The point of a
main panel is the green dot and it is visible in 3D too. Note that there is a Show Object

ID higher up in the menu and this option allows you to see the Object ID number in
3D as well.

4/ Alignment marks (sometimes also called strike up marks) plot lines along the
edge of the panel and helps to align surface edges when assembling panels.

5/ The Mark settings specify the length of the alignment marks.



___________________________________________________________________________
Page 54

6/ Object ID inserts a panel number in the corner in the following format  (5/3). The

first number specifies the main panel number and the second is the sub panel number
(e.g. 5/3 means that the main panel number is five and it is the third sub panel in that
main panel. Note that the sub-panels always occur in consecutive order with the
starting point in the same corner. This keeps track of where they belong.

7/ The Vertex ID plots the vertex number along each side. This aids when

assembling large panels with many points along the edge.

8/ The Cut Coordinates option plots the coordinates along the true edge of the
panel including overlaps. It is useful when optimizing the use of material to fit into a
given material width or height. Note that each panel has its own local coordinate
system, and it will dynamically update as you move and rotate the object. It even

allows you to edit the 3D-model with the arrow keys while being in the Unfold view. It
works because the 3D model is dynamically linked to the unfolded model, so changes
in 3D can instantly be seen in the Unfold view. If you look closely you will se that the
unfolded shapes and coordinates slowly changes as you move. Optimizing the use of
material can therefore be an integrated part of the design process in an efficient and
powerful way.

9/ The Plot Coordinates are basically the same as the Cut coordinates but they
represent the inner joining line instead.

10/ Text size sets the size of the texts in the Unfold view.

11/ Use Line Colors display the 3D-line color instead of the standard unfold colors.

12/ Use Fill Colors display the 3D fill color instead of a white outline. It can be used
for printing out color scale models on a color printer.

13/ Folding lines display lines across the unfolded surfaces. The primary use is to

indicate where to fold panels using a folding or plate rolling machine.
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14/ Stretch tensions displays the amount and location of the tensions generated
when using the Stretch Unfold modes and when combining strips into groups using the
Join Steps option.

15/ Stretch Anchor Points is used as a balance point for the Stretch Unfold modes.
The Anchor Point is displayed as a purple rectangle (above shown filled to make easier
to find). The point should normally be placed in the middle though in some cases it
may be useful to move it a bit to re-distribute and balance the tensions more evenly
over the surface. This can be done using the JoinPt H and JoinPt V edit fields in the
Unfold Tab of the Object Info palette.
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16/ Stretch Unfold Settings is used for customizing how the tensions are being
displayed. The image above shows the dialog. The Round To (A) pop-up controls the
number of decimals used. The Display Type (B) pop-up controls what to draw in the
drawing area. The Text Size Unfold (C) edit field controls the text size used in the
Unfold view. It is usually practical to keep it as small as possible as the tensions
calculations tend to generate lots of texts.  The Ignore Tensions Less Than (D) edit

field controls what to ignore in tensions. This setting is very individual and must be set
based on experience and the type of material used. Typically, more flexible materials
allow a higher setting. The Define Limits By (D) buttons control whether to use
absolute value offsets when plotting or an offset as a percentage of the sub-strip width.

Unfold export limitations.
All these options can be printed and exported to other programs. There are however
some limitations:

The DXF export does not support fills.
The PlotMaker and HPGL export does not support fill colors and coordinates.
The VectorWorks export supports all options.
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Tool palette

The Tool palette contains various tools for drawing and editing objects. The palette

is sub-divided into three sections.
The red section (1) at the top contains tools for editing objects and views. It includes

zooming, panning, selection, rotation, cutting, joining, alignment, lofting, extruding
and sweeping tools.

The blue section (2) in the middle contains basic 2D style tools such as lines,
rectangles, circles, double lines, polygons and arcs.

The yellow section (3) contains various pre defined 3D objects such as surfaces, 3D
points, cubes, spheres, torsos, cylinders, tubes, rectangular to circular transformations,
T-tubes, etc.
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Selection Arrow

The Selection Arrow tool is used for several things.

Starting and finishing activities.
First of all the Selection Arrow tool is the start and stop point of most activities. If you
for example draw a rectangle, you select the Rectangle tool and draw one or several
rectangles, and then finish the sequence by selecting the Selection Arrow. If you by
mistake forgot to select the Selection Arrow tool and therefore started a new activity
sequence with another tool, it is possible to cancel it by pressing the Escape key. If no

activity are in the works the active tool shifts to the Selection Arrow when the Escape
key is pressed.

Selecting and deselecting tools and activities.
The most common use of the Selection Arrow tool is to select and deselect objects,
tools and activities. You typically select objects by clicking on them with the mouse.

In the drawing area you deselect by clicking on an area beside the available objects.
Object can be selected by clicking on a control point or by drawing a selection box
around the object or objects. Several objects can be selected by pressing the Shift key
while clicking or drawing a selection box.

 Editing selected objects.
Selected objects within the drawing area can also be edited in a wide range of ways
with the Selection Arrow tool. The selection can be dragged, resized, scaled, deformed,
skewed and rotated.

More info regarding editing with Selection Arrow can be found in the Drawing
Elements chapter.
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 Zoom and Pan

The Zoom (2-3) and Pan (1) tools behave like a standard drawing program. There
are however a few things worth noting.

Pan tool
The Pan/Hand (1) tool in the Tool palette allows you to move the drawing area
relative to the drawing window.

Panning can be done using the scroll bars along the right and bottom edges of the
drawing window. A third option is to press the Space Bar key on the keyboard. This

feature temporarily activates the Pan/Hand tool. Move the drawing area to a new
location and press the Space Bar again to return to the previously selected tool. A forth
option is to press the Shift key and then use the Arrow keys. It scrolls the view 1/3 of
the screen width in the direction of the arrow.

Zoom in tool
There are no fixed zoom steps as sometimes found in other programs. Instead you have
access to a powerful proportional zoom tool. The Zoom in (2) tool in the Tool palette
allows you to draw a selection rectangle around the area concerned. This area will
zoom in filling the drawing area. A small selection area will drastically increase the
degree of zoom but choosing a selection rectangle slightly smaller than the drawing
area creates a small increase in the zoom. You can double-click on the Zoom In (2)
tool to double the degree of zoom.

Zoom Out tool
The Zoom Out (3) tool works in reverse. The quickest way to zoom out is often to

use the Fit to Window command in the Page Menu (Command/Control + 4), which
brings back a view where the entire sheet area is seen (the light blue rectangle).

There are also some view control tools in the bottom left corner of the drawing
window. The first four buttons (1-4) are used for storing up to ten views and to step up
and down in the view list. The forth and fifth buttons (5-6) double and half the degree
of zoom. The blue sixth button (7) fits the drawing area into the drawing window. The
last button (8) centers the drawing area on the object(s) selected.
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Mirror tool

The Mirror tool (1) is used for flipping an object around a given axis. Two modes
allow you to just mirror the object or creating a mirror copy of the selection. Below is a

picture showing the steps.

Mirror mode
In the first example we will just mirror the object. Start by selecting the object using the

Selection Arrow, Object mode in the Mode bar. Note that you can mirror element
within an object, but that is not what we want to do now. Select the Mirror tool (2) in
the Tool palette. Select the Mirror mode (2) option in the Mode bar. Draw a horizontal
lever arm along the centerline by clicking on the first point (3) and then the end point
(4). In this case we used the snapping features to get a horizontal line. It is possible to
draw a horizontal line by pressing the Shift key while drawing the lever arm. The

mirror action takes place directly after the second click (4). The picture (5) may
incorrectly suggest that there is an offset. It has been offset for diagrammatic purposes
only. The mirrored object will be located on the other side of the lever arm.

Mirror and Duplicate mode
The Mirror and Duplicate mode works in the same way. Select the object. Make sure

that the Mirror and Duplicate mode (6) button is selected, draw the lever arm (7, 8),
and a mirror copy occurs on the other side of the lever arm line (9).
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Rotate tool

The Rotate tool (3) rotates selected objects. Start by selecting an object using the
Selection arrow (1-2). Select the Rotate tool (3) in the Tool palette and make sure that
the Standard mode (4) is on in the Mode bar. The procedure consists of three steps.
The first step is to click on the center point (5) of the rotation. A gray rubber band line
occurs. Move the cursor to a second location (6) and click again. The line you just

created is the lever arm used for the actual rotation of the object. The selected object or
objects now follows the lever arm (7) movement around the center point. The third
step is to finalize the rotation by a third click (8).

A few points are worth noting. You can see the current rotation angle (9) above the
drawing area.  You can make use of the snapping while rotating by holding the cursor
over a non-selected point. You can lock the lever arm to be horizontal, vertical or

being at 45 degrees by pressing the Shift key. Note - all angles are in degrees reading
counter clockwise from zero at due east.
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Rotation modes
TouchCAD provides three rotation modes, which can be selected in the Mode bar

above the drawing window. The first rotation mode rotates objects in a fairly standard
way.

The Constraint Rotation modes block out the offsets in one direction and therefore
result in a skewed rotation. The Horizontal mode blocks the vertical offsets and vice
versa.

An example of use for the constraint rotation mode can be to make a boat hull
wider (seen from the top) by selecting all points from the mid-point and backwards
(excluding the points along the center-line).

Select the Rotate tool (1) in the Tool palette and then select the mid-button in the
Mode bar. This mode allows vertical movements and blocks horizontal movements.
Click on the center of rotation point (2). Drag to the left while pressing the Shift key to

lock the lever to being horizontal and then click again (3). Drag the lever arm
downward (4).  Note that the movement gets bigger further away from the center-
point (5). Click to finish the sequence.

Spend time experimenting with constrain mode rotation. You will find that it can be
used for generating all sorts of useful effects. An entire object can for example be
skewed if you select all control point in an object and then rotate from a point close to

the center of the object.

Other rotating methods
Note that TouchCAD also provides a range of other tools for rotating objects in the

Edit menu -> Rotate -> submenus. The options are; Rotate Left 90°, Rotate Right 90°,
Flip Horizontal, Flip Vertical, and Rotate by means of a dialog. The later provides the

same features as on the drawing, but here you enter the rotation values numerically.
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Align tool
The Align tool is used for aligning objects to rulers or surfaces. Two methods are

provided.

Align to ruler
The Align to ruler mode can be used for aligning control points to a control ruler in the
X, Y and Z direction. Both individual rulers and rulers within a surface can be used as
master curves. Below is a picture showing the steps.

Start by drawing a control ruler (4) to which it is intended to align to. Note that is

must be a ruler and not a curve (a series of ruler starting points). Select the control
points (3) that you want to align to the curve, using the Selection Arrow, and then
place the Intersection Point at the master curve (4). Note that you can move the
Intersection point to the right curve if it is in the wrong place by double-clicking on a
selected control point on the master curve if you have a selected point, or Shift-clicking
on it if you have no selected points there. Select the Align tool (1) in the Tool palette,

make sure that the Align to Curve mode (2) is on in the Mode bar, and then click on
the related Directional (5) button in the Mode bar. The Directional (X, Y, Z) buttons
execute the command when you click on it and align the selected points to the master
curve (4). The result can be seen in the lower picture (6).
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Individual control rulers in a surface object can also be used as a master-aligning
object. The picture below shows an example where two control points (3) are being
aligned to the center-ruler of the surface (4). The steps are the same as before. Click on
the points to be aligned using the Selection Arrow (3) and then select the master ruler
(4). Select the Align (1) tool in the Tool palette. Make sure that the Align to Curve (2)
is selected in the Mode bar. Click on the appropriate directional button (5) in the
Mode bar. In this case it was the Z button. The selected control points align to the

master curve (6).

Align to Surface
The Align to Surface mode is used for projecting control points to a surface. Below is a
picture showing the steps.

Select the control points (4) you want to project to the surface using the Selection
Arrow in the Tool palette. Place the Intersection Point (5) on the master surface or
object group consisting of surfaces (5). Select the Align tool (1) in the Tool palette.
Select the Align to Surface Mode (2) in the Mode bar. Click on the appropriate
Direction button (3) in the Mode bar to project the points on the surface. The result (6)
is shown.

The Align to Surface mode can be used for many purposes such as placing graphics

on a surface (7 - a water line), or to find the intersection between the surface and an
internal object such as a bulkhead or a cushion (8).
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Rotate View tool

The Rotate view tool rotates the view. It does not rotate the objects. You rotate the
view by selecting the Rotate View (1) tool, note that the View mode changes into

Perspective mode (2), hold the cursor over the drawing window (3), click and drag (4-
5). Drag horizontally to rotate horizontally (4) and vertically to rotate vertically (5).
Click again to finish the sequence.

Other ways to rotate the view
Another method for rotating the view includes using the Trackball palette, which has

the advantage of being modeless and can therefore be used with most other tools
without switching tools. Other methods include using the numerical keyboard (0-9),
and using the standard views in the View menu. The view can also be nudge rotated
using the arrow keys in combination with the Alt/Opt key.
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Join tool

The Join (1) tool is used for joining objects. Two objects can be joined provided it
has the same number of control rulers and that they are physically connected along
one edge and that the rulers have the same direction. Surfaces, as well as curves (a
series of ruler starting points), and control rulers can be joined.

Below is a picture showing the steps.

Select the Join (1) tool in the Tool palette. Click on the first control point (2) along
the joining side and then on a second control point (3). The objects are joined (4)
provided all the above mentioned conditions are met.

A few things are worth noting. The reason for having to click on two points is that
it allows you to join two objects in the middle of a bigger mesh of individual objects.
The joining lines typically reduce the number of possible joining candidates to two.

When joining curves (a series of ruler starting points) and control rulers you don’t have
access to two individual points. In such cases it is perfectly valid to click twice on the
same point, because you then seldom need to worry about other objects.

Other joining methods
TouchCAD also allows two objects to be joined using the Join menu command in the

Edit menu. In this case you simply select the two objects to be joined and then select
the Join command to join them.
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Cut tool.

The Cut tool is used to divide objects at control points, along control rulers or
perpendicular to control rulers. The method used is very similar to the Join tool. Below

is a picture showing the steps.

Cutting along a ruler
Select the Cut (1) tool in the Tool palette. Click on the first cutting point (2). A rubber
band line (3) occurs that you drag to the second cutting point (4) where you click
again. The screen flickers slightly indicating that the cutting procedure has taken place.
Use the Selection Arrow tool (Object mode) in the Tool palette to separate (5) the two
elements.

Cutting perpendicular to a ruler
Cutting perpendicular to the control rulers works in the same way. Use the Cut (1)
tool and draw a cutting line (6->7) perpendicular to the control rulers.

Placing a cutting line along the edge of for example a ruler generates an error
message. The reason for this is of course that it doesn’t make sense to do a cut if you
don’t get anything on both sides of the cut.

Cutting off control rulers and curves (ruler points) works in the same way. In such a

case you can’t click on two separate points because you don’t have two points, so just
click twice on the same point.

Cutting in between two rulers
The easiest way is to insert a temporary cutting ruler or set of control points (an extra
cross section consisting of control points) where you want the cut, and then use the

Cut tool.

Other cutting methods
The Split Object -> Along Rulers / Perpendicular to Rulers commands in the Edit
menu allows splitting of objects along or perpendicular to the control rulers in one
step. Note though that the split takes place on every station along the selected path.

One use for such a split is to split a surface into individually editable objects when
arranging a cut layout in the Unfold view.
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Polygon Extrude tool

The Polygon Extrude tool is used for extracting a cross section and then extruding
it along a polygon that you draw. It works like drawing a double-line but you can

extrude just about any cross section along the polygon path. Below is a picture
showing the steps.

We will extrude a cross section from the Top view, and need a cross section being
vertical from that view, that is, it has a depth in the direction away / towards you.
Drawing the cross section seen from the Front or Side (Right) views can be used in this
case. We have here used the Side (1) (Right) view when drawing the cross section (2)
polygon. Select the Top (3) view in the View bar. Select the object (5) by clicking on it

with the using the Polygon Extrude (4) tool or by using the Selection Arrow tool.  The
location of the Intersection point determines offsets (6) relative to the control polygon
(7-8). Start clicking out the extrusion path polygon (7). A polygon drawing sequence
can be terminated in two ways, by double-clicking (8) on the last point if the shape is
open, or by clicking once again on the starting point. The first alternative was used in
this example. Once the sequence is completed the new extrusion (9) occurs.

3D-extrusions
The Polygon Extrude tool can also be used for generating extrusions having a variable
depth in the direction away / towards you. This can be done by using the 3D-snapping
option in the Constraint palette and by snapping on object points having different
height locations (in the direction away / towards you). The Cross section (1). The
Extrusion path (2). The extruded object (3).
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Measure tool

The measure tool is used as a temporary measuring device for measuring the 2D and
3D length and tilt angles. Below is a picture illustrating the steps.

The illustrated object is a 3D surface shown in the Perspective (1) view. The actual

measuring procedure must take place in the standard Front (2), Top or Side (Right)
views. Select the Measure (3) tool in the Tool palette. In this case we want to measure
the 3D lengths and using the mesh knots along the edge. To do this, activate the
2Dsnappin (4) as well as the Snap to Mesh (6) buttons in the Constraint (4-6) palette.
Start drawing the measuring polygon in the drawing area by snapping on each mesh
point in consecutive order around the surface edge (7). Just like the polygon tool, you

can terminate the drawing procedure in two ways, by double clicking on the last point,
or by clicking once again on the starting point, which is the case in this example.

Once the drawing procedure is finished, a dialog occurs showing the measured data.
The data shown are as follows. The total projected 2D-length (8) of the drawn line or
polygon. The projected 2D-length of the last segment (9). The 2D tilt angle (10) as
seen from the currently selected view. The projected 2D-area (11) of the polygon as

seen from the current view. The total 3D-length (12) of the polygon. The 3D-length of
the last segment (13).

Note that the area assumes a closing line between the first point used and the last
point if the measuring polygon is an open polygon.

Note that the true 3D-area of the surface can be calculated using the Surface
Properties commands in the Tool menu.

Note that the 2D- and 3D-lengths are not the same here because the 3D-snapping
made the measuring point three-dimensional, that is, it uses the coordinates in the
direction away / towards you as well.

The Measure tool works in the Front, Top, Side (Right) and the Unfold views.
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Loft tool

The Loft tool is used for merging line / curve / ruler objects into a single surface
object. It can also be used for removing rulers from a surface object into a separate

object, and insert-lofting an extra ruler into an already existing surface object. Below is
a picture showing the steps.

Building a surface
Start by drawing for example three control rulers (1) using the Polygon tool found in
the blue section of the tool palette. Curves (a series of ruler points) can also be used.
Select the Loft (2) tool in the Tool palette. Select the Build Surface (3) mode in the
Mode bar. Click (4) on one of the control points in each of the objects to be used for
the surface in consecutive order starting from one side. Click twice on the last curve
point (or beside any of the curves) to finish the sequence. A dialog (5) occurs where
you specify if you want to keep (7) the original lofting objects or not (6). The default
setting is to keep the original curves but in reality it is often best to delete them unless
you have an explicit use for them later on. Once this selection has been made the final
result is being displayed (8). This surface may look rough but that can easily be fixed
by increasing the surface resolution using the Object Info palette.
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Removing a ruler or curve
The removing and inserting procedures work in a fairly similar way. To remove for
example the center ruler from the surface we just created, just select one relevant
control point with the Selection Arrow (1). Select the Loft (2) tool and then the Delete
(3) (minus) button in the mode bar. Click on the selected point, drag and then click
again beside (4) the surface. A dialog (5) occurs where you specify if you want to

remove the selected control ruler or a curve being perpendicular to the control rulers.
Click on the relevant direction and the selection will be removed (6) from the surface.
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Inserting a ruler or curve
Inserting a curve (a series of ruler starting points) or control ruler is done in the same
way except that you use the Insert (2) (plus) button in the mode bar and that you draw

the connection line from the insertion object to the receiving object.
It is important to realize that the inserted curve / ruler is placed above the ruler you

click on in the receiving surface, counted from the green starting point.
In the above mentioned example you will get back to the shape you had before if

you drag the insertion ruler to the ruler with the green dot (3-4), because the inserted
ruler will then be located immediately above the ruler having the green dot (5-6).

If you on the other hand drag the insertion ruler to the upper ruler, it will be
inserted as the third curve in the list and this will result in a very different shape. The
last picture (7) shows the surface as a contour and here you clearly see that the
intermediate curve in the (3-4) example is located as the last ruler in the shape,
referenced from the green point dot.
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Path Extrude tool

The Path Extrude tool is used for extruding cross sections along a given ruler or
curve. The path can be an individual control ruler or curve (a series of ruler starting

points), but it can also be an element in a surface, along the edge as well as somewhere
in the middle. Below is a picture showing a path extrusion along the edge of a surface
where the edge ruler (3) is used as the extrusion path.

Extruding along a ruler
Start by drawing a cross section (2), for example by using the tools in the blue section
of the Tool palette. Be sure to draw in a view roughly perpendicular to the extrusion
path (3 & 5). The cross section (2) object can be a ruler or a curve (a series of ruler
points) but not a surface. Select the Path Extrude (1) tool in the Tool palette. Draw a
connection line between the connection point of the cross section and the extrusion
path (2->3). Note that it is important to choose the relevant cross section point (2) as it
controls where the extrusion is placed relative to the path. In the example above the
leftmost side was used and that places the entire extrusion to the right of the path
curve. If the rightmost point had been selected the extrusion would placed to the left of
the extrusion. The same applies in the up /down direction.
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A dialog occurs where you specify that you want to extrude the cross section along
the path ruler (4). The extrusion takes place when you click on the OK button in the
dialog box. The result (5) is here shown in a slightly rotated view.

The Extrusion type options control the behavior of the extrusion. The parallel
option (2) generates a simple offset with no corner adjustments. The other three
options (1) essentially behave as when drawing a double-line or when using the
Polygon Extrude tool. They automatically rotate and expand the joints so that the
cross section remains constant relative to the view used. The Front option behaves as if

you where drawing a double line in the Front view and so on. This is why there are
three view options.

Extruding perpendicular to a ruler
Above is a picture showing a path extrusion perpendicular to the control rulers and
placed at the same control point index (1) on each control ruler (in the middle in this
example). The procedure is the same as before. Drag the cross section to the path (2),
select the direction (3) and the extrusion takes place (4).
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Extrude tool
The Extrude tool can be used both for adding more control points within the

currently selected object, and for adding new objects based on the selected object or
objects.

Extruding a new surface
Above is an example showing how to extrude a new connecting surface from the edge
of a selected object (3). Start by selecting at least two points along the edge (1).
Selecting two ruler points in a ruler indicates that you want to base the extrusion on

the control ruler. Selecting two control points being in different rulers but having the
same point index indicates an extrusion being perpendicular to the control rulers.
Select the Extrude (2) tool in the tool palette. Click on one of the selected control rulers
and drag (3) and then click to finish the extrusion line. A dialog occurs. The Offset (4)
fields specify the offsets in the X, Y and Z directions. The Extrude Steps (5) indicates
the number of rulers to be added in the extrusion. New Surface (6) and Current
Surface (7) indicates whether the new items are to be added within the current object
or if a new object is to be added. Multiple Surfaces (8) allows simultaneous extrusion
of several objects. Solid Extrude (9) adds a thickness and edge surfaces to the currently
selected surface. Click OK (10) to add the new surface (11).

Note that the Extrude tool allow extrusions from any edge side (12), internally in
the middle of a surface along a ruler (14), and internally / perpendicular to the control
rulers (13).
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Solid Extrude
The Solid Extrude (9) option in the Extrude Dialog allows you to add a thickness to a
surface. Below is a picture showing the steps.

Select a surface (1) using the Selection Arrow tool in the Tool palette. The picture
shows it from the side, which is the normal operational view for such an operation,
and in a perspective view to clarify the shape. Select the Extrude (2) tool in the Tool
palette. Click on the surface, drag the extrusion line to the approximate extrusion
depth (3) and then click to finish the sequence. The Extrude dialog (4) occurs where

you adjust the extrusion distance (5), specify the number of extrusion steps (6), and
that you want a solid extrusion (7). Click OK and you have added a thickness to the
surface as seen to the bottom left.

The Solid Extrusion tool essentially adds four side walls and then copies the master
surface to form the opposite side of the object. The extrusion consists of six objects
and is therefore grouped by default. To edit the object, select the Ungroup command

in the Edit menu. You can also use the Ignore Groups command in the Edit menu to
temporarily disable the group behavior and allow editing without ungrouping the
group. Select Ignore Group menu command again to reset the Ignore Group mode.
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The default is to use one extrusion step on the sides to create a straight connection
between the upper and lower sides. If the sides are intended to have curved sides it is
better to add some intermediate steps such as shown below.

Below are a few examples where this technique has been used. The terrain model
originates from a single surface extruded downward in a single step. The bottom is

made flat by, choosing the Ignore Groups mode, selecting all control points along the
bottom, click on the Y field above the drawing window, and add “=” before the
coordinate. Press Enter. That’s all it takes to generate a flat underside for the
extrusion.
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The chair is created in a similar way. Exaggerate the extrusion, drag the vertical (2)
points back to the original location and then nudge them forward, in this case about 6
mm. Move the bottom parts (4) upward and the joint parts both (3) forward and up.

A third example shows a simple way to add rounded edges to a table surface. A
simple rectangular surface drawn in the Top view is the basis for the extrusion (1). The
surface is then extruded seen from the Front view, using the Solid Extrusion method

and adding three new extrusion steps (2). Note that the extrusion is much thicker than
the final thickness of the table surface. This makes it easier to select objects and can
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easily be fixed later in the process. The eight intermediate corner points are selected

using the Selection Arrow (Mesh mode) (3). Select the Reshape command in the Edit
menu. Add 30 mm in the X and Z directions and scale for the center point (4). Select
everything and use the reshape command to change the height to 30 mm (5). The final
result can be seen in the image as a rendered image (6). You may need to change the
Skin Type setting in the Object Info palette for two sides to get the smoothing right
when rendering.

This method works fairly well on non-rectangular shapes too, though it may need
some minor editing/nudging to get a more or less perfect result as seen above.
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Sweep tool

The Sweep tool is used for creating surfaces based on a cross section. The tool can
be used both for adding more control points within objects and for new objects based

on the selected cross sectional object or objects. Below is a picture showing the steps.

Start by drawing a cross section (1). It should be oriented perpendicular to the
sweep direction. Change view to where the cross section looks like a line (1), which is
the correct direction using the Sweep tool. Select it using the Selection Arrow tool in
the Tool palette. Select the Sweep (2) tool in the Tool palette. Click at the center of
rotation (3), draw the first sweep angle arm and then click (4) to place it. Rotate the
lever arm (5) to a second location and click (6) again. A sweep dialog occurs, in which

you just click OK for now. The swept object (8) is now generated.
Note that it can be quite useful to either place a temporary center-point in order to

have something to snap on when using the Sweep command. In some cases it can also
be useful to turn on the Alignment Indicator (7) found in the Constraint palette. These
methods can provide useful assistance.

When drawing a completely circular object (8) you simply click twice (4, 6) on one

and the same point. In such a case TouchCAD assumes that you want to draw a
circular shape and not a zero-sweep object.
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We have previously covered the basic use of the Sweep tool. The options in the
Sweep dialog are as follow:

Start angle (1). This field displays the angle between the first center-point click and
the second click. This is a fixed setting.

Sweep angle (2). This field displays the angle between the first and second lines.
Note that if you click twice on the second point it is assumed that you want to draw a
full 360-degree circle rather than a zero-degree arc. You can also insert an angel bigger
than 360 degrees, for example 720 or 1440 degrees. This only makes sense if you
include some sort of deformation along the path such as a pitch or a radius
transformation.

Pitch (3). The Pitch option allows you to generate a spiral shape such as a coil
spring. The value defines the total height offset of the sweep.

Sweep steps (4). TouchCAD automatically calculates how many control points you
need to control the specified sweep surface. The Sweep steps option can in most cases
be left untouched. In some cases it is however practical to use a different setting, for
example to be able to control a more complex shape.

Start Radius (5). Defines the start radius of the sweep (the distance from the center
point to the center of the cross section). This is not an editable field and it is only used
for reference.

End Radius (6). Defines the radius at the end of the sweep. A value being higher
than in the start radius gradually increases the radius along the sweep path. A lower
value decreases the sweep radius along the sweep path.
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New Surface (7). If the New Surface option is selected, TouchCAD creates a new
separate surface from the selected control points. If not, the sweep is added to the
currently selected surface. It may sound strange, but you can for example add a spiral
or and S-curve in the middle of a straight extrusion.

Multiple surfaces (8). Allows you to simultaneously create several sweeps from
control points placed in different objects.

Height and width (9-10). Defines the height and width of the cross section at the

start of the sweep. Not editable.
Height and Width (11-12) of the cross section at the end of the sweep. These

features allow you to gradually transform the cross section dimensions along the
sweep path.

Sweep examples
Below is a picture showing some examples of sweep shapes.

The first example shows a basic 360-degree sweep (1) founded on a circular cross
section. The second example shows a 720-degree sweep (2) that has a pitch. The third
example shows a 720-degree sweep (3) with a pitch and the sweep radius decreases
along the sweep path. The fourth example shows a simple 90-degree sweep (4). The

fifth example is also a 90-degree sweep (5) but where the cross section transforms from
a circular section into a fairly flat oval. The sixth example illustrates that nearly any
cross-section can be used, in this case an arc with a 720-degree sweep (6), a pitch and
wherein the sweep radius increases along the sweep path.

These examples illustrate the wealth of options in just the basic Sweep tool. You can
of course use any combination of these settings. Note that the sweep objects are still

the same math-curve based surfaces as in the rest of the program. They therefore allow
you to extract even more complex shapes based on these sweeps.
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Line tool

The Line (1) tool in the Blue section of the Tool palette is used for drawing basic
2D-lines. It can also generate surfaces if the depth setting is set to a value higher than
zero. Below is a picture showing the steps.

A line is drawn using the Line (1) tool in the Tool palette The Mode bar provides
two drawing options, Curves (2) (a series of ruler starting points) and Control Rulers
(3). The Depth (4) button displays a depth dialog where the depth is set. The depth
controls if you want the line to be extruded (4) or not (5). A depth of zero gives no
extrusion whereas a depth higher than zero adds an extrusion depth to the line. The
current depth setting (5) is displayed in the mode bar. The location of the line in the

direction away /towards you is controlled with the three coordinate edit fields (6)
above the drawing area. If you, for example, are in the Top view while drawing the
line, and with no 3D snapping activated, the line ends up at the current Y coordinate
field (6) setting. TouchCAD also displays various additional dimensional data (7)
while drawing a line.



___________________________________________________________________________
Page 84

You can also draw a line numerically by double clicking on the Line tool, or by

selecting the Line command in the Tool menu. A dialog is shown in both these cases,
where you can enter the size of the line.

The Cartesian (3) mode defines a line using a height (1) and width (2) whereas the
Polar (6) mode defines it by means of a diagonal length (4) and angle (5).

The Depth (7) is the same as described on the previous page and so are the line
types, Along (8) and Perpendicular (9) to the ruler.
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Rectangle tool
The Rectangle (1) tool found in the Blue section of the Tool palette is used for

drawing basic 2D-rectangles. It can also be used for generation cubes and cubical
shapes if the depth setting is set to a value higher than zero. Below is a picture showing

the steps.

A rectangle is drawn using the Rectangle (1) tool in the Tool palette. The Mode bar
provides three drawing options, Curves (2) (a series of ruler starting points), Control
Rulers (3) and surface (4) where a surface object consisting of two rulers each having

two control points. The Depth (5) button displays a depth dialog, in which the depth is
set. The Depth (5-6) controls if you want the rectangle to be extruded or not. A depth
of zero gives no extrusion whereas a depth higher than zero adds an extrusion depth
to the rectangle. The current depth setting (6) is displayed in the mode bar. The
location of the rectangle in the direction away /towards you is controlled with the
three coordinate edit fields (7) above the drawing area. If you, for example, are in the

Top view while drawing the rectangle, and with no 3D snapping activated, the
rectangle ends up at the current Y coordinate field (7) setting. TouchCAD also displays
various additional dimensional data (8) while drawing a rectangle.

Note that surface rectangles drawn with a depth creates a group consisting of six
surfaces. The curve and ruler based objects consists of a single surface and does not
have a bottom or top surface. To edit individual control points in the group, choose

the Ignore Groups mode command in the Edit menu or use the Ungroup command in
the Edit menu.
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You can also draw a rectangle numerically by double clicking on the Rectangle tool,
or by selecting the Rectangle command in the Tool menu. A dialog is shown in both
these cases, wherein you can enter the size of the rectangle.

The Cartesian (3) mode defines a rectangle using a height (2) and width (1) whereas

the Polar (4) mode defines it by means of a diagonal length (5) and angle (6).
The Depth (7) is the same as described on the previous page and so are the rectangle

types, Along (8), Perpendicular (9) to the ruler, and Surface (10).
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Circle / Ellipse tool
The Circle / Ellipse (1) tool in the Blue section of the Tool palette draws basic 2D

circles and ellipses. It can also generate cylinders and cylindrical shapes if the depth
setting is set to a value higher than zero. Below is a picture showing the steps.

A Circle / Ellipse is drawn using the Circle / Ellipse (1) tool in the Tool palette The
Mode bar provides three drawing options, Curves (2) (a series of ruler starting points),

Control Rulers (3) and Surface (4) where a surface object consists of two control rulers
(one in the middle).

Two drawing methods can be used, diagonally (5) and as a radius (6) from the
center-point. The diagonal (5) method allows you to draw ellipses, but you can also
draw circles by pressing the Shift key while dragging.

The Depth (7) button displays a depth dialog where the depth is set. The Depth (7)
controls if you want the circle / ellipse to be extruded or not. A depth of zero gives no
extrusion whereas a depth higher than zero adds an extrusion depth to the circle /
ellipse. The current depth setting (7) is displayed in the mode bar. The location of the
Circle / Ellipse in the direction away /towards you is controlled with the three
coordinate edit fields (8) above the drawing area. If you, for example, are in the Top
view while drawing the Circle / Ellipse, and with no 3D snapping activated, the circle

/ellipse ends up at the current Y coordinate field (8) setting. TouchCAD also displays
various additional dimensional data (9) while drawing a circle / ellipse.

Note that surface circles / ellipses drawn with a depth build a group consisting of
several surfaces. Curve and ruler based objects consists of a single surface and does
not have a bottom or top surface. To edit individual control points in the group,
choose the Ignore Groups mode command in the Edit menu or use the Ungroup
command in the Edit menu.
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You can also draw a Circle / Ellipse numerically by double clicking on the Circle /
Ellipse tool, or by selecting the Circle / Ellipse command in the Tool menu. A dialog is
shown in both cases, wherein you can enter the size of the Circle / Ellipse.

The width (1) and height (2) fields define the basic dimensions.
The Sweep Steps field (4) defines the number of sweep steps used along the sweep

path.
The Depth (3) is the same as described on the previous page and so are the Circle /

Ellipse types, Along (5), Perpendicular (6) to the ruler, and Surface (7).
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Polygon tool
The Polygon (1) tool in the Blue section of the Tool palette draws basic 2D

polygons. It can also generate surfaces if the depth is set to a value higher than zero.
Below is a picture showing the steps.

A polygon is drawn using the Polygon (1) tool in the Tool palette. The Mode bar
provides two drawing options, Curves (2) (a series of ruler starting points) and Control
Rulers (3). The drawing sequence can be terminated in two ways, by clicking on the

starting point, or by clicking twice on the last point. The Depth (4) button displays a
depth dialog where the depth (5) is set. The depth controls if you want the polygon to
be extruded (6) or not (2-3). A depth of zero gives no extrusion whereas a depth
higher than zero adds an extrusion depth to the polygon. The current depth setting (5)
is displayed in the mode bar. The location of the polygon in the direction away
/towards you is controlled with the three coordinate edit fields (7) above the drawing

area. If you, for example, are in the Top view while drawing the polygon, and with no
3D snapping activated, the polygon ends up at the current Y coordinate field (7)
setting. TouchCAD also displays various additional dimensional data (8) while
drawing a polygon.

The Polygon tool sets the object resolution to the same resolution as the number of
control points used. The resolution can however be changed using the settings under

the Properties tab in the Object Info palette. The same applies to the smoothing
properties, which by default are set to straight in both directions. It enables you to
convert a polygon from having straight lines between the control points into a smooth
looking curve, and wherein the degree of smoothing it is controlled numerically in a
very accurate and flexible way.
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You can also draw a polygon numerically by double clicking on the Polygon tool,
or by selecting the Polygon command in the Tool menu. A dialog is shown in both
cases, where you can enter the size of the polygon.

The Coordinate (1) fields are used for editing the currently selected control point
coordinates.

The Depth (2) is the same as described on the previous pages and so are the polygon
types, Along (3) and Perpendicular (4) to the ruler.

The Plus and Minus (5) are used for adding and deleting control points respectively.
The Up and Down (6) buttons control wherein the control point list new objects are
being added or deleted.

The Points used and Current point (7) lead texts specify where you are in the
control point list.
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Double-line tool

The Double-line (1) tool in the Blue section of the Tool palette draws basic 2D
double-lines. It can also generate wall-style objects if the depth setting is set to a value

higher than zero. Below is a picture showing the steps.

In a double-line drawn using the Double-line (1) tool in the Tool palette the Mode
bar provides two drawing options, Control Rulers (2) and Surface (3). The drawing
sequence can be terminated in two ways, by clicking on the start point, or by clicking
twice on the current point. The drawing sequence can be right (5), center (5) or left (6)
oriented. The Depth (7) button displays a depth dialog (7), wherein the depth (8) and
distance (9) between the lines are set. The depth controls whether you want the
double-line to be extruded (6) or not (2-3). A depth equals zero gives no extrusion
whereas a depth higher than zero adds an extrusion depth to the double-line. The
current depth setting (9) is displayed in the mode bar. The location of the double-line
in the direction away /towards you is controlled by the three coordinate edit fields
above the drawing area. If you, for example, are in the Top view while drawing the
double-line, and with no 3D snapping activated, the double-line ends up at the current
Y coordinate field setting. TouchCAD also displays various additional dimensional
data (10) while drawing a double-line.

The double-line tool sets the resolution to the same resolution as the number of
control points used. The resolution can however be changed using the settings under

the Properties tab in the Object Info palette. The same applies to the smoothing
properties.
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Note that double-lines being drawn with a depth and based on the Surface method

form a group consisting of many surfaces. Ruler-based objects consist of a single
surface, and does not have a bottom or top surface. To edit individual control points in
the group, choose the Ignore Groups mode command in the Edit menu or use the
Ungroup command in the Edit menu before editing.

You can also draw a double-line numerically by double clicking on the Double-line
tool, or by selecting the double-line command in the Tool menu. A dialog is shown in
either case, wherein you can enter the elements of the double-line.

The Coordinate (1) fields are used for editing the currently selected control point
coordinates.

The Separation (2) field specifies the distance between the two lines.
The Depth (3) is the depth of the double-line, that is, in the direction away /

towards you.
The Offset Direction (4) specifies the location of the double-line relative to the

control point polygon.
The Plus and Minus (5) are used for adding or deleting control points. The Up and

Down (6) buttons control wherein the control point list objects are being added or
deleted.

The Points used and Current point (7) lead texts specify where you are in the
control point list.
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Arc tool

The Arc (1) tool in the Blue section of the Tool palette is used for drawing basic 2D-
arcs and arc surfaces. It can also be used for generation arc based objects if the depth
setting is set to a value higher than zero. Below is a picture showing the steps.

 An Arc is drawn using the Arc (1)  tool in the Tool palette The Mode bar provides
three drawing options, Curves (2) (a series of ruler starting points), Control Rulers (3)
and Surface (4), wherein the surface object consisting of two rulers.

The Depth (5) button displays a depth dialog where the depth is set. The Depth (6)
controls if you want the Arc to be extruded or not. A depth of zero gives no extrusion
whereas a depth higher than zero adds an extrusion depth to the arc. The current
depth setting (6) is displayed in the Mode bar. The location of the arc in the direction
away /towards you is controlled with the three coordinate edit fields (16) above the
drawing area. If you are, for example, in the Top view while drawing the arc, and with
no 3D snapping activated, the arc ends up at the current Y coordinate field (16)
setting. TouchCAD also displays various additional dimensional data (17) while

drawing an arc.
To draw an arc, click on the center-point (7) to start the arc. Draw the radius line

(8) and click again. Draw the arc (10) and click (12) to finish the drawing procedure.
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The New Arc dialog occurs where you are able to define the arc in detail. You can

change the arc type (2-4), radius (8), start angle (9), sweep angle (10), depth (6), if you
want to use the long arc (13) being more than 180 degrees, the pitch (14) setting and if
you want to add more control points (15) than the suggested default setting.

Note that surface circles / ellipses being drawn with a depth build a group
consisting of several surfaces. Curve and ruler based objects consist of a single surface,
and do not have a bottom or top surface. To edit individual control points in the

group, choose the Ignore Groups mode command in the Edit menu or use the Ungroup
command in the Edit menu.

Double-clicking on the Arc tool
You can also draw an arc numerically by double clicking on the Arc tool, or by

selecting the Arc command in the Tool menu as described above.
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Surface tool

The Surface (1) tool in the yellow section of the Tool palette is used for drawing
basic 3D-surfaces and surfaces with a thickness. Such surfaces are usually used as a
base for more complex shapes and the dialog window therefore displays a wide range
of options to avoid work later in the design process.

The drawing process starts by selecting the Surface (1) tool in the tool palette. Click
(2) on the starting point and drag a diagonal (3) line to the opposite corner of the
rectangle and click (4) again to finish the drawing sequence.

The New Surface dialog occurs. The Width (7) and Height (8) specifies the basic
dimensions of the rectangle. The Depth (9) can be set to zero to build a single surface
with no thickness or a six-surface object group if the depth is bigger than zero. The

Position (10) field specifies where to place object in the direction away / towards you.
The Coordinate fields above the drawing area in the main drawing window define the
default position setting.
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The No of Rulers (5) and Controls (6) specify the number of control rulers and

points to be used in the surface. The Surf Res H (11) & V (12) fields specifies the mesh
resolution of the surface. Note that the Surface Type (16) popup may override these
settings in some cases.

The two weight (13 / 14) fields specify the weight property of the surface. Note that
only one of these fields can have a value bigger than zero. The field having a value
bigger than zero indicates if the weight per area unit or object weight method is to be

used when performing weight calculations.
The Marine Calculation (15) check box specifies if the surface is to be used for

marine calculations. The marine calculation methods are quite mathematically
intensive and it is therefore advisable to have this option checked only on surfaces that
are actually used for such a purpose.

The Ruler Direction (5) popup allows you to place the control rulers either

horizontally or vertically relative to the view used when drawing the surface.
The Surface Type (16) popup specifies the smoothing settings, and the options are

Straight along the Rulers / Straight perpendicular to the rulers, Smooth along the
Rulers / Straight perpendicular to the rulers, Straight along the Rulers / Smooth
perpendicular to the rulers, and Smooth along the Rulers / Smooth perpendicular to the
rulers.

The Color (17) and Layer (18) pop-ups place the new object in the right layer and
gives it a color.

The Display mode (19) pop-up specifies the display mode for the object. The
options are contours, mesh, cross sections, curves along or perpendicular to the rulers.

The Close (20) pop-up allows closing of the surface along the control ruler,
perpendicular to the ruler and in both directions. You will find a more detailed

description in the Object Info / Properties tab section of the manual.
The Unfold (21) pop-up defines if the surface is to be used for unfolding or not, and

how it should behave when being unfolded. The options are no unfolding, joined
horizontal strips, horizontal strips, joined vertical strips, and vertical strips. You will
find a detailed description in the Object Info / Unfold tab section of the manual.

The Overlap (22) pop-up specifies the direction of internal overlaps counted from

the green starting point of the main panel. The options are Up (away from the green
starting point), down (towards the green starting point), and overlaps on both sides.
You will find a detailed description in the Object Info / Unfold tab section of the
manual.

The Overlap (23) fields specify the overlaps individually for each of the four
external edge sides of the main panel and the internal overlap in between the sub-
panels. The external overlaps are normally inserted clockwise around the main panel
starting from the green staring point of the main panel. You will find a more detailed
description in the Object Info / Unfold tab section of the manual.
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The Join At (24) field specifies the joining point used when displaying joined

unfolded surfaces. The default setting is zero and indicates that the joint is located at
the green starting point. Higher values move the joining points to the respective mesh
index point (e.g. number five places the joining point at the fifth mesh point). You will
find a detailed description in the Object Info / Unfold tab section of the manual.
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Point tool

The Point tool draws points. Points can be used for several tasks, for example as a
reference point, as a starting point that can be extended into a ruler, curve or surface,

or in combination with other points, be joined into a curve using the Combine into
Curve command in the Tool menu. Points can also be imported using the Import ->
Points… command in the File menu.

Select the Point tool in the Tool palette, and then click in the drawing area to draw

a point. The location can be adjusted using the Coordinate fields above the drawing
area, and / or using the Arrow keys.

Below is a picture showing the New Point dialog occurring when you double-click
on the Point tool.

A point can be extended into a control ruler by clicking on it with the Selection
Arrow tool (Mesh mode) while pressing the Alt / Opt key. This adds a new control
point to the point, and therefore converts it into a control ruler. Adding a new ruler to
the point is done by pressing the Alt / Opt + Shift keys. This means that a point is
essentially an object with only one control ruler that has a single control point, and
that is why you can handle it like any other TouchCAD object.

Double-clicking on the Point tool
You can also draw a point numerically by double clicking on the Point tool, or by

selecting the Point command in the Tool menu as described above.
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Cube tool

The cube tool draws cubes. Below is a picture showing the steps.

Select the Cube (1) tool in the yellow section of the Tool palette. Draw the cube (2)
in the drawing area. The New Cube dialog occurs where you specify the width (3),
height (4) and depth (5) settings. Click OK and the cube occurs.

Note that cubes form a group consisting of many surfaces. To edit individual
control points in the group, choose the Ignore Groups mode command in the Edit
menu or use the Ungroup command in the Edit menu.

Double-clicking on the Cube tool
You can also draw an cube numerically by double clicking on the Cube tool, or by

selecting the Cube command in the Tool menu as described above.
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Sphere tool

The Sphere tool creates spherical objects.

Select the Sphere (1) tool in the Tool palette. Select the Diameter (2) or Radius (3)
method in the mode bar. Draw the shape in the drawing area. The new sphere (4)
occurs.

An alternative method is to double-click on the Sphere (1) tool in the Tool palette.
The New Sphere dialog is shown and here you can enter the diameter (4) and sweep
angle (5).
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Torus tool

The Torus (1) tool generates torus based objects such as elbow tubes, spirals, coil
springs, etc. Below is a picture showing the steps.

Select the Torus (1) tool in the yellow section of the tool palette. Click in the
drawing area, drag and then click again to draw the basic shape (2). The New Torus
dialog is displayed, wherein you have the following options.

The Sweep Angle (3) field controls sweep angle. The uppermost (2-3) examples are
360 degrees whereas the lowermost is 90 degrees. Angles higher than 360 degrees can
be used though it would mostly make sense in combination with a pitch (4).

The Pitch (4) field adds a pitch, that is, a spiral shape in the direction away /
towards you.

The Sweep Steps (5) field controls how many control points used in the object. The
default setting is normally adequate and the only reason for changing it is if you have
specific needs, such as if the object is to be used for generating complex
transformations or if you need an extreme degree of accuracy.
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The Start Radius (6) and Stop Radius (7) fields controls the sweep radius. The

default setting is the same setting for these two fields and generates a sweep having the
same radius across the sweep. If the start radius is smaller that the stop radius, the
sweep forms a smooth transformation outward and away from the center point and
visa versa.

The Start and End Width and Height  (8-9) fields allow internal transformations of
the basic cross sections along the sweep. You can for example have a 100 x 100-mm

circular cross section at the start, and that smoothly transforms into a 200 x 300-mm
elliptical cross section at the end of the sweep.

Note that the Torus shape is a normal TouchCAD surface and it therefore allows
you to change the shape both by moving the control points as well as the settings in the
Object Info palette. You can for example change the number of steps used along the
sweep path to make it easier to produce for example a sheet metal based elbow tube.
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 Tube / Cylinder / 3D Arc tool
The Tube / Cylinder / 3D Arc tool generates various cylindrical shapes. Simple

cylinders as well as tubes and sections of tubes with a wall thickness can be generated.
Below is a picture showing the steps and options.

The Tube / Cylinder / 3D Arc (1) tool found in the yellow section of the Tool palette is
used for drawing basic 3D-cylinders, tubes etc and surfaces with a thickness. Such
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surfaces are usually used as a base for more complex shapes and the dialog window

therefore displays a wide range of options to avoid work later in the design process.
The drawing process starts by selecting the Tube / Cylinder / 3D Arc (1) tool in the

tool palette. The Diagonal (2) and Radius (3) methods are optional methods in the
Mode bar. Click on the starting point and drag a line to the opposite corner of the
circle and click again to finish the drawing sequence.

The New Cylinder Tube Radius dialog occurs. The Width (4) and Height (5)
specifies the basic dimensions of the cylinder. The Depth (6) field defines the height of
the cylinder in the direction away / towards you. The Wall thickness (7) field can be set
to zero to build a single surface with no wall thickness, or a surface object group if the
thickness is bigger than zero. The Start Position (8) field specifies where to place object
in the direction away / towards you. The Coordinate fields above the drawing area in
the main drawing window defines the default position setting.

The Start angle (9) defines the angle of the circle /arc starting angle and the Sweep
angle (10) defines how many degrees the sweep arc is.

The No of Rulers (11) and Controls (12) specify the number of control rulers and
points to be used in the object. It is normally best to leave these fields with their
respective default settings, unless you want to use the shape as a base for a curved
surface or if you wish to use curved edge surfaces.

The Surf Res H (13) & V (14) fields specify the mesh resolution of the surface. Note
that Surface Type (17) popup may override these settings in some cases.

The two weight (15) fields specify the weight property of the surface. Note that only
one of these fields can have a value bigger than zero. The field having a value bigger
than zero indicates if the weight per area unit or object weight method is to be used for
this particular method when performing weight calculations.

The Marine Calculation (16) check box specifies if the surface is to be used for
marine calculations. The marine calculation methods are quite math intense and it is
therefore advisable to have this option only checked on surfaces that are actually used
for such a purpose.

The Surface Type (17) popup specifies the smoothing settings, and the options are
Straight along the Rulers / Straight perpendicular to the rulers, Smooth along the

Rulers / Straight perpendicular to the rulers, Straight along the Rulers / Smooth
perpendicular to the rulers, and Smooth along the Rulers / Smooth perpendicular to the
rulers.

The Color (18) and Layer (19) pop-ups place the new object in the right layer and
gives it a color.

The Display mode (20) pop-up specifies the display mode for the object. The

options are contours, mesh, cross sections, curves along or perpendicular to the rulers.
For a more detailed description see the Object Info palette / Properties tab section of
the manual.

The Close (21) pop-up allows closing of the surface along the control ruler,
perpendicular to the ruler and in both directions. For a more detailed description see
the Object Info palette / Properties tab section of the manual.
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The Unfold (22) pop-up defines if used for unfolding or not, and how it should

behave when being unfolded. The options are no unfolding, joined horizontal strips,
horizontal strips, joined vertical strips, and vertical strips. You will find a more detailed
description in the Object Info palette / Unfold tab section of the manual.

The Overlap (23) pop-up specifies the direction of internal overlaps counted from
the green starting point of the main panel. The options are Up (away from the green
starting point), down (towards the green starting point), and overlaps on both sides.

You will find a more detailed description in the Object Info palette / Unfold tab
section of the manual.

The Overlap (24) fields specify the overlaps individually for each of the four
external main panel sides and the internal overlap in between the sub-panels. The
external overlaps are normally oriented clockwise around the main panel starting from
the green starting point of the main panel. You will find a more detailed description in

the Object Info palette / Unfold tab section of the manual.
The Join At (25) field specifies the joining point used when displaying joined

unfolded surfaces. The default setting is zero and indicates that the joint is located at
the green starting point. Higher values move the joining points to the respective mesh
index point (e.g. number five, places the joining point at the fifth mesh point). For a
more detailed description se the Object Info palette / Unfold tab section of the manual.

Double-clicking on the Tube / Cylinder / 3D Arc tool
You can also draw an cylinder numerically by double clicking on the Tube /

Cylinder / 3D Arc tool, or by selecting the Cylinder command in the Tool menu as
described above.

Above is an example showing an object founded on a basic 180-degree tube object
used as a starting object for a more complex shape. The height in the back was
increased (1) to generate a convex shape. This was achieved by adding an extra control
point in the middle of the surface (2). The shape also has a curved front edge (3).
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Rectangle to Circle tool

The Rectangle to Circle Connection tool is used for generating smooth
transformations between a rectangular and a circular or elliptical cross section. It also

allows you to add a small radius in the rectangular part, for example to simulate the
bending radius generated when bending sheet metal objects. The basic shape can also
be transformed to handle eccentric transformations or where the cross sections are not
parallel to one another. Below is a picture showing the steps.

Select the Rectangle to Circle (1) in the yellow section of the Tool palette. Click and
drag a diagonal line and then click again to draw the basic object (2) in the drawing

area. The Rectangle to Circle Connection dialog (3) window occurs.
The Rectangular Width (4), Height (5) and Corner Radius (6) fields specify the

properties on the rectangular side of the object.
The Circular Width (7) and Height (8) fields controls the circular side.
The Extrusion Depth (9) field specifies the length of the extrusion.
Note that it is often practical to add a small radius (6) in the rectangular end of

such a shape, especially if the object is to be used for producing sheet metal objects.
Sheet metal can normally not be folded into an absolutely sharp edge in a corner, so in
most cases it would look more like the rendered picture (10) when produced as a real
physical model.
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T-tube tool
The T-tube tool draws T-shaped tube connections. Below is a picture showing the

steps.

Select the T-tube (1) tool in the yellow section of the Tool palette. Click on the
drawing area. The T-tube Connection (2) dialog occurs.

The Diameter (3) field specifies the diameter of both the main parts and the branch.
The Length Main (4) field specifies the total length of the main tube. The Length
Branch (5) field defines the length of the branch component. The Angle (6) field
defines the angle between the main tube and the branch. The maximum angle is 90
degrees and the minimum is defined by what fits in along the main tube without
extending upwards beyond the upper edge of the main tube. If such an event occurs,
TouchCAD displays a warning message and then calculates the lowest possible angle
given by the current settings. You can however decrease the angle further by adding
more length to the main tube. The Section Steps (7) enable you to choose between a
number of resolution settings. A higher resolution generates smoother looking

unfolded curves but also requires more power to calculate it.  The Unfold (8) checkbox
specifies that the shape is to be used for unfolding purposes and enables you to see the
unfolded patterns directly after having selected the Unfold view (8 A-C).

Note that T-tubes form a group consisting of several surfaces. To edit individual
control points in the group, choose the Ignore Groups command in the Edit menu or
use the Ungroup command in the Edit menu.

T-tubes can also be used as a foundation for generating other similar objects such as
T-tubes with variable cross section transformations, etc.
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File menu

The file menu contains standard features found in many other programs, for
example Open, Save, Print and Quit.

New
The New… command opens a new empty document. If an unsaved document is active,
TouchCAD displays a warning dialog, wherein you have the option to either save the
current document or go directly to a new and empty document without saving first.
The quick key for the New command is [Command + N (M) / Control + N (W)].

Open
The Open… command opens generic TouchCAD documents. If an unsaved document
is active, TouchCAD displays a warning dialog, wherein you have the option to either
save the current document or go directly to a new and empty document without saving
first. The quick key for the Open command is [Command + O (M) / Control + O (W)].

Load Into…
The Load Into… command opens generic TouchCAD documents and inserts the
content thereof into the currently active document. The purpose of this command is
primarily to insert previously drawn object elements. It enables you to create a library
of predefined objects such as people, trees, cars, furniture, engines, etc, and use them as

reference objects in you projects. An example is shown below.

Importing an outboard motor and a person immediately creates a sense of
proportion to the rendered image.

Consider adding a new layer for such objects before importing them. In this way
you can easily turn them off and on while editing the model.



___________________________________________________________________________
Page 109

Save
The Save command saves the active document. If the document has not been saved
before, the Save As dialog occurs, wherein you are prompted to enter a document
name. The quick key for the Save command is [Command + S (M) / Control + S (W)].

Save As…
The Save As… command saves the active document under a new name. The Save As
dialog occurs, wherein you are prompted to enter a document name.

Revert to saved
The Revert to Saved command takes you back to the last saved version of the model.

Export as -> DXF…
The Export as -> DXF… command exports the active model as a DXF file. A DXF file
is a standard file format defined by AutoDesk, producers of AutoCAD, and is used for
exchanging files between various CAD and 3D-modeling programs on both the
Windows and Mac platforms.

The DXF export dialog contains the following items.
The Export DXF layers (1) popup allows you export TouchCAD layers, colors or

objects as DXF layers. When using the TouchCAD layers you keep the layer structure

from TouchCAD. Exporting TouchCAD colors as DXF layers is primarily useful when
exporting 3D models to rendering programs where layers are used for defining the
color identity of the objects. TouchCAD supports 256 DXF colors when exporting and
uses the DXF color being closest to the color definition in TouchCAD. Exporting
objects in separate layers can be useful when exporting to some rendering programs
and when sending files to some plotter driver programs that do not support groups.

The Export Line Color (2) popup allows you to use either the line or fill colors for
export to DXF. The reason for this option is that DXF does not separate the line and
fill colors, so you simply need to choose either of these two options.
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The Surfaces As (3) popup allows you to choose between exporting surfaces as the

DXF data types 3D Faces or Polygon Mesh. Choose the one that works best in the
receiving program. TouchCAD can read both these data types but Polygon Meshes
usually fits better into the internal data handling as it builds larger units rather than
individual surface elements.

The Scale factor (4) allows you to scale the model when exporting. It is primarily
useful when exporting for example a model drawn in mm to a document based on

inches. It can also be useful when exporting to drawing programs, which do not
support full scale drawing, a drawback with many illustration programs.

The Triangulate (5) option is primarily used when the model is to be used for
rendering purposes. Most rendering programs base their models on triangles and it can
therefore be practical to convert to triangles in such cases.

The Group Surfaces as Blocks (6) option generates a DXF datatype called

Anonymous Blocks (the equivalent of groups in most other programs) and makes it
easier to handle the objects in such other programs. Note though that not all programs
support this feature, so don’t use it if it causes problems.

The Export 3D models as a 2D projection (7) option exports the 3D views as seen
on the screen and not as a 3D model. This option is primarily used when exporting to
strictly two-dimensional programs.

Export as -> EPSF
The Export as EPSF command is used for exporting 2D drawings to Adobe Illustrator,
and other programs compatible with this file format, such as MacroMedia Freehand,
Canvas, CorelDraw and PhotoShop. The exported files are fully editable in the
receiving program if you use the Open method. Both 3D views and unfolded patterns
can be exported. 3D-models are exported as a 2D-projection as seen on the screen and
the reason for this is of course that the receiving programs are all essentially 2D-
illustration programs.

It is important to know that TouchCAD always works using full-scale coordinates
and uses the Drawing Scale to reduce the size of the model to fit into a given sheet
space. This is not the case with most illustration programs, and such programs often

have a limited drawing area. TouchCAD therefore exports to the EPSF format using
the scale factor stated in the Drawing Scale dialog.

Export as -> 3DMF
3DMF (QuickDraw3D) is a file format defined by Apple Computer and is used for
displaying rendered 3D models. It allows fast real-time rotation of models. The

QuickDraw3D format is available for MacOS Classic and Windows but is not
supported in the new Mac OSX unless you install the Quesa plug-in in your system.
TouchCAD uses QuickDraw3D models in the internal rendering engine.
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Export as -> VectorWorks
The VectorWorks export command exports files to Nemetschek’s VectorWorks and
MiniCAD (older name for VectorWorks) in the VectorScript file format (called
MiniCad Text in MiniCad 7 and older versions). Drawings can be exported as 3D
models, as projected 2D version of the 3D models, or as unfolded patterns. Below is a
picture showing the Export dialog options.

The Export as Class colors (1) checkbox generates a specific Class name and color
for each TouchCAD color used in the model. If the checkbox is off, TouchCAD simply
exports the colors with no name.

The Triangulate (2) checkbox allows you to sub-divide all surface objects into
triangles. Such a conversion is especially useful if you intend to use the generic

VectorWorks rendering engine plug-in called RenderWorks, which does not handle
twisted quads (four-sided polygons) well.

The Include layer definitions (3) checkbox allows you to export the layers or colors
used in TouchCAD as VectorWorks layers or colors. Deselect this option if you just
want to import the entire TouchCAD model into the currently active VectorWorks
layer or class.

The Export 3D model as a 2D-projection (4) checkbox allows you to export a 2D-
representation of a 3D-model.

The Polygon / NURBS (5) options defines the data types used when exporting. The
Polygon option simply exports all objects as polygons, whereas the NURBS option
exports curves and surfaces as NURBS objects. The later is better if the purpose is to
continue to work with smooth looking objects, when there is a need to perform solid

modeling calculations in VectorWorks or when there is a need to re-export objects
using the VectorWorks IGES export features. When the NURBS option is activated, the
Export as Solids (6) checkbox becomes selectable, which enables you to export
surfaces as solid or just plain NURBS surfaces. The NURBS option only works on
VectorWorks 10 or later.
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Export as -> VRML
The Export VRML command exports 3D models as VRML files.  This format is

primarily used for displaying 3D models in real-time. Many rendering programs
support this format.

Export as -> StrataVision
The Export as StrataVision command exports files in a simplified MiniCAD text
format, which can be read by many versions of the Strata line of rendering programs.
Strata also reads DXF, VRML and 3DMF as an intermediate format for exporting.

 Export as -> Artlantis 3-4 / 4.5
The Export as Artlantis commands are used for exporting 3D models to various
versions of the rendering program Artlantis. The 3-4 option exports as .opt / .db files

whereas the 4.5 have a new generic format called .atl. TouchCAD exports the colors
used as Artlantis color objects and includes both fill color and transparency settings.
The imported model scene is predefined having the shadows, reflectivity and
transparency options activated, and with a default light object and camera setting.
This means that the model is fairly well prepared from the start and only needs some
basic adjustments to be ready to build a basic photo realistic rendering. Artlantis is

available for Mac and Windows. More info and demos can be found at
www.artlantis.com. Below is a picture showing the difference in rendering quality
between the generic TouchCAD rendering engine and an Artlantis rendering.
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Export as Plotmaker
The Export as Plotmaker command exports both projected 3D views and unfolded
patterns to the sail-cutting program PlotMaker developed by Sail Science in New
Zealand. Sail makers using the SailMaker program can use their hardware for
producing other fabric-based objects such as canvas elements, sail-roofs, blimps, etc.

When exporting from a 3D view, TouchCAD exports the view as a 2D projection.
The export dialog enables exporting as cut or as plot lines. The primary use is to

generate graphics and convert it into objects that can be processed in the plotter/cutter.
When being in the Unfold view, TouchCAD supports PlotMaker export of all

unfolding options in the Object Info palette and most options in the View -> Show in
Unfold menu. The exceptions are that it does not export coordinates and line /fill
colors, because it does not make sense to export these features to a strict cutting
program.

An export dialog occurs after having selected the Export->Plotmaker command in
the File menu. The Smooth option assumes that you let Plotmaker do the required
smoothing between the vertex points. The Straight option exports the model exactly as
seen in TouchCAD. It can be hard to say which of these options that works best in a
given situation, but a good strategy may be to use the Screen Plot command to

simulate the cut. If that looks right there is a good chance that the actual cut will work
as well.
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TouchCAD exports the unfolded model in the PlotMaker ASCII format, which can

be imported by simply double-clicking on the file generated, or by selecting the Import-
>PlotMaker ASCII command in the File menu of PlotMaker.

Export as Unfolded images.
Background images can be mapped on the 3D model and be saved as a single or a set
of images. To be able to do it you have to prepare a model and image as follows.

Start by importing a background image and place it behind a 3D model, which must
consist of surfaces. Make sure that the surfaces to be used have an unfolding property
(other than “No Unfold” in the Object Info palette -> Unfold Tab -> Unfold pop-up).
Select the object or objects to be used for the image unfolding calculation. Select the
view where you can see the background image and then select Unfold Images from the
File menu. The following dialog occurs.

The File Type (1) pop-up states the file type to be used.
The Quality (2) pop-up states the degree of compression used.
The Image Resolution (3) edit field states a target resolution for the unfolded image

or images. The value stated in the example suggests 89 DPI, which roughly reflects the
resolution of the image relative to the scale stated in #5 to #8. In the example using the
drawing scale. Click on the Full Scale button (5) and the DPI rate changes provides
that drawing scale in not 1:1. The lead text below (4) suggests a scale, which can be
used or not. It is fully possible to scale an image upwards though you it must be said
that you may loose some in quality as TouchCAD only calculates an image based on

the original. Worth noting is that very physically large images are typically printed at
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much lower resolutions than used in form example brochures, magazines and books,

sometimes as low as 8 to 12 DPI. This works because you need to back off quite a lot
to actually make sense of say a 30-meter wide image. In other words, use the DPI
settings with caution. If you double the rate you typically quadruple the file sizes
generated and rendering times. It may not matter much if the file is 200K and you go
to 800K but if you start at 75 Megabytes you end up with 300 Megs if you double the
setting. At some point there is a risk that you simply run out of both RAM and hard

disk space. In other words, use it with caution.
The Output Scale buttons controls the output scale using the Full Scale (5),

Drawing Scale (6) or Custom Scale (7) options. If the later is selected an edit field (8)
is displayed where you enter a custom scale.

The Single File (9) checkbox controls if the unfolded image(s) is to be exported as a
single file or as separate images for each of the chosen panels. Note that it may be a

good idea to create a special folder for projects where you unfold many panels as 50 or
100 new files in an existing folder may cause a bit of a mess. When images are
exported as individual files you start with a basic file name, for example called
“MyImage”. Each new image is then named MyImage + the panel and sub panel index
number, for example “MyImage_1_12.jpg”. This makes it easier to identify a sub panel
without actually having to open it.

The Render Panel buttons control which panels to be sued for a particular rendering
session. All Selected (10) render all panels selected in the drawing window. Intersection
Point Object (11) renders the surface that carries the Intersection Point symbol and all
it’s sub parts. The Individual Panel Option (12) just renders a single sub panel based
on its object and sub panel ID as stated in the edit fields (3) below the button (not
visible in the diagram).

Once the paper work is done it is just a matter of clicking OK and wait for the
result.

The final step in the process is to open the file(s) and change the resolution to the
target resolution as stated in the export dialog. The files are all exported at 72 DPI by
default but if you change it to the target resolution you get images that match the
stated scale. In PhotoShop you use a command called Image Size found in the Image
menu.

Worth mentioning is that the image unfolding also adds all the drawing elements
seen in the Unfold view, such as cut and plot lines, panel numbers, alignment marks,
pen and line color settings etc. In other words all settings as defined in the Object Info
palette as well as the general unfolding settings as defined in the Show in Unfold
commands found in the View menu.

Images that only partially cover the unfolded model are only rendered where they
are located whereas uncovered areas use the color settings as seen in the Unfold view. If
a given area has a white fill setting it simply generates an image with a white fill in the
image.

To save space and keep the image sizes to a minimum it is recommended to edit the
unfolded parts a bit in the Unfold view to minimize the area used. TouchCAD simply

generates images that found boundary boxes around the unfolded shapes.



___________________________________________________________________________
Page 116

Export as HPGL
The Export as HPGL command is used for exporting HPGL file. The file format was
originally used for controlling pen plotters but is nowadays mostly used for computer
controlled cutting tables and vinyl cutters.

Export as STL
The Export as STL command exports 3D-models as STL files. The file format is

primarily used for quick prototyping and 3D-milling.

Export as Image File.
The Export as Image File command exports pixel based screen dumps as image files.
The export dialog enables you to export as JPEG, TIFF, TARGA, PICT, BMP, and
PhotoShop, using the File Type (1) pop-up. By default it generates a screen dump,

which is what the Width and Height (2) edit fields states measured in pixels. Changing
the numerical values can scale these settings upwards and downwards proportionally.

Export as Points
All objects in the drawing can be exported as text based TAB formatted file.

Importing files.
Files can be imported into TouchCAD in DXF, VectorWorks (VectorScript), Points,
STL, SailMaker ASC 3D, Wavefront, QuickDraw3D, VRML formats. TouchCAD can
also import in-scale background images used as a modeling aid and for generating
unfolded images.

Import as ->
The Import As sub-menu contains import filters for various file formats such as DXF,
VectorWorks (VectorScript / MiniCAD text), Points, STL, Sails Science ASC 3D,
Wavefront, VRML, QuickDraw3D (text) and as in scale Background Images..
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Import as -> DXF
The Import as -> DXF… command imports DXF files. A DXF file is a standard file
format defined by AutoDesk, producers of AutoCAD, and is used for exchanging files
between various CAD and 3D-modeling programs on both the Windows and Mac
platforms.

TouchCAD supports importing of the following DXF data types: Lines, circles, arcs,
polylines, LW polylines, Polygon Meshes, Polyface Meshes, 3D faces, points, layers,

256 colors and anonymous blocks (but not blocks).

The DXF import dialog allows you to change flip the Y and Z directions (1), which
is used when importing from programs having a flipped coordinate system.

A scale factor (2) can be applied to the import model, which is used when the file is

exported in another drawing unit than used in the current drawing. A model drawn in
meters would for example need a scale factor of 1000 if the drawing units is set to
millimeters. The scale factor has to be set manually because the DXF format does not
specify the drawing units.

Import as -> VectorWorks
The VectorWorks import command imports files from Nemetschek’s VectorWorks and
MiniCAD (the older name for VectorWorks) in the VectorScript file format (called
MiniCad Text in MiniCad 7 and older versions).

TouchCAD supports the importing of the following VectorWorks data types: Lines,
circles, ovals, arcs, rectangles, 2D polygons, 3D polygons, 2D & 3D locus points,
layers and fill / line colors.

Import as -> Points
The Points import format is a simple text-based TAB based X, Y, Z, coordinate list.

The syntax is a s follows:
123.123 (TAB) 456.456 (TAB) 789.789 (Carriage Return)
789.789 (TAB) 456.456 (TAB) 123.123 (Carriage Return)
Etc.
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Such a file can be generated using an ordinary word processor, spreadsheet or

database program and the typical use is to import and make use of measurement points
to create a model.

The manual section concerning the Combine Into Curve command contains an
example on how to process and refine points into usable surfaces.

Import as -> Sailmaker ASC 3D
The import Sailmaker ASC 3D format is used for importing 3D sails from Sails Science
Sailmaker. The main use if to allow further processing of sails within TouchCAD, for
example to apply images and unfold then to produce sails with printed images such as
shown above. Sails imported maintain their original panel layout and they are pre-set
to be unfolded at their original location used in Sails Science Plotmaker.

Import as -> STL / Wavefront / QuickDraw3D / VRML
It is possible to import STL / Wavefront / QuickDraw3D / VRML files to be used as
reference objects. In most cases though, such models tend to contain lots of triangles
and are therefore not particularly well suited for use in TouchCAD. The reason for this
is that TouchCAD models are based on mathematically defined surfaces that forms

large blocks of surface elements, which is a very different approach. It can however be
useful to use such models when designing for example inflatable objects as there are
quite a lot of predefines models available on the Internet. In such cases you usually
need to re-skin and simplify the model to reach a truly usable compromise between
shape and making it reasonably easy to build.

Import -> Background Image
The import background image feature enable importing of high resolution background
images that can be used both as a modeling aid as well as for generated unfolded
images. Background images are imported in exact scale relative to the 3D model and
follow the 3D model when panning and zooming. It is also possible to import separate
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background images for the Front, Top and Side views to generate corresponding 2D

view images that can be compiled into a real 3D shape. Background images are by
nature connected to given standard view and is only shown when the relevant vise is
selected.

When background images are to be used for modeling and image unfolding, it is
usually a good idea to check the dimensions of the 3D model to be used and to make a
note of it for use later on in the process. The diagram blow shows the import dialog

displayed after selecting the Import Background image command.

The first step is to select the image to be imported by simply clicking on the Get
Image button (1). A standard Open dialog is shown where you select a suitable image.

Mots commonly used file formats such as PICT, JPEG, BMP, TIFF, TARGA, PDF and
so on can be used.

Some elements in the drawing area are: The original Image Box(2) that encloses the
original image. The Clip Line Guides (3) that forms the Clip Area (4), which is what is
actually exported to the main drawing window. The Clip Area can be resized by
clicking on the respective lines and dragging. If the Image Box and Clip Area lines

overlap, the Image Box is selected, but you can always get access to the Clip Area
controls by using the extended Clip Guide (3) lines. The Image Box can be deformed
by means of the red Image Box Deformation handles (5-6). When the Image Box is
deformed the image follows the box to generate a deformed image, which can be used
for removing the perspective from an image to make it easier to use a modeling guide.
The four corner handles (5) are used for free-form deformation. Note that you can

generate a horizontally or vertically constrained deformation drag by pressing the Shift
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key while using these handles. The four intermediate deformation handles (6) are used

for skewing the image by moving one side as a unit. The red lines in between the red
control points is used as a rotation handle (7) for the entire image. When pressing the
Alt/Opt key, the rotation only occurs on the one side you clicked on. The rotation then
centers around the red dot in the middle of the selected line, resulting in some sort of
image deformation. The Bulls Eye (8) is used for placing a zero point relative to the 3D
model and you simply drag it to a suitable location. Note that you can fine-tune the

location afterwards so if is OK to be a bit crude when placing it. The Measuring
Line(9) is used for control measuring elements of the image. You may for example
know the distance between two points in the image but not the total width or height of
the clip box. You then move the line endpoints to the corresponding location and then
enter the true length of the line in the corresponding edit fields below (9) to get a
correct scale. Note that the Clip Box width and height edit fields (11), the line width
and height (9) and the coordinates are updated accordingly to enable real scale
measuring. The same of course happens if you change the clip box height or width
values (11), where the corresponding values are updated. If the horizontal and vertical
dimensions do not correspond, it is possible to adjust the proportions by means of the
StretchH and StretchV (15) edit fields. They have a default setting of 100 (%) and if
you change for example the horizontal filed to 101 (%), the image is stretched by one

percent horizontally whereas the vertical proportions remain unchanged. Note that the
field resets itself to 100 (%) afterwards to prepare for a new operation. It is also
possible to rotate the entire image (15) by a numerical value, for example to adjust a
slightly rotated scanned image. Positive angle values rotate the image counter-clockwise
and the units used are in degrees. Before exporting the image to the main drawing
window you need to specify the main view to be used using one of the three View
buttons (16).

When the image is correct and ready for use you simply press the Done (17) button
to return to the main drawing window together with the new image.

Some practical suggestions and methods when working with background images. If
you find that you need to move the background image a bit or scale it slightly, you can
do so by selecting the Edit Background Image command found in the View menu. This

displays a floating window where you can nudge the image, move it by entering a
numerical value in the edit fields or scale it. Another thing worth noting is that a
modified version of the image is stored at the location of the original image, using the
same file plus an additional letter stating which view it belongs to (e.g. MyImage ->
MyImageF to indicate that it belongs to the Front view. The reason for this is that
background images are not stored within the actual TouchCAD file, it only stores the

address to it. If you move the file to a new location, TouchCAD finds that it can’t find
it and therefore asks for help when the file is opened again. If so, just locate it again on
your hard disk and it stores the new location or cancel the background image if you
don’t need it.
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Page Setup
The Page Setup command is used for extracting a page size and orientation from the
printer driver and for setting how many sheets to be used for defining the light blue
drawing / sheet space area found in the drawing area of the main drawing window.
Below is a picture showing how the first dialog looks like when selecting the Pager
Setup command.

TouchCAD allows you to create a sheet space over any number of sheets. You can
for example join two A4 sheets (the same applies for letter size sheets) into one A3
drawing by placing two sheets beside one another. The light blue rectangle seen on the
screen represents the true available drawing area of the printer you use. It is therefore
easy to join two sheets by simply cutting off one of the sheets along the edge of the
area actually being used by the printer, and then place it on top of the other sheet. This

will generate a perfect match, or at least as good as the printer can manage. The
number of steps (sheets) horizontally and vertically (1-2) simply defines the number of
sheets to be used.

The Print connection markers checkbox adds small diagonal lines in the corners of
all sheets and helps in reassembling the sheets.

The Page numbers check box (4) prints a page number in the corner of each sheet

and helps to keep track of where you are on the assembled sheet.
The Show Page Breaks adds a line around each sheet.
A standard Page / Print setup dialog occurs after having clicked OK on the first

dialog. Here you specify the printer specific properties.

Print…
The Print command prints out the drawing on sheet in a standard way. The quick key
is Command P (M) / Control P (W).
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Quit…
The Quit command closes down TouchCAD. If the currently active document is
unsaved, a dialog occurs wherein you specify if you want to save your work or not.
The quick key is Command Q (M) / Control Q (W). Note that The Quit command is
located in the TouchCAD menu on the Mac OSX version.

Recently Used files
The last items in the File menu are used for storing the fine name and location of
recently used files. These can easily be opened by using these commands and without
having to look for them.



___________________________________________________________________________
Page 123

Edit menu

The Edit menu contains various editing tools.

Undo and Redo
The Undo and Redo commands are standard features in most programs. TouchCAD
provides five Undo/Redo steps and operates in a loop. The quick key for Undo is
Command Z (M) / Control Z (W). The quick key for Redo is Command Y (M) /
Control Y (W).

Copy and Paste
The Copy and Paste commands are primarily used for copying the drawing area and
pasting the copy into the clipboard or to other programs. The quick key for the Copy
is Command C (M) / Control C (W). The quick key for Paste is Command V (M) /
Control V (W).

Clear
The Clear command deletes unwanted objects from the drawing. Other possible
methods to delete objects are to use the Delete or Backspace keys on the keyboard.

Group and Ungroup
The Group command is used for joining one or several object(s) into one unit.

TouchCAD only supports single level groups so grouping of for example two
groups results in a group, which when ungrouped, consists of a number of individual
objects.

Clicking on a grouped object result in a selection of all control points within the
group and such an object is therefore treated as a unit.

Many tools in the Tool palette and Tool menu generates grouped objects by default,

and you may need to either ungroup them or use the Ignore Group mode command to
be able to edit the object.

The quick key for Group is Command G (M) / Control G (W). The quick key for
Ungroup is Command U (M) / Control U (W).
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Ignore Groups
The Ignore Groups command disables the group identities and enables individual
editing without having to ungroup the objects first. A check before the Ignore Group
command text means that groups are disabled and visa versa.

The picture above shows an example. The yellow walls form a group when drawn
as a surface using the Double-line tool. Imagine that you want to project the upper
control points to a roof surface. If you click on one of the wall control points, all
points will be selected. You could of course ungroup it but in some cases it is easier to
use the Ignore Groups mode. In this case it is used to temporarily disable the wall
group, select the upper control points (1) and then project them to the roof surface
using the Align to Surface tool (2) and then enable groups again.
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Move…
The Move… command moves selected objects by means of a dialog box. Enter the
relevant offsets in the dialog and click OK.

Other methods for moving objects include entering new coordinates in the edit
fields above the drawing area, which moves the Intersection Point to a new location
and moves all selected objects the same distance. The Intersection Point coordinates
can also be moved relative to the previous location by placing an “M” before the
coordinates. Typing M200, for example, means that the current coordinate in
increased by 200 units and M-100 means that the coordinate in decreased by 100

units.

Reshape…
The Reshape… command is used for changing the dimensions of the selected object or
objects by means of a dialog box.  Below is a picture showing the dialog box (1).

The three X, Y and Z (2) fields are used for entering new dimensions, or, if the By
Scale Factor checkbox is checked, by entering a scale factor.

The object can be scaled individually in all three directions from the minimum,
center, or maximum (3) side or from the Intersection Point (4).



___________________________________________________________________________
Page 126

The Proportional (5) checkbox enables you to scale the selection proportionally. If

the X dimension was 1000 units and you type in 500, the Y and Z dimensions are
automatically halved. This can be quite practical if you want to produce a series of
more or less identical objects that only vary in physical size.

The By Scale Factor (6) checkbox enables you to scale the selection by means of a
scale factor instead of using actual dimensions. The default is one and if you multiply a
coordinate by one you will get the same value, that is no scaling. Entering for example

0.5 will halve the size and 2 double it and so on.
     The Reset (7) button is used for resetting the dimensions to what you had when

the dialog first opened. Quite practical when you lost track of what you where doing.

The Quick Key for the Reshape command is Command R (M) / Control R (W).

Other methods for resizing objects include ordinary dragging on the screen, using
the Resize box on the screen and using the Resize features found in the Dimension Tab
of the Object Info palette.

Rotate ->
The Rotate-> sub-menu items allows you to rotate points and objects in various ways.

Rotate -> Left 90 degrees
The Rotate -> Left 90 degrees rotates selected objects 90 degrees to the left (counter-
clockwise) relative to the current view. The Quick Key for Rotate -> Left 90 degrees is
Command L (M) / Control L (W).

Rotate -> Right 90 degrees
The Rotate -> Right 90 degrees rotates selected objects 90 degrees to the right
(clockwise) relative to the current view.

Rotate -> Flip Horizontal / Vertical
The Rotate -> Flip Horizontal / Vertical commands are used when mirroring the

selected objects horizontally or vertically around the physical centerline of the
selection.



___________________________________________________________________________
Page 127

Rotate -> Rotate…
The Rotate…command rotates the selected objects by means of a dialog box (1).
Below is a picture showing the options.

The rotation angle (2) is entered in the edit field at the top.
The Normal (3) rotation method rotates the selection in the ordinary way.

The Constrained Horizontal and Vertical methods (4) block out the calculation in
one direction and therefore results in a skewed and distorted result which might be
useful in some cases. These methods work in the same way as found in the Mode bar
when using the Rotate tool in the Tool palette and we therefore suggest that you study
this section of the manual to understand these methods.

The rotation can center around the physical center-point (5) or on the Intersection
Point (6).

Other methods for rotating objects and selected points include using the Rotate and
Mirror tools in the Tool palette.

Select All
The Select All command selects all objects that can be accessed with the current layer

setting. Invisible objects are ignored. The Layer visibility command found in the Page
menu and as a pop-up in the Layer tab of the Layer/Color palette also affects the
behavior of the Select All command. The Show / Snap /Modify Others mode is the only
mode allowing the selection of objects located on other layers.

The quick key for the Select All command is Command A (M) / Control A (W).

Select All Points ->
The Select All Points sub-menu allows you to improve a selection by selecting more

relevant points. In most cases you start by selecting a single point and then use these
commands to select the rest of the relevant points. Note that most of these items are
also available in the contextual menu displayed when you have a two-button mouse or
by pressing the Control key before clicking (Mac with a one-button mouse).

Select All Points -> In Object selects all control points in an object [command + 5
(M) / control + 5 (W)].

Select All Points Along Ruler selects all control points along the currently selected
control ruler [command + 6 (M) / control + 6 (W)].

Select All Points Perpendicular to Ruler selects all control points perpendicular to
the currently selected control ruler [command + 7 (M) / control + 7 (W)].
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Select All Points Along the Edge selects all control points along the currently

selected surface edge [command + 8 (M) / control + 8 (W)].

Custom Selection ->
The Custom Selection sub-menu selects objects having specific properties. A typical use
is to select for example all points used as design aids during the design process and then
delete them. The options are:

Custom Selection -> Points selects all objects consisting of a single control point.
Custom Selection -> Rulers selects all objects consisting of a single control ruler.
Custom Selection -> Curves selects all objects consisting of a single curve (a series of

ruler starting points).
Custom Selection -> Rulers Curves selects all objects consisting either of a single

control ruler or curve.

Custom Selection -> Surfaces selects all objects defined as being a surface, that is
having at least two control rulers and at least two control points on one of the rulers.

Custom Selection -> In Current Layer selects all objects belonging to the currently
selected layer.

Custom Selection -> In Current Color selects all objects belonging to the currently
selected color.

Duplicate
The Duplicate tool is used for creating copies of objects. The quick-key is [command +
D (M) / control + D (W)]

Another way of creating a copy of an object is to select it using the Object Selection
mode in the Selection mode bar, click on the object while pressing the Opt (M) / Alt /
Opt (W) key and drag. This generates a copy of the selection.

Duplicate Array
The Duplicate Array command found in the Edit menu is used for adding several

copies of the selected object(s). Objects can be duplicated in three different ways; by
fixed offsets (1-2) in the X, Y and Z directions, by offsets in rows and columns (3-4)

or by rotating and copying objects (5-7) around a fixed center-point (6).

In the two first cases you select the objects to be copied and then run the Duplicate
Array command. In the circular case you have the option to manually enter the
coordinates of the center-point, but in most cases it is easier to use an object as the

center-point. Placing the Intersection Point on a special center-point object (6) before



___________________________________________________________________________
Page 129

running the Duplicate Array command does this. This object is ignored by the

command.

The Duplicate Array dialog can be seen below.

1/ Linear mode
2/ Number of copies
3/ Rotation angle for each new copy
4/ Copy in rows and columns

5/ How many copies in the row direction (rows and columns are always oriented as
seen on the screen)
6/ How many copies in the column direction
7/ Rotation angle for each new copy
8/ Offsets is the only available option in the Linear and Rectangular modes
9,10,11/ Offset distances for each new copy.
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The offset fields works in a slightly different way in the Circular mode (1). Two of
the coordinates are used as center-points (2-3). The third field is used for in the
direction away towards you (4). Note that the direction is determined by the view used.
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The offset can for example be used to generate the steps in a stair as seen below.

Select the object (1), and then the center-point object (2) to place the Intersection
Point in the middle. Chose Duplicate Array in the Edit menu. Select the Circular array
(3) mode. Fourteen steps (4) were used in this case, the first selected objects not
included. Set the angle (5) between each copy. Click on the Intersection Point (6)
button. Leave the two center-point (7) coordinates unchanged. Add a pitch offset in

the Vert. Offset (vertical) field (8). Click OK, and the stair (9) is generated. The steps
as seen from an isometric view (10).
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Flip Index Direction->
The Flip Index Direction commands change internal index order of the control rulers
along or perpendicular to the rulers, and the direction of the rulers.

One fairly common example of use would be if you want to add more controls
downwards and towards the green starting dot. In such as case you simply flip the
direction along the rulers and then add point upwards as usual. Below is a picture that
illustrates the steps.

The Flip Index Direction Along Ruler (2) command moves the green starting dot
from the left side (1) to the right side (3). In the left (1) case, the first control point is
located to the left whereas in the right (3) case it starts to the right.

The Flip Index Direction Perpendicular to the Ruler (5) command moves the green
starting dot from the bottom side (4) to the upper side (6). In the left (4) case, the first
control ruler is located at the bottom whereas in the right (6) case it is located at the

top.
The Flip Index Direction 90 Degrees (8) command rotates the ruler direction from

being horizontal (7) to being vertical (9). The green starting dot is still in the same
place and has therefore not moved.

The Flip Selected Ruler and Curve commands flip a single element within a surface
object. An example of use is when a surface is generated using the Loft command abd

where one of the rules gets a flipped direction by mistake. It is then quicker to just fix it
with these commands instead of taking it apart to re-do it again.
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Duplicate Along Ruler
The Duplicate Along Ruler command duplicates objects along a control ruler. It

can for example be used for duplicating flagpoles or trees along a road, guard rail poles
along the sheer line of a boat, etc. The picture below shows the steps.

Start by preparing a ruler. The number of copies is controlled by the number of
steps along the ruler and is set in the Object Info (1) palette. Select the object or objects
(2) that you want to duplicate and then shift-click on the control ruler (3) to be used.
The object that contains the Intersection Point is ignored in the duplication process and
is used as the extrusion path in the calculation. Select Duplicate Along Ruler in the
Edit menu. The result shows up in the lower picture (4). Note that the relative distance
from the Starting point of the path curve is preserved, so it is a good idea to place the
objects to be duplicated relative to the starting point of the curve. Any surface ruler

can be used. Just place the Intersection Point in the relevant curve by clicking (or Shift-
clicking on it).

The picture below shows several examples where the Duplicate Along Curve
command has been used. The bridge columns (1), the light poles (2), the cars (3 & 4).
Note that the traffic is heavier in one direction and this was achieved by temporarily
changing the resolution along the bridge slightly before duplicating. This works

because the number of duplicates is controlled by the mesh resolution in the control
object.
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Control Point Resolution
The Control Point Resolution command adds or deletes control points to and from

an object. This can for example be useful when you suddenly realize the need for more
control points to control the shape of a curve or surface. You can of course add
controls manually but this method usually maintains the basic shape well. Below is an
example showing how it is done.

Click on the object (1) to be modified. Choose Control Point Resolution in the Edit
menu. Change the Control point resolution (2-3) to for example four by four and the
mesh resolution (5) to say eight by eight. Note that the new points (4-5) where added
along the shape of the original surface. The mesh resolution (5) was also changed,

which essentially the same as in the Object Info palette though done in a single step.
The Even control point distribution (6) checkbox does the same as the Redistribute

Controls command though it is done in a single step and applies to all rulers in the
object.
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Below are a few practical examples showing the use of the Control Point Resolution
command.

Imagine that you want to project a surface (red / 1) to the yellow surface using the
Align - > Surface tool. If you do it with a resolution of 1 x 1 you will get a very poor

alignment to the surface (third picture). If you instead increase the resolution to say 16
steps along the ruler using the Control Point Resolution (3) command and then the
Align -> to Surface you will get a much better result (blue / 2)

The Control Point Resolution command can also be used for reducing the

resolution. Imagine that you have imported a polygon having for example fifty control
points (1). A recommended rule when working with math is to use as few control
points as possible without loosing the shape. In such as case, just decrease the
resolution to say 16 steps (2) by using the Control Point Resolution command. As you
can see in the second picture, the shape is still almost identical to the first picture. Even
a reduction to eight control-points (3) with a curve resolution of sixteen steps (3)
works in this case. If done correctly, you will end up having the same shape, but with a
manageable number of controls, and it is quicker too. Experiment!
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Redistribute Controls
The Redistribute Controls command is used for creating an even distance between

the control points. An example of use is to clean up and generating smoother and more
harmonious objects. A more even distribution typically generates better looking and
less nervous math curves.

The diagram above shows some examples. The upper ruler curve (1) forms a
smooth looking shape though the control points are not evenly distributed. The second
ruler curve (2) looks the same but the controls are more evenly distributed.

The Redistribute Controls command does not always do a good job and should

therefore be used with some caution. The third example (3) shows a very uneven shape
and when the Redistribute Controls command here generates a fairly different shape.
In other words, the Redistribute Controls command works bet on basically smooth
looking shapes.

Worth noting is that the Redistribute Controls command works on the selected
object but only on control rulers where at least one control point has been selected. In

other words, it is possible to redistribute one, some, or all control rulers within a given
selected object.

Join Objects
The Join Objects command is used for joining two objects into one. It works in a
similar way to the Join tool in the Tool palette, but instead of drawing a joining line

along the edge you simply select the two objects to be merged and then run the Join
command.

Two objects can be joined provided that they have the same number of control
rulers and that they are physically connected along one edge and that the rulers have
the same direction. Surfaces as well as curves and control rulers can be joined.

The quick key are [command + J (M) / control + J (W)].

Split Objects
The Split Surface commands split objects into strips, along or perpendicular to the
control rulers. Just place the Intersection point on the object and then select the
command. The picture below shows the result of a perpendicular split. Cutting along
the rulers works in the same way but in the other direction.
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Objects can also be divided into separate objects using the Cut tool in the Tool
palette. This tool allows individual cutting along a give cutting line, which is not the
case with the Split Object commands.
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Page menu

The Page menu contains various document settings such as the location of the sheet
area, the degree of zoom, the layer visibility, drawing scale, units and grid, cross-

sectioning settings, and origin settings.

Move Print Area
The Move Print Area is used for moving the intended sheet area relative to the

model. In the picture above the objects (2) are located in the upper left corner of the
sheet area (1). Select the Move Print Area command and drag (3) the sheet to a
suitable location around the objects.

Note that each view in the View bar, above the drawing area, has its own
individual setting and requires its own individual adjustment.

Fit to Window
The Fit to Window command adjusts the degree of zoom and pan settings so that the
sheet area fits into the drawing area. This is an extensively used command by nearly all
users so it is a good idea to memorize the quick key [command + 4 (M) / control +
4(W)].

The Fit to Window button, in the bottom left corner of the drawing window does

the same thing as the Fit to Window command in the Page menu. Just click on it.
There are also other ways to adjust the degree of zoom.  The Zoom and Pan tools in

the Tool palette.  The View buttons in the bottom left corner of the drawing area.
Pressing the Space bar key temporarily activates the Pan tool. Changing view
automatically centers the pan on the objets selected.
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Layer Visibility->
The Layer Visibility commands work in the same way as the pop-up menu in the
Layer / Color palette. They enable you to control what you see in the drawing area.

The four layer visibility modes are:
Active Only wherein you only see the active layer, regardless of the fact that other

layers are visible or not.
Show All displays all visible layers but does not allow snapping to objects in other

layers.
Show / Snap Others displays all visible layers and allows snapping to object in other

layers but not editing them.
 Show / Snap / Modify  displays all visible layers and allows both snapping and

editing of visible layers.

Drawing Scale
The Drawing scale command scales the model into something that fits within the

sheet space boundaries. A house may for example need a scale of 1:100 to fit into the
sheet space, whereas a chair would fit in at a scale of say 1:10.

It is also possible to enlarge the model to fit into the sheet space by entering a value
smaller that one. A scale of 1 : 0.5 is the same as a drawing in scale 2:1 and 1 : 0.25
equals 4:1.

Note that the drawing scale does not change the physical size of the model.
Changing the drawing scale also changes the default setting used when opening a new
blank document.
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Drawing Units
The Drawing units command is used for defining the drawing units used in the

document. There are four different settings in the dialog. The reason for this is that it
may be practical to use for example millimeters for measuring lengths but not for
measuring areas or volumes.

The Drawing Units (1) define the length units used by TouchCAD, and the options
are mm, cm, dm, meters, decimal inches and decimal feet.

The Area Units (2) options are mm, cm, dm, meters, decimal inches, and decimal

feet.
The Area Volume (3) options are mm, cm, dm, meters, decimal inches and decimal

feet.
The Weight Units (4) options are kilos, metric tons and lbs.
Note that changing the drawing units also changes the default setting used when

opening a new blank document.
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Set Grid, Change Grid Resolution->
The Grid resolution command controls several things. It is used for controlling the

number of decimals displayed when drawing. Note though that it does not affect the
true accuracy of the program, only what you see. A second use is to control the step
length used when nudging objects with the arrow keys.

The Set Grid command displays a dialog wherein you can choose between a number
of options in a pop-up.

The Change Grid Resolution -> Bigger Steps command increases the grid steps used

by a factor of ten (e.g. 1 -> 10 -> 100 -> 1000).  The quick key for this command is
[command + 2 (M) / control + 2 (W)].

The Change Grid Resolution -> Smaller Steps command decreases the grid steps
used by a factor of ten (e.g. 1 -> 0.1 -> 0.01 -> 0.001).  The quick key for this
command is [command + 1 (M) / control + 1 (W)].

An easy way to remember which is which of these quick key commands is to

remember that 2 is bigger than one (bigger steps) and 1 is smaller than 2 (smaller
steps).

Text Sizes
The Text Sizes command controls the size of texts in the 3D view as well as in the
Unfold view. They are defined in standard point sizes in the dialog that follows when

the command is selected.
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Sectioning Settings
TouchCAD allows you to work with dynamic line drawings, which automatically
update when you move control points. The Sectioning Settings command controls the
behavior of surfaces using the Cross Sections display mode. Any surface can be used
and you can change display mode of a surface at any time using the Display mode
pop-up found in the Properties tab of the Object Info palette.

The Sectioning Settings command allows you to specify what kind of cross
sectioning you want to see, the distances between the cross sections and so on. Below is

a picture showing the settings dialog.

The c/c distance (1-3) X, Y and Z fields specify the sectioning distances used in the
current document. The settings are individual for each direction.

The Grid Color (4) setting allows you to change the color of the grid by clicking on
the color field. A standard color dialog occurs where you can choose any color.

The Zero Lines (5) checkbox allows you to see the standard horizontal and vertical
zero lines.
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The Sectioning Grid (6) checkbox activates the display of the sectioning grid.

The Show Texts (7) checkbox controls whether you will see the sectioning texts or
not.

The Start Sectioning At X, Y, Z, (8-10) controls where the sectioning lead texts
place their respective reference points. In the example the Y direction places the zero
point at the waterline and all reference lines have a negative value. In the X direction,
the zero point is set at the leftmost section that fits into the given surface and current

c/c sectioning setting. TouchCAD automatically updates the texts if the surface is made
longer in such a way that more sections can be added.

The Text Size (11) field allows you to specify the size of the lead texts.
The Section Color (12) settings define the color of the cross section lines in the X, Y

and Z directions.
The Contour, Section and Grid line thickness (13) pop-ups define the thickness of

the respective lines when printed. It is used for making a more clear distinction between
the line types and make a drawing more clear when printed in a large formats.

Set Origin, Reset Origin
In many cases it can be useful to get the coordinates from a given point instead of from
the fixed coordinate system. It allows you to get dynamic offsets from a given point

without having to calculate an offset. The Set Origin Reset Origin commands are used
for creating a temporary offset in the dynamic coordinates shown above the drawing
area in the drawing window. It does not really move the coordinate system and does
not affect the Intersection Point coordinates. TouchCAD provides two offsets, one for
the 3D-views and one for the Unfold view and you set and reset them individually.
The quick keys for Set Origin is [command + 9 (M) / control + 9 (W)] and the Reset
Origin quick keys are [command + 0 (M) / control + 0 (W)].

The unfolded panel (1) above must be fitted into a material width of 1200 units. To
check it, select the Rotate tool (2) in the Tool palette and rotate it so that the bottom
points form a horizontal line. Select the Reset Origin command and click on the
bottom left corner (4) of the object to place a temporary zero point (5). Hold the
cursor over the control points (6-7) to locate the highest coordinate (7). In this case,

the Y max was 1206, which probably makes it possible to fit it into the given material
width by modifying the 3D shape slightly. Reset the Origin when you’re done using
the Reset Origin command.

This is an example showing how to integrate an efficient use of material in the
design process. In fact, it is good design to make things efficient to produce.
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Tool Menu
The Tool menu contains tools for modeling and calculations. Some of the

commands are menu version of the tools in the tool palette, used where you essentially
want to come to the dialog without having to select a tool in the Tool palette and do

something on the screen.

Add Control Point / Ruler
The Add Control Point command adds one ore several control points to a selected
object or objects. It essentially does the same thing as can be done by pressing the
Opt/Alt key before clicking to start a dragging sequence. Control points are added up

and away from the green starting point dot found on all objects.
The Add Ruler command adds one ore several control rulers to a selected object or

objects. It essentially does the same thing as can be done by pressing the Shift +
Opt/Alt keys before clicking to start a dragging sequence. Control rulers are added up
and away from the green starting point dot found on all objects.

Combine into Curve
The Combine into Curve command is used for combining a number of control points
into a new separate ruler object. The control points can be separate points, or elements
in curves, rulers or surfaces. The Combine into Curve command uses the physical
distance between the selected points when deciding the extrusion path. The starting
point is where the Intersection Point is located.

Select a number of points (1). Shift-click (2) on the starting point if it is not where
you want it to be. Run the Combine into Curve command. The Delete Source (3)
objects dialog occurs where you can choose to keep (4) the original objects (points) or
delete (4) them. In the upper example we probably want to delete them to avoid having
redundant objects whereas in the lower example it may be better to keep them. The
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result (5-6) is a control ruler with the starting point (5) where the Intersection point
(2) used to be.

The lower example shows some selected points being located in various shapes (7)
and the Intersection Point (8) in one corner. The result is of course an individual
control ruler (11) with the starting point (10) where the Intersection point (8) used to
be. In the lower example it was better to keep the original objects (4).

The most common use for the Combine into Curve command is probably to clean

up imported data by creating ruler objects that can be lofted into surface objects.
Imported objects such as points or triangles are not very useful in TouchCAD, because
it is really based on math based surface objects, but it can be a good base for re-
skinning new objects.

Add End Caps
The Add End Caps command adds an end surface on an open / uncovered surface end.
It only works on control ruler ends. Below is a picture showing some examples.

The first example is a cylinder with no end caps. Select all control point along the
edge (1). Run the Add End Caps (2) and an end surface is added automatically. The
cap can be edited by for example dragging the center-point (3).

The second example (4) is an open surface where you select all end points (4). Run
the Add End Caps (5) and an end surface is added automatically. Note that the center-

point is not in the middle of the distance between the edges of the original surface.
Instead it is by default placed at an average coordinate of all the selected points in the
respective directions. It can however be adjusted by dragging the center-point (6) in
any direction.
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Curve to Surface
Curves (a series of ruler starting points) and control rulers are not surface objects

and are therefore not visible when rendered and can not be used for unfolding. The
Curve to Surface command can be used for converting rulers and curves (ruler starting
points) into surfaces.

In the first example we have a control ruler (1) that we want to convert into a
surface. You can see that it is a ruler because all lines are red between the control
points even though this particular object is blue. You can see the color when the object

is deselected. Select it and then run the Curve to Surface (2) command to convert it
into a surface (3). Note that you can see that it is a surface because it has two control
rulers and blue intermediate lines (the color of the object).

In the second example we have a curve (4) (a series of ruler starting points) that we
want to convert into a surface. You can see that it is a curve because none of the lines
are red between the control points even though it is selected. Select it and then run the

Curve to Surface (5) command to convert it into a surface (6). Note that you can see
that it is a surface because it has five red control rulers and blue intermediate lines (the
color of the object).

Surface to Outline
The Surface to Outline can essentially be described as a reversed version of the Curve

to Surface command. There are however some differences. The Surface to Outline
command always generates a new object and this object is always a control ruler.
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Surface Properties
TouchCAD provides a range of tools for weight, surface area and center of gravity
calculations.

1/ Specifies the total object weight of the object regardless of the surface area. This

property is primarily used for fixed objects where the surface area is irrelevant (e.g.
engines, batteries, tanks, fittings, etc.). Weights can be added or attached to any type of
objects including curves and points, so there is no need to draw a complex model in
order to use an engine in a weight and center of gravity calculation.

2/ Specifies the weight per surface area of a specific object (e.g. 0.3 kg per square

meters or 12 pounds per square feet). TouchCAD uses the area and weight units
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settings specified in the Drawing Units setting in the Page menu. Note that this setting

requires a surface to generate a weight.

3/ Calculations are initiated by selecting one of the four Surface Property options
found in the Tool menu. The first three options allow you to calculate the Selected
Object(s), the Visible Objects or All Objects in the drawing. A dialog window occurs
specifying the combined weight, surface areas and center of gravity of the selected

objects. It also allows you to place a point (5) at the center of gravity of the combined
center of effort of all objects used in the calculation. Such a point is useful for example
when you want to compare the center of gravity of the objects with the center of
buoyancy of a boat hull.

4/ The List All Objects option in the Surface Property menu displays a spreadsheet
with the all objects in the drawing listed (6-10). This dialog allows you to copy (11)
the spreadsheet into the clipboard and paste it into other programs, save (12) it as a
TAB based text file or print (13) it.
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Marine properties
TouchCAD provides special features for automatically calculating various marine
properties such as wetted surface, prismatic and block coefficients, section area curves,
displacement, center of buoyancy, hull and waterline lengths, total and waterline
beam, etc. The marine calculation property is normally turned off by default, so we
therefore need to activate it.

Start by clicking on the hull surface. Select the Properties tab (Prop.) in the Object
Info palette. Click on the Marine Calculations check box to enable marine calculations
on this surface (any number of surfaces can be used though it increases the execution
time considerably).

The next step is to select the Marine Properties command in the Tool menu. The
Marine Calc palette occurs showing the properties of the surface.

The following objects are displayed in the palette.
Length overall (1).
Waterline length (2).
Beam (3).
Beam on the waterline (4).
Draft of the hull (5).
 Center of buoyancy (6),  which of course should be balanced against the center of

gravity to get the correct floating position.
The Lateral center (7) creates a balance between the lateral center of the hull and

the sails. The lateral center of the sails can easily be calculated using the Surface
Properties command in the Tool menu. On mono-hull sailboats you typically place the

center of the sail-plan slightly ahead of the lateral center of the hull to compensate for
the asymmetry of the hull when heeling. It can also be useful when positioning the keel
/centerboard/ rudders.
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The Curve of Areas (8), and various other curves can be used dynamically by
making small alterations and then running the Marine Properties command again
without closing the Marine Calc palette.

If you like, you can plot the final curves by checking the Plot Curves checkbox. The
plotting takes place when you close the palette by clicking on the Done button.

The Prismatic Coefficient (1 below) and Block Coefficient (2 below) are used for

estimating the properties of the hull. The coefficients are defined as follows:
Prismatic Coefficient (1) = Volume (red)   /   (maximum cross-section area   x

length in waterline) (blue)
Block Coefficient (2) = Volume (blue)   /   (cross-section width   x   cross-section

height   x   waterline length) (red)

The Wetted Surface is a key factor when estimating the drag of the hull.
The Top Area / Center of Buoyancy factor can be used for estimating the trim

balance of a planning hull. A good trim is usually achieved by placing the top area
center a few percents of the waterline length ahead of the center of buoyancy.
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Offsets.
The Offsets command generates a 3D coordinate table of the selected object. The table
is used for creating full-scale cross sections of the surface, which can be placed in a
building jig. The jig is used for holding the skin elements while building the object. The
table can be copied to the clipboard, be saved as a file or be printed.

The first (1) and third (3) sections contain the horizontal and vertical coordinates as
defined in the Sectioning setting dialog (Page menu).

The second (2) and forth (4) sections define where the horizontal and vertical
sectioning cuts meet the edge of the surface. Note that these coordinates come in pairs.

The fifth (5) section defines where the control rulers meet the surface. Note that
these coordinates come in pairs.

The sixth (6) section defines the four X, Y and Z corner coordinates.
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Extrude, and other drawing commands in the Tool menu
The Extrude, Line, Rectangle, Circle, Polygon, Double Line, Arc, Surface, Point,
Cube, Sphere, Torus, Cylinder, Circle to Rectangle Extrusion and T-tube commands
are all essentially the same as found in the Tool palette. We therefore recommend that
you take a look in the Tool palette section of this manual to find out more about the
respective features of these tools.

The difference between the tool commands in the Tool menu and the tools found in

the Tool palette is that they allow you to generate an object without having to select a
tool in the Tool palette and draw something in the drawing area first. It can sometimes
be practical and may save some time. Defining a shape using a dialog can however be a
bit abstract, but can sometimes be quicker and more accurate.

An alternative way of drawing an object by means of a dialog is to double-click on
the relevant tool in the Tool palette. This method allows you to skip the drawing part

and go directly to the object creation dialog.
The Extrude command has a quick-key [command + E (M) / control + E (W)]
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View menu
The View menu contains various viewing settings such as rendering, views, and

what you see in the model editor.

Render model
A model is normally displayed as a wireframe model while editing TouchCAD allows
you to see a rendered version of the model. All visible surface objects can be rendered.

The color of a surface is controlled by the fill color setting and can be changed using
the color pop-up in the Object Info palette.

A color is a group of color settings consisting of a name, a line color, a fill color
and a transparency setting. Colors can be added and deleted using the Color tab of the
Layer/Color palette.

Choose Render Model in the View menu. The model is now displayed as a solid
surface. Some new controls are shown in the drawing window when you render the
model. We will now take a closer look at the options.

The controls are Walkthrough (1), Flyover (2), Hither (3), Yon (4), Animate (5),
Render / WireFrame (7). Background Color (8), Ambient Light (9), Flood Light (10),
Trackball palette (11), Step backward view (12) Save View (13), and Step Forward
view (14).
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Walkthrough tool
The Walkthrough (1) tool enables you to walk through the model. You operate it by
placing the cursor close to the center of the rendered area (2). Press the mouse button
and drag the cursor upward to go forward. The model moves closer to you (3). Drag
downwards and you move away from the model. Drag left and you rotate to the left,
drag right and you rotate to the right (3). Press the Alt / Opt keywhile dragging
upward on the screen moves the camera upwards (4), down for downwards (5) and
left/right for moving sideways.

Note that the numerical view keys also work. The only difference is here that the

zero key is used for resetting the view instead of unfolding the model.

Flyover tool
The Flyover tool enables you to rotate the view in the same way as when using the
Trackball. Hold the cursor over the drawing area and drag to rotate. Unlike the
Trackball the Flyover tool also allows recording of a simple animation. More on that

later on.
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Hither and Yon tool.
The Hither and Yon tools are used for cutting off parts of the model from the front
and back sides. This enables you to look into a section of the model. It also works
when you record and play an animation, which can generate certain useful effects such
as shown in the lower section of the picture above. Dragging upwards/downwards on
the screen operates both tools. Note that the numerical settings are displayed in the
Info field above the drawing area when you drag.

Animate tool
It can sometimes be useful to see a model in motion when designing certain objects.

The Animate tool enables you to record a motion and play it in an endless loop.
Choose the Front view by pressing the 2 key on the numerical keyboard. Choose the

Flyover tool and rotate the view slightly. Click on the Animate tool and the model
starts rotating. Click again on the Animate tool to stop the motion.

Note that you can lock the motion while dragging / recording the motion to being
either constrained horizontally or vertically by pressing the Shift key.

You can change view at any time while running the animation, useful if you only
want to see a small part of the entire motion loop.
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Hidden Lines /Solid display tool
This tool enables you to toggle between looking at the model as a wireframe or as a
solid.

Background color tool
The Background field enables you to set the color of the background by choosing any
color. Just click in the color field and chose a color using a standard color-dialog.

Light settings
These two Light sliders allow you to dynamically change the Ambient and Flood

light settings. The Ambient light control makes the rendering look lighter or darker.
The Flood light control increases and decreases the contrast.
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Lens Setting tool
The Lens setting tool allows you to set the perspective deformation of the display.

Some rendering notes
The Skin type setting in the Object Info palette also affects the way a surface is
rendered. Smoothing in a certain direction generates a smooth rendering in this
direction.

Views saved with the Save button in the bottom left corner of the drawing window

are also saved when the document is saved. The saved view includes view-, perspective-
, lens-, light-, yon-, hither and background color settings.

There are separate lists of saved views for the WireFrame and Render modes, which
can store up to ten views each.

A good suggestion is to check out the various display modes found in the Properties
tab of the Object Info palette. The Display pop-up enables various settings such as

wireframe, outline, mesh, filled mesh, visible panel joints, or various combinations
thereof to be displayed in the rendering mode. A more detailed description can be
found in the Object Info palette section, Property Tab.
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Standard views -> ….
The Standard views are a series of fixed views. You will find some of these views in the
View bar over the drawing window. They are also available on the numerical keyboard
according to the following layout.

Show Background Image
The Show Background Image commands enable background images to be made visible
or not. Visible images have a check mark.

Edit Background Image…
The Edit Background Image command displays a floating palette that enables fine-
tuning of the location of the background images relative to the 3D model and in scale.

The first three View buttons (1) state the target view image to be edited. The
Horizontal (2) and Vertical (3) edit fields move the image by value. The Scale factor
(4) edit field provides a method to scale a image relative to the 3D model by a scale
factor in percent. The Nudge buttons (5) moves the image one grid step relative to the
3D model.  The Delete (6) button deletes the currently selected image from the file.
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Low Res. Dragging
The Low Resolution dragging option is used when you rotate and move complex
objects. In such a case it can be practical to reduce the mesh resolution while dragging.
This is done automatically if this option is checked. Note that it does not have any
effect on the model when it is static.

Show Resize Box
The Show Resize Box command allows you to turn on or off the Resize box feature in
the drawing area. The quick-key command is [command + < (M) / Control + < (W)].
Please refer to the Resize Box section found in the Basic Concept chapter for further
details.

Rotation box
The Rotation Box option enables you to turn on and off the rotation features of the
Resize Box. Please refer to the Resize Box section found in the Basic Concept chapter
for further details.

Show Controls
The Show Controls command allows you to turn on (1) and off (2) the control dots.
This is primarily used when presenting a final model.

Coordinate axes
The Coordinate Axes command allows you to turn on and off the coordinate axes
found in the drawing window.

Analyze Curves
The Analyze Curves commands enables you to apply a temporary stretch factor on one
or several of the basic X-, Y-, and Z- axes. It is primarily used for analyzing the lines /

curves of a shape to locate areas of bad fairing.
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The Stretch-X, Y and Z items simply turn on the stretching in the given direction.

The Stretch Settings… dialog specifies the degree of stretching. A factor of 1 means
no stretching 0.5 scales the direction to half the original size and so on.

You will find another shape analyzing method when activating the Surface
Analyzer palette found in the Palettes menu.

Show Sections in 3D
The Show Sections in 3D (1) commands control how the dynamic cross sectioning
features is displayed. The Sections (2) option shows cuts along the X-axis. The
Waterlines (3) option shows cuts along the Y-axis. The Buttocks (4) option shows cuts
along the Z-axis. These features are on by default but it may be easier to read and it is
certainly faster to use a more limited setting from time to time. The Current View
Curves (5) just displays the relevant curves in the respective Front, Top and Side views,
which makes it a bit quicker as it does not need to calculate curves that are straight
anyway.

The sectioning distances and other sectioning settings are controlled by the
Sectioning Settings… command found in the Page menu.



___________________________________________________________________________
Page 161

Show Lights
The Show Lights command makes light objects visible or not. Note though that it only
displays light objects that are turned on. You handle the light properties in the Lights
palette found in the Palette menu. Lights only affect the rendering mode.

Show Object ID
The Show Object ID (1) command allows you to see the object ID in 3D-views close to
the green starting point dot. The main use for this feature is to provide a reference

picture when assembling unfolded objects.
The unfolded equivalent is found in the View menu -> Show In Unfold -> Object

ID (2). This feature places an ID text close to each sub-panel starting point. The
syntax is 1/1, 1/2, etc. where the first number specifies the main panel ID and the
second the sub-panel ID. Note that the sub-panels are always located in consecutive
order starting from the main panel starting point, and this makes it easier to assemble

the parts in a correct way.
On more complex models we recommend you to generate a 3D assembly-plan that

can be used as a map when building the model.
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Show in Unfold
TouchCAD provides a range of general unfolding settings. These options can be found
in the View menu -> Show in Unfold -> etc.

These options allow you to organize and keep track of very large and complex
models consisting of hundreds of sub-panels. All these unfold options are supported
when exporting as DXF (supported by most CAD programs), VectorWorks

(VectorScript) and PlotMaker (PlotMaker is a program for controlling sail panel
cutting machines used by many sail makers).

1/ The Cut Lines option shows the outer edge of the surface including overlaps.

2/ The Joining Lines, that is where the final surface edges meet excluding overlaps.

3/ The Start Points are used for specifying where each panel starts. The Starting
point of a main panel is the green dot and it is visible in 3D too. Note that there is a
Show Object ID higher up in the menu and that option allows you to see the Object ID
number in 3D too.

4/ Alignment Marks (sometimes also called strike up marks) plot lines along the
edge of the panel and help to align surface edges when assembling panels.

5/ The Mark Settings specify the length of the alignment marks.
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6/ Unfold Object ID inserts a panel number in the starting point corner in the

following format  (5/3). The first number specifies the main panel number and the
second is the sub panel number (e.g. 5/3 means that the main panel number is five and
it is the third sub panel in that main panel). Note that the sub-panels always occur in
consecutive order with the starting point in the same corner. This helps to keep track of
where they belong.

7/ The Vertex ID plots the vertex number along each side. This helps when
assembling large panels with many points along the edge.

8/ The Cut Coordinates option plots the coordinates along the true edge of the
panel. This can be useful when optimizing the use of material to fit into a given
material size. Note that each panel has its own local coordinate system, and it will

dynamically update as you move and rotate the object. It even allows you to edit the
3D-model with the arrow keys while being in the Unfold view. Just select the point in
3D and then switch to the Unfold view and use the arrow/+/- keys as if you wherein the
Front view. This works because the 3D model is dynamically linked to the unfolded
model, so any changes in 3D can instantly be seen in the Unfold view. If you look
closely you will see that the unfolded shapes and coordinates slowly changes as you

move. Optimizing the use of material can therefore be an integrated part of the design
process in an efficient and powerful way.

9/ The Plot Coordinates are basically the same as the Cut coordinates but they
represent the inner joining line instead.

10/ Unfold Text Size sets the size of the text in the Unfold view.

11/ Use Line Colors displays the 3D-line color instead of the standard unfold colors.

12/ Use Fill Colors display the 3D fill color instead of a white outline. It can be used
for printing out color scale models on a color printer.

13/ Folding Lines displays lines across the unfolded panels, which can be useful
when fabricating sheet metal objects using a folding or rolling machine.

14/ Stretch Tensions command makes the tension markers visible. More on Stretch
Unfold features in the Object Info -> Unfold Tab palette section of the manual.

15/ Stretch Anchor Point command makes the Anchor point marker visible. More
on Stretch Unfold features in the Object Info -> Unfold Tab palette section of the
manual.
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16/ Stretch Settings… dialog defines how the stretch tension markers are being

displayed. More on Stretch Unfold features in the Object Info -> Unfold Tab palette
section of the manual.

Unfold export limitations.
All these options can be printed and exported to other programs. There are however
some limitations:

The DXF export does not support fills.
The PlotMaker export does not support fill colors and coordinates.
The HPGL export does not support fill colors and coordinates.
The VectorWorks export supports all options.
The Unfolded image export supports all options.
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Palette, About TouchCAD menu

Palette menu
The Palette menu is used for showing and hiding the five standard palettes used by
TouchCAD. Most of the features of these palettes are covered in other sections of the

manual though two ore not.

Surface Smoothness Analyzer.
The Analyze Smoothness palette adds a new set of tools for graphically analyzing the
smoothness of a surface in the X-Y, X-Z and Z-Y directions. Rapid changes in the
change are displayed as highlighted areas within a given selected surface (1-2). Note
that highlights defined as smooth transformations may not necessarily be a bad thing,
but rapid changes up and down in color may suggest a not so smooth shape (3). The
analyzing process is dynamically updated as the shape is updated, when you change
direction or when you change the setting of the sensitivity slider.
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Lights palette
The Lights palette controls the light settings when rendering the model. A basic light is
automatically inserted so these lights are basically used for adding and highlighting
certain areas. Light objects become visible in the drawing window if they are checked
in the palette and can be dragged to a suitable location as any other 3D object. Note
that the Show Lights item in the View menu must be checked to make them visible.

 About TouchCAD
The About TouchCAD menu item can be found under the Apple menu on MacOS and
under the Help menu on Windows.

This command displays the About TouchCAD dialog. Here you will find a button
that takes you to the Serial number dialog.
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Contextual menu
TouchCAD displays a contextual menu when control-clicking (Macs with a one

mouse button) or right-clicking (on Windows and Macs having a two or more button
mouse installed) in the drawing window. The options are:

Select All, which selects all accessible objects.

Deselect All, which deselects everything.

Selects All Points in the Object (1), which selects all control points in the object having
the Intersection point.

Selects All Points Along the Ruler (2), which selects all control points along the control
ruler object having the Intersection point.

Selects All Points Perpendicular to the Ruler (3), which selects all control points having
the same point index as the control point having the Intersection point.

Selects All Points Along the Edge (4), which selects all control along the surface edge
the where the Intersection point is located. Note that you need to select a point that

explicitly belongs to one side to make this work. A corner point will not work.

Undo, which steps back one step in the action list.

Redo, which steps forward one step in the action list, if you have used the Undo
command before.

All these commands can also be found in the standard menus and can also be
reached using keyboard shortcuts.
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Keyboard shortcuts
TouchCAD provides many keyboard shortcuts for various tools and commands.

Some of them are used in combination with the Command (Mac) / Control (Windows)
keys to work, whereas others activate something using a single key.

Command key shortcuts
Below is a list of the commands requiring the Command / Control keys (here
represented by the # character) being pressed to work:

File menu
New #+N
Open #+O
Save #+S
Print #+P
Quit #+Q

Edit menu
Undo #+Z
Redo #+Y
Cut #+X
Copy #+C
Paste #+V
Group #+G
Ungroup #+U
Ignore Groups #+Shift+G
Move #+M
Reshape #+R
Rotate Left 90 ° #+L
Rotate… #+Shift+V
Select All #+A
Select All Points in Object #+Shift+6
Select All Point Along Ruler #+5
Select All points Perpendicular to ruler #+Shift+5
Select All Points Along Edge #+6
Duplicate #+D
Duplicate Array #+Shift+D
Control Pt Resolution #+Shift+A
Redistribute Controls #+Shift+J
Join Objects #+J
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Page menu
Fit to Window #+4
Set Grid Resolution Bigger Steps #+2
Set Grid Resolution Smaller Steps #+1
Set Origin #+9
Reset Origin #+0

Tool menu
Marine Properties #+K
Extrude #+E

View menu
Render Model #+H
Show Resize Box #+<

Palette menu
Object Info #+I
Tool #+T

Single key shortcuts
Below is a list of keyboard shortcuts where you press a single key to activate a tool or
command.

Note that the Escape key can be used for canceling a tool action, and when such an

action takes place the tool is set to the default tool, which is the Selection Arrow. If no
action has started, the Esc key takes you to the Arrow key.

The Space bar temporarily deactivates the tool used and switches to the Pan tool.
Note that you do not need to press the Space bar while panning, just press the Space
bar again to go back to the tool originally used.
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Nudging.
The arrow keys are normally used for moving selected objects on the screen but they
can also be used for other things. Press Shift + an arrow key to quick pan. Press
Alt/Opt + an arrow key to nudge-rotate the 3D view. Press Command
(Mac)/Windows flag (Windows) + an arrow key to nudge zoom in and out.

Trackball keyboard features.
The Trackball palette also provides some keyboard-controlled features. Press Control
plus Click in the window to display the Trackball Sensitivity slider. Click again to
deactivate it. Press Opt/Alt while dragging with the mouse within the Trackball
window to zoom in and out. Press Shift while dragging with the mouse within the
Trackball window to pan.
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Working in the Unfold view

The unfolding feature in TouchCAD is essentially an unfolded 2D-projection of the
3D-model, that is, a view having a dynamic link to the 3D model. This link means that

any changes in the 3D model can instantly be seen in the Unfold view and are instantly
available when the Unfold view is selected.

Using the Unfold view
Objects can not be drawn in the Unfold view but you can edit many of the properties
such as skin resolution and unfolding direction. You can also move objects by
dragging or nudging and rotating them. The Selection Arrow is used for selecting the

object you want to edit.  Clicking on the green starting point (1) of an object activates
it, and red dots (4) along the edge indicates that it has been selected. An object can also
be activated if the cursor (2) indicates that you have a snap, that is, it displays red dots
at the end of the lines.

Any of the red curve dots around the object can be used as a handle (4) for dragging
the object.

Objects can also be rotated using the Rotate tool in the Tool palette. The method
works in exactly the same way as in 3D, though you can not use the Constrain rotation
modes. Select the object to be rotated, click (6) in the center of rotation, drag the
rubber-band line to the second location and click (7) to establish the lever arm, drag to
rotate (8) and then click when the angle is where desired.

Sub-panels can not be moved individually, but you can convert the elements of a

main panel into individual objects using the Split (5) commands found in the Edit
menu.
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Creating a cut layout
A useful technique to optimize the use of material is to create a cutting layout. A
recommended method is to draw a rectangular test surface used for representing the
available sheet dimensions. This makes it easier to optimize the use of material. You
simply drag in the unfolded elements into the test rectangle and check if they fit in.
Above is a simple example.

The red (1) rectangle represents the sheet used. It can be placed in a separate layer if

you want the ability to make it visible or invisible. The rest of the objects (2-6) are the
actual unfolded pieces. This makes the layout very clear and it can be made very
efficient if you experiment a bit.
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Using the Arrow keys in the Unfold view
One way of optimizing the use of material would be to make small changes in the 3D-
model and then click on the Unfold view to see if the result is acceptable or if it needs
some more nudging. This is perfectly OK due to the speed of the unfolding calculations
but there are certain useful features allowing you to edit the model without changing
views a lot.

Three buttons (2-4) occur in the Mode bar when you select the Unfold (1) view.
These three buttons controls the behavior of the selected objects when nudging with
the arrow keys.

Unfold nudging
The left button (2) is used for ordinary nudging / moving the unfolded objects in the
Unfold view, that is, change its physical location within the Unfold view.

3D nudging
The second button (3) moves selected 3D-control points in the 3D views while being
in the Unfold view. In this mode, the arrow and plus / minus keys behave as if you
were in the Front view. The Left and Right arrow keys increase and decrease the X
coordinates one grid step. The Up and Down arrow keys increase and decrease the Y
coordinates one grid steps. The Plus and Minus keys increase and decrease the Z
coordinates one grid steps.

An example: Imagine that you have designed an object, and intend to use sheets of

material 2000 mm wide. When you unfold the model it turns out that the model has an
unfolded width of 2007 mm, which is close but still too wide.  Rotating the model to
the optimal angle using the Rotate tool in the tool palette doesn’t help. The solution is
to select one or more points in the 3D-model, select the Unfold view and nudge the
selected point until it fits into the 2000-mm sheet width.

Note that the Set /Reset Origin commands can be useful for such jobs. Displaying

the cutting coordinates (View -> Show in Unfold -> Cut Coordinates) while
optimizing the use of material is another useful feature.
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Projected 3D unfold nudging
The third button in the Mode bar works in a similar way to the 3D Unfold Nudging.
The purpose of this mode is primarily to allow nudging of control points being located
on the surface along the actual surface of the model.

The advantage with this method is that it allows you to change the distance
between the rulers without changing the shape of the surface too much. This change of
distance between the rulers affects the width of the strips, and allows you to “borrow”

material (widths) from areas where the strips are narrower than the maximum material
width and transfer it to where the strips are too wide to make them narrower. Below is
an example.

The four controls in the middle (1) have been selected, and have been nudged

upwards in the Unfold (2) view. The sliding takes place along the surface, like water
running along the skin (if you can imagine water running upwards).

The same steps but in the opposite direction is illustrated in the steps 4-6. Note that
the shape (3 & 6) is more or less the same if you compare the two side views, but the
unfolded panel layout (2 & 5) is very different.
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The example illustrated below shows that you could improve the use of material a

lot. The practical use may still be a bit abstract and for that reason we will take a
closer look at the steps and explain what happens.

The picture shows a side view of the model. The following steps illustrate how to
think and what to do.

A/ The model is a sail roof and has the biggest extension seen from the Top view,

and seen from that view the rulers have a horizontal orientation. This is a key factor,
and means that we will slide the controls in Z direction. The Arrow keys behave as if
you were in the Front view when you use this mode (6). In the Front view you nudge
objects in the Z direction using the Plus- and Minus- keys, and these are the keys to
use in this case.

B/ Select the 3D-points in a 3D view and then select the Unfold view. Select the

Slide mode (6) and the Y projection (7).
C/ This is what happens when you use the Plus- and Minus- keys. Note that we

show what happens when seen from the side but the action takes place in the Unfold
view. If we press the Plus key, the 3D Z coordinate is increased by one grid step and
we end up at the third (3) location. This would change the shape of the skin, and that
is not what we want, so before the shape is updated, TouchCAD projects the control
point to the skin as it was before we pressed the Plus key. This moves the control point
upward to position five (5) because we used the Y projection method (7). The skin is
then recalculated. The practical result is that the rulers slide as illustrated by the
diagonal (5) vector arrow, in other words along the surface skin.
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Intermediate rulers
The intermediate rules can also be used for redistributing the unfolded strips over the
skin. Below is an example.

In the first example the control rulers have been pushed closer to the center of the
surface. In the second example they have been moved closer to the edge of the surface.
Note the difference in panel width. It is obvious that it can be useful to take some time
to optimize the use of material in this way, and this is how the 3D sliding method
comes in. It allows you to move the curves without worrying too much about the 3D
shape, at least if the changes are reasonably small.

Some suggestions
The above described technique should be used with moderation though. Extreme
changes may cause deformations in the shape. The Change Grid Resolution
commands found in the Page menu are quite useful features while nudging on large
models. It offers a quick method for controlling the speed of the motion.
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Tutorial, a boat hull

The object of this exercise is to draw a boat hull and some other components found
in a boat. This illustrates many common techniques used when modeling with
TouchCAD, such as extruding connecting surfaces and projecting control points on

other surfaces.
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Drawing a surface
Start by drawing a surface.  This will help you understanding some basic features of the
program. Choose the Front view by clicking on the left button in the View bar. Click
on the 3D-Surface tool in the Tool palette. Move the cursor to the drawing surface and
draw a rectangle. Note that you don’t have to press the mouse button while dragging.
Just click at the starting and end points. Ignore the dialog that shows up for now. Just
click on the OK button. The picture below shows the drawn surface.

Surface objects
The green dot represents the starting point. The red dots are control points used for
changing the shape of the surface. In this case they are all red, meaning that they all are

selected. Unselected control points are invisible. The green starting point is also a
control point..

Dragging the Surface
Choose the Selection Arrow from the Tool palette (the top right item). Click on one of
the red dots.  The surface now follows the movements of the cursor. Note that you

don’t need to press the mouse button while dragging. Click again to stop moving the
surface.

Editing the surface
The entire surface was moved because all control points where selected. In order to just
move one control point; click beside the surface in the drawing area. All control points

become black to indicate that they all are deselected. Click on one of the points. The
red Intersection point indicator appears again indicating that it is selected. Click again
to start the moving sequence. Click again at the new location. Note that the surface
changes shape when you drag. Try moving some other control points. Note that you
can Shift-Click to activate further points. You can also draw a selection rectangle,
where every control point inside will be selected.
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Adjusting the shape
Now, try modifying the surface so that it looks roughly like the picture above. Try to
align the surface with the zero section and the waterline. They are displayed as light
blue lines. If you click on the Right/Side view button in the View bar you will only see
a vertical line.  This means that the surface is completely flat (2). We will now add a

third dimension to the model.

Click on the Front view button again. If you look at the picture above you will find
that some of the lines become red when you select something. These lines are called

Control Rulers. A surface can have up to 64 such control rulers, and each control ruler
can have anything between 1 and 256 control points. The green dot is always located
at the first control ruler and at the first control point. This is important to know when
editing models. In this case the green dot is at the bottom left corner of the surface.

Now choose the first and second control points in the second and third control
rulers by Shift-clicking on them (1). They should have red dots if correctly chosen. One

of the points will carry the Intersection Point marker. Change view to the Side/Right
view (2). Click on the Intersection point and drag it horizontally to the right (3).
Deselect by clicking beside the surface and draw a selection rectangle around the
control points in the third ruler. Drag the selection a little further to the right (4).

Adjusting the surface resolution
We now have something that looks like a boat hull even though it is fairly rough and
“edgy”. Let’s experiment with the parametric features of TouchCAD. Deselect by
clicking outside the model with the Selection Arrow tool. Choose Fit to Window in the
Page Menu (or use Command/Control 4). Select the Iso Front Right view by pressing
the “3” key on the numerical keyboard. Click on one of the control points (2). This
enables us to edit the properties of the surface. Click on the “Prop.” Tab on the Object
Info palette (1). Change the value in the field SurfRes H (horizontal) from 5 to 16 (3).
The surface is now subdivided into 16 steps, so this field controls the number of steps
along the ruler.
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Changing surface type
At present the surface is defined as having straight lines perpendicular to the rulers.
Change this by changing the Skin Type popup to Smooth Along Ruler /Smooth
Perpendicular to ruler (4). The surface is now displayed with 16 steps along the ruler
and 5 perpendicular to the ruler. Increase the resolution perpendicular resolution in the
SurfRes V (Vertical) field to say 8 (5). The surface now has a higher resolution in the
perpendicular direction.
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 Resizing the model.
The boat hull is at present just a shape with no particular size defined. In order to scale
it to a real physical size we simply select the surface and then select the Reshape
command in the Edit menu.

Specify the size of selection as follows: X = 6000 (mm), Y = 1200 and Z = 1200.
Scale from the center in the X and Y directions and from the lower side (min) in the Z
direction. Click OK. The surface is now 6000 x 1200 x 1200 mm.

Being able to choose a point from which to scale is useful in this case. The Reshape

dialog enables you to scale from the minimum point (1), center point (2), maximum
point (3), and Intersection point (4) in each respective direction. The picture above
illustrates the X direction as seen from the Front view.

In the X and Y directions it was a good idea to scale from the center whereas in the
Z direction it was better to scale from the Min point because it is located at the center
line. The proportional option is used if you want to keep the proportions of the

selection.
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Adjusting the drawing scale
The model is now probably too big to fit into the drawing area if you use a letter sized
printer. It is easily fixed by changing the drawing scale. Choose Drawing Scale… in the
Page menu. Change the scale to 1:25 and click OK. Choose Fit to Window from the
Page menu. Move the model so that it is similar to the picture below, which is probably
how it would float.
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Adding more control points.
Change view to the Top view. We will now add some control points to the surface

to get a better control of the shape.

 Adjust the width of the transom as seen above ( 1 & 2 ). Locate the green point of
the surface. TouchCAD always adds control points and rulers upwards and away
from the green starting point. Move the three center points to the left to add some
more space (4). Press the Alt/Opt key and then start dragging to the right. Three new
points occur (5). Adjust the shape of the model (6). You probably need to adjust the
shape from the Front and Side views as well. You can delete any number of points by
selecting them and then press Backspace or Delete. You can add a new control ruler
(red lines) by selecting a point and then press Shift + Alt/Opt before starting to drag.

The dragging direction is always away from the control ruler containing the green dot.
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Adding a transom.
The next step is to add a transom. This is best-done using the Extrude tool. The picture
below shows the steps.

Select the three control points to the left or stern of the boat (1). Select the Extrude
tool in the Tool palette (2). Click on one of the selected control points to activate it and

drag downward (3). Select the Selection Arrow in the Tool palette and deselect. Select
and delete the far-left point (4) (we only need one point in this ruler). Select the other
two points and move them upward (5). Alt/Opt-Drag downward to add two new
control points (6). Click on the Z field above the drawing window and type “=0” and
then press Enter (7). The two selected control points coordinates both become zero by
this action (7). Change display mode to Cross Sections in the Object Info palette and

adjust the lines so that the green section lines roughly aligns with the edge lines seen
from the side (8).
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Adding a deck.
In the next step we will add a deck to the model. It is essentially done in the same way
as was used when adding the transom. The pictures below show the steps.

Select the four control points along the sheer line (1,2,3,4). Technically, you only
need to select two points along the ruler to specify that you want to extrude from the
chosen edge of the hull surface. Another thing to note is that the Intersection Point (4)
is placed in the middle of the surface before extruding. Placing it along the edge
between the hull and transom may create an unpredictable result because it connects to

two surfaces. It is therefore better to place the Intersection Point in the middle. Select
the Extrude tool in the Tool palette (5). Click and drag upward (6). Move the inner
edge points to their new location (7, 8, 9, 10). Select the Top view. Move the edge line
control points upward and downward to get roughly aligning cross sections (14). The
final deck is seen in the right isometric front view (15).
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Joining surfaces.
Based on the knowledge of snapping it is now easy to add an afterdeck and join it with
the other deck element. Select the edge points along the upper side of the deck by Shift-
clicking on them (1). Select the Extrude tool in the Tool palette (2). Click on one of the
edge points and drag forward (3). Switch to the Selection Arrow tool and join the edges
of the two deck elements (4). Use the Move 3D feature (item 7 on the previous page) if
required to join the two surface edges (5). Changing view to a horizontal view verifies

that the 3D snapping has occurred (not really required) (6). Move the point closest to
the center point to Z=0 (7). Adjust the shape if required.
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Working with layers
When you continue to add parts such as a cockpit and so on, it may be convenient to
locate the surfaces onto separate layers. It makes the model less cluttered when editing.
It also makes it easier to select and edit individual points.

Locate the Layer/Color palette. If you can’t find it, try choosing Layer/Color palette
in the Palette menu. Click on the Layer tab if it is not already selected. The picture
below shows the elements.

The two symbols in front of the layer name indicate that the layer is visible (the eye)
and that it is the active layer (the brush). You activate a layer by clicking on the layer
name (if more than one layer is available). The brush symbol then moves to that layer.

A layer is made invisible by clicking on the layer name and then clicking on the Eye
button further down to the right in the palette. It is an on/off button. The objects in the
layer are still visible because the layer is still the active layer. It overrides the invisible
command. The invisible layer becomes invisible when you click on another layer.

Another factor to consider is the Layer Visibility mode pop-up (also found in the
Organize menu). The Active Only Option only displays the active layer regardless of

whether the rest of the layers are visible or not. The Show Others option displays all
layers defined as visible but does not allow snapping to objects in other layers. The
Show Snap Option displays all visible layers but does not allow editing of other layers.
The Show Snap Modify Others option allows you to edit any layer defined as visible.

Now, add two layers by clicking twice on the Add Layer button (+). Click on the
layer named Layer-1 to activate it and then on the Rename field. Name it “Hull” and

then click on the name in the list to verify. Rename Layer-2 to “Deck” and Layer-3 to
“Superstructure”.
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Moving objects to other layers.
Check that the Layer Visibility in the Layer palette is set to Active Only (1). Click on
the “Hull” layer to activate it (2). Click on a control point that exclusively belongs to
one of the deck surfaces to select it (3). Locate the Object Info palette (4). Select Object
Info from the Palettes menu if you can’t find it. Click on the Properties tab (Prop.) (4).
Locate the Layers popup (5) and select the “Deck” option (6). The selected surface
disappears though it is not really the case (7). It just moves into another layer. This

layer is currently invisible because the Layer View mode is set to Active Only (1). You
can make the deck visible again by selecting the “Deck” as the active layer (8), or by
selecting anything below Active Only in the Layer Options menu (1).
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Path Extrude.
Now, let’s add a gunwale molding along the sheer line of the hull. It is best done using
the Path Extrude tool in the tool palette. Before adding we need to create a cross
section of the intended molding. Select a view where you see the hull from the front
view, in this click on the right view button or press the “6” key on the numerical
keyboard. Start by drawing a basic shape using the Polygon tool in the Tool palette (1).
Adjust the size using the Reshape command to say 25 x 50 mm (2-3). Select the Path

Extrude tool in the Tool palette (4). Click on the appropriate point in the cross section
and draw a help line to a control point along the sheer line ruler of the hull and then
click again (5). Select Along the ruler in the Path Extrude dialog (6). The
Perpendicular option extrudes the section down to the centerline of the hull in case you
wonder. Adjust the resolution of the new surface to the same resolution as the hull (7).
Delete the cross section original if necessary (8).
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Using the Rotate tool.
When examining the path extrusion generated on the previous page it becomes evident
that we need to adjust the new surface. Change view to the Top view. Zoom in on the
bow of the hull where the path extrusion ends. Let’s adjust the end points of the
extrusion so that they are roughly perpendicular to the hull. Start by drawing a
selection rectangle around all control points in the area (3) using the Selection Arrow
tool (1) set to Vertex Mode in the Selection Mode bar (third form the left) (2). It

enables us to select individual control points. Select the Rotate tool in the Tool palette
(4). The action consists of three steps. Click on the center point of the rotation (5),
which is the control point of the hull. Click a second time on the control point located
at the greatest distance away from the first point (this is the most practical option in
this case) (6). The selected control points start to move with an imaginary lever that
now occurs. Move the cursor until the control points are roughly perpendicular to the

hull (7). Click a third time to finish the rotation session (8).
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Though not applicable in this case, there are other useful options in the Mode bar
(2). The options are from left to right, Normal two-directional rotation, Constrained
Horizontal and Constrained Vertical rotation. The later two constrain in one direction
(X or Y) but performs the calculation in the other direction. The example below shows
where we want to make the rear end of the hull gradually wider as we move towards
the left. We also want to keep the horizontal coordinates intact. Start by selecting the

appropriate control points. Exclude the points along the centerline because we don’t
want to move them. Select the Rotate tool in the Tool palette (1).  Click on the Vertical
Constrain option in the Mode bar (2). Click on the center-point of the rotation (3).
Move the cursor to the left and click a second time to establish a second point used to
define the lever (4). Drag upwards to rotate (5). Click to finish the rotation session (6).
The after end is gradually wider (7), but keeps the width closer to the rotation point

(3).
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Using the Sweep tool.
When moving back to the front end of the extrusion, it may be a good idea to add a
radius around the bow of the hull. This can easily be done using the Sweep tool in the
Tool palette. These are the steps:

Select the Top view and then zoom in so that you clearly see the end of the extrusion
(in the Bow). Use the Selection Arrow tool (1), Mesh selection mode (2), to draw a
selection rectangle around the end of the extrusion (3). The Sweep procedure is similar
to the Rotation tool. Click on the center point of the sweep (4), on the other end of the

extrusion end to create a lever (5), rotate the lever down to horizontal (6), press the
Shift key to lock to a horizontal constraining line and then click to finish the sequence
(7). The Sweep dialog occurs. Check that the Sweep angle is reasonable (8) and that
you will create a new surface (9) (yes, you can add a sweep within a surface). The new
surface automatically inherits the properties of the surface it starts from, and in this
case the horizontal resolution is 16 steps. This may be practical on a long object, but

too many in this case. Select a control point in the new surface, and change the
resolution to say four steps (10-11). (11) Shows the surface displayed as a mesh and
(12) as a contour.
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Using the Align tool.
The Align tool aligns objects to curves or surfaces. Below is a picture showing the
steps.

1/ The curve needs some adjustments. Dragging points can of course do this but in
some cases it is easier to use a control ruler, especially if there are lots of points to be
moved.

2/ Draw a temporary curve using the Polygon tool and make sure that it has a
suitable resolution for the job. If not, adjust it in the Object Info Palette. Note that you

need a curve that moves along a ruler to make it work. Select all points to be moved
and then Shift-click on one of the points along the control curve. The Intersection point
should be located on the control ruler because this tells TouchCAD which curve to use
and which points to move.

3/ Select the Align tool in the Tool palette.
4/ Make sure that the Align to ruler button is selected in the mode bar.

5/ Locate the relevant directional button in the mode bar and click on it. In this case
we wanted to move points in the Y direction and we therefore used the Y button.

6/ All selected points move to align with the selected curve, in this case in the Y
direction.
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Generating a bulkhead
Below is another example where rulers in a surface are used to create three bulkheads.

1/ The surface used for creating the new elements.

2/ Draw a polygon, in this case having three points, because we have a three-ruler
surface with straight lines in between. Select the three upper points and then place the
Intersection point on the upper ruler by Shift-clicking on it. Use the Align tool as
described on the previous page. Note that there are two directions to align to here and
it is usually easier if you change view in between the two steps to see what you are
doing. Repeat the steps for the center and lower rulers.

3/ This is what the finished result should look like.

4/ Select all points in the three new curves.  Change view to see them as cross
sections and make sure that the Vertex mode is selected in the Selection mode bar.
Press the Option (or Option-Shift depending of the direction of the polygon) and drag.

This adds new points to the curve and converts it from a curve to a surface. Adjust the
points to generate the frame or bulkhead.
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Adding a stripe
Below is an example of use of the Align tool and illustrates the use of the Align to
Surface mode. The mode moves points to align to a surface instead of a ruler.

The object of this exercise is to create a stripe along the surface of the hull.

1/ Start by drawing a rectangle surface using the Rectangle tool in the Tool palette
and using the Surface mode in the Mode bar. The rectangle has four control points but
we can easily add more points by increasing the resolution to say 16 steps along the
rulers, using the Object Info palette, and then add points using the Controls at Surface
Resolution command in the Edit menu. Make sure that all points are selected in the
new surface.

2/ Shift-click on one of the control points of the hull surface. This tells TouchCAD
to use the hull as the master surface.

3/ Select the Align tool in the Tool palette.
4/ Select the Align to Surface button in the Mode bar.
5/ Click on the relevant directional button, in this case the Z button. All selected

points project to the surface of the master surface, in this case the hull.

A few tips for using the Align to Surface tool
In some cases it appears that some points refuse to move to the surface. If so, check
that the point is located inside the projected area, by simply looking at it from the
relevant view. If you intend to render the aligning and master surfaces together it is
usually best to move the aligning surface away from the carrying surface a small

distance to avoid zebra-style renderings. You will understand why we call it that when
you see it.



___________________________________________________________________________
Page 196

More Align to Surface examples
Above are more examples showing the use of the Align to Surface tool.

The glass surfaces (1) where projected on the cabin side. Note that the surface was
nudged away a bit from the cabin side to get it to render well. If it is too close you
typically get a zebra style flicker when rotating it and that means that the two surfaces
are too close to one another. A copy was placed on the inside in a similar way to
indicate the location of the glass seen from the inside.

The bulkheads (2) where drawn as a double line surface where the distance between
the lines represent the true thickness of the bulkhead. Change the surface resolution to
8-16 steps along the rulers and then run the Controls at surface resolution command to
add more control points. Project the points to the hull surface using the Align to
Surface tool. Extrude the surface towards the centerline using the Extrude tool in the
Tool palette (Solid Extrude mode). Select the Ignore Group mode in the Edit Mode and

adjust location of the inner points to get the desired shape. An interesting side effect
with using a solid bulkhead is that it enables you to calculate the edge angles along the
hull edge side, which of course varies along this edge.

The cushion (3) example is similar to the bulkhead, except for the horizontal
orientation. The thickness of the material and the location in the hull makes it even
more important to use a double-sided projection along the skin of the hull because the

angles can sometimes be very steep, especially on sailboats.
The water (4) example shows a slightly wave shapes ruler drawn along the waterline

of the hull. Extrude the surface sideways / backwards and away from the hull and then
project the inner edge to the hull surface. This generates a wave style water surface.
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Tutorial, a human shape

Modeling a human shape
Modeling a human shape or other similar shapes may sound difficult, but it is mostly a
question of having a good strategy. Once you have that, it is mostly a matter of time
and experimenting back and forth to build a good looking model. This example briefly
illustrates the basic steps of one way of doing it.  It also illustrates how to build models
consisting of connecting surfaces, which is a common modeling technique used when

modeling with TouchCAD. Note that this strategy can also be used for modeling
animals, because they also have a similar configuration with elements that stick out
from the basic torso in one way or another.
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1/ Start by double clicking on the sphere tool in the Tool palette. Specify the
dimensions and that you want a 180 degree sweep. The reason for this is that it is
easier to model only ones side of a symmetrical object such as a human body.

2/ Delete the lowest control points so that a semi circular opening occurs at the
bottom.

3/ Select the lowest control points and use the Extrude tool in the Tool palette to
extrude a neck. Use one step in the Extrusion dialog. Rotate the lower control points a
bit as seen on the picture.

4/ Use the Extrude tool again to extrude the shoulder piece. In this case it is better

to use two steps in the Extrude dialog to allow a smother transformation towards the
arm.

5/ Continue extruding the outer side of the arm downwards using two steps in the
Extrude dialog. Don’t worry too much about the shape yet. It is usually easier to adjust
the proportions later on when the entire model is visible.

6/ Select the outer arm.

7/ Use the Mirror and Duplicate tool in the tool palette to generate the inner part of
the arm.
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8/ Adjust the edges so that they snap to the corresponding control points on the

outer side.

9/ Rotate the upper control points of the inner piece of the arm so that they are
more or less vertical by using the Rotate tool in the tool palette and rotating from the
joint between the outer and inner pieces.

10/ Select the rotated edge and use the Extrude tool in the tool palette to generate
the side of the torso. Use two extrusion steps in the Extrude dialog. Additional steps
can be useful if you want to build a more realistic shape, but as always, it is
recommended to use a few steps as possible.

11/ Use the Extrude tool to generate the front and back sides of the torso, starting

from the shoulder. Use the same number of extrusion steps as in the side of the torso.
Make sure that the front, back and side edge points snap together and that the edge
along the centerline is completely vertical to allow a perfect alignment with the other
side of the shape that will be created later on.

12/ Select the lower edge control points of the side of the torso. Use the Extrude tool

in the tool palette again to generate the outer side of the leg. Use at least two steps to
allow leg bending around the knee joint.

13/ Select the leg.

14/ Use Mirror and Duplicate tool in the Tool palette to generate the inner side of
the leg.

15/ Move the respective edge points so that they snap on the respective edges on the
outer side.
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16/ Use the Rotate tool in the Tool palette to rotate the upper edge control points of

the inner side of the leg into a vertical orientation. Make sure that all control points
along the centerline have the same coordinate setting. A quick way of doing this is to
select all control points along the centerline, select the relevant coordinate field above
the drawing window and there insert an “=” before the coordinate. Press Enter and all
selected control points get the same coordinate value setting.

17/ Select all control points along the lower end of the leg. Select the Extrude tool in
the tool palette and extrude the foot. In this case you probably need three extrusion
steps to form a reasonably realistic looking shape. Note that you now extrude two
shapes at the time and in order to do that you need to activate the Multiple Surfaces
checkbox in the Extrude dialog. If not, TouchCAD only allows one extrusion at the
time.

The foot shape now looks like a tube. This is however easily fixed by selecting the
lower two sections, changing view so that you see the model from the side, and then
adjusting the shape with the gray Resize box controls.

18/ Select all parts and use the Mirror and Duplicate tool in the Tool palette to
create the other side.

Conclusion
The model is by no means ready now and probably needs lots of adjustments and
tweaking to get the right proportions, dimensions and poses. The idea with this
exercise is primarily to suggest a possible strategy.
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Importing files
TouchCAD can read files exported from a other programs that supports the same

file types as TouchCAD. There are however some things to consider:
It is usually best to simplify the imported data as much as possible. You can for

example import thousands of triangles and then use the skinning features to build real
TouchCAD surfaces but that is normally a fairly inefficient way to do it. TouchCAD
allows you to control the number of mesh points used, so an excessive number of
imported points are just a waste of space.

Importing a few polygon curves or just points and use the lofting features to rebuild
the surfaces is usually better than importing lots of triangles because triangles needs

more memory to define the same shape. In most cases you do not an improved
accuracy by importing an excessive number of points.

DXF
Most CAD and 3D modeling programs support DXF export and TouchCAD supports
the following import data types: Lines, circles, arcs, polylines, LW polylines, 3D faces,

points, layers, 256 colors and anonymous blocks (but not blocks).
The DXF format is usually text based and this allows you to create your own DXF

files using any word processor or by writing your own program that generates such a
file. A typical minimal DXF file consists of the following elements (a four sided 3D
polygon):

The file: Comments:
0 This is the Header section. It starts here
SECTION Copy this
2 Copy this
HEADER Copy this
0 Copy this

ENDSEC Copy this
0 Copy this
SECTION Copy this
2 Copy this
BLOCKS Copy this
0 Copy this

ENDSEC Copy this
0 Copy this
SECTION Copy this
2 Copy this
ENTITIES ..and ends here. Just copy this section.
0 This command starts the first polygon

3DFACE This command indicates a closed polygon
8 Copy this
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UNTITLED-1 Copy this (Layer info)

10 Copy this (Code for first X value)
800.000 First X value
20 Copy this (Code for first Y value)
1150.000 First Y value
30 Copy this (Code for first Z value)
250.000 First Z value

11 Copy this (Code for second X value)
650.000 Second X value
21 Copy this (Code for second Y value)
2100.000 Second Y value
31 Copy this (Code for second Z value)
400.000 Second Z value

12 Copy this (Code for third X value)
2950.000 Third X value
22 Copy this (Code for third Y value)
2650.000 Third Y value
32 Copy this (Code for third Z value)
300.000 Third Z value

13 Copy this (Code for fourth X value)
3450.000 Fourth X value
23 Copy this (Code for fourth Y value)
1100.000 Fourth Y value
33 Copy this (Code for fourth Z value)
100.000 Fourth Z value

0 End of polygon
ENDSEC Copy this (closing commands)
0 Copy this (closing commands)
EOF Copy this (closing commands)

You can also learn more about DXF files by opening a DXF file exported from

TouchCAD or from another CAD program. A more detailed description of the DXF
format can be found at AutoDesk’s web site (the manufacturer of AutoCAD).

Import as -> VectorWorks
The VectorWorks import command import files from Nemetschek’s VectorWorks and
MiniCAD (the older name for VectorWorks) in the VectorScript file format (called

MiniCad Text in MiniCad 7 and older versions).
TouchCAD supports the importing of the following VectorWorks data types: Lines,

circles, ovals, arcs, rectangles, 2D polygons, 3D polygons, 2D & 3D locus points,
layers and fill / line colors.

The VectorScript format is fairly easy to use and read and is therefore well suited for
building your own files to be imported into TouchCAD.
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This is a small example showing a minimal syntax for importing a VectorScript file

(two 3D polygons):

Poly3D( Copy this (Start of 3D polygon)
800.000, 250.000, 1150.000, X,Y,Z values - first vertex
650.000, 400.000, 2100.000, X,Y,Z values - second vertex
2950.000, 300.000, 2650.000, X,Y,Z values - third vertex

3450.000, 100.000, 1100.000 X,Y,Z values - fourth vertex
); Copy this (End of 3D polygon)
Poly3D( Copy this (Start of 3D polygon)
250.000, 200.000, 500.000, X,Y,Z values - first vertex
800.000, 250.000, 1150.000, X,Y,Z values - second vertex
3450.000, 100.000, 1100.000, X,Y,Z values - third vertex

3750.000, -100.000, 300.000 X,Y,Z values - fourth vertex
); Copy this (End of 3D polygon)

You can also learn more about VectorScript files by opening a VectorScript file
exported from TouchCAD or from another CAD program. A more detailed description
of the DXF format can be found at AutoDesk’s web site (the manufacturer of

AutoCAD).

Points
The Points import format is a simple text-based TAB based X, Y, Z, coordinate list.

The syntax is a s follows:
123.123 (TAB) 456.456 (TAB) 789.789 (Carriage Return)
789.789 (TAB) 456.456 (TAB) 123.123 (Carriage Return)
Etc.
Such a file can be generated using an ordinary word processor, spreadsheet or

database program and the typical use is to import and make use of measurement points
to create a model. The manual section concerning the Combine Into Curve command
contains an example on how to process and refine points into usable surfaces.

Digitizing methods
A common question is whether it is possible to use various digitizing devices for
converting physical models into a 3D model in TouchCAD.

Many 3D digitizers have the disadvantage of generating an excessive number of
objects, and this is not very practical for use in TouchCAD unless the models have been

reduced to a reasonable size by deleting excessive data.
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MicroScribe range 3D digitizing arms
The MicroScribe range 3D digitizing arms and other similar devices can however be
quite useful since the operator controls the input data. A human operator can easily
detect where relevant changes in the model shape occur and the data provided can
therefore be kept at a reasonable level. More info about the MicroScribe range can be
found at www.immersion.com

PhotoModeler and other photo based digitizing programs
Another possible digitizing method is to use a photo based program such as the Eos

Systems PhotoModeler program. Here a series of pictures from various views is
compiled into a 3D model that con be imported into TouchCAD using the DXF,
Wavefront, STL or VRLM formats. PhotoModeler is a Windows based program but
rund well on Macs having Virtual PC installed. More info aboyt PhotoModeler can be

found at www.photomodeler.com
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